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Алғы сөз 

 

Бұл оқу құралының мақсаты – графикалық бейнелерді ӛңдеуге арналған 

соңғы бағдарламалық жабдықтардың мүмкіндіктерін қарастыру; растрлық -

Adobe Photoshop, векторлық – CorelDraw және Macromedia Flash графиктік 

редакторларында практикалық тапсырмалар орындау арқылы, студенттерді, 

пайдаланушыларды осы графиктік редакторларда жұмыс істеу принциптерімен 

таныстыру; растрлық бейнелер, векторлық объектілер құрудың шексіз 

мүмкіндіктері туралы түсінік қалыптастыру. 

Macromedia Flash технологиясы алдыңғы кезекте бейнелерді анимациялау 

үшін кеңінен қолданылатын, білім беру саласында электронды оқу құралдарын 

жасауда, сонымен қатар, күрделі интерактивті схемалар навигациясын, 

динамикалық WEB түйіндерді, мультсериалдарды, ойындарды, музыкалық 

видео ойнатқыштарды құру үшін жиі пайдаланылады.  

Оқу құралы жоғары оқу орындарының студенттеріне, оқытушыларына, 

орта мектептің информатика пәні мұғалімдері мен оқушыларына арналған. 
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1. ГРАФИКАЛЫҚ АҚПАРАТ ТУРАЛЫ ТҮСІНІК 

Компьютерлік графика - бұл компьютерде графикалық бейнелермен 

(суреттермен, сызумен, бейнекадрлармен және т.б.) жұмыс істеу мүмкіндігін 

беретін информатиканың бір бӛлімі. Сонымен бірге мұнда компьютер 

кӛмегімен  графикалық бейнелер алу әдістері құрылып, қолданылады. 

Графикалық редакторды пайдаланып, тӛмендегі әрекеттерді орындай алады: 

- суретті мәтінмен рәсімдеу, хабарландыру, жарнамалық плакат, қызметтік 

карточкаларды және т.с.с. безендіруді; 

- бұрын салынған кескіндерді біртұтас суретке біріктіруді; 

- кескіннің кез келген бӛлігін “қиып алу”, “жапсыру” және “ӛшіру”;   

- ұсақ бӛлігін ӛңдеу үшін кескін фрагментін үлкейтуді; 

- суреттерді сыртқы тасушыларда сақтауға; 

- бояуға, түстерін ӛзгертуге, сурет салу үшін түрлі “бояу” мен “қылқаламды” 

қолдануды. 

Бұдан басқа, сурет салу немесе оны ӛңдеу процесінде қолдануға болатын 

қосымша аспаптары бар. Бұлар қандай да бір сызық жүргізуге арналған 

қылқалам; ӛшіруге арналған ӛшіргіш; бояуға арналған құйма; сурет үзіндісін 

қиып алуға арналған қайшы, т.б. аспаптар. 

  

Растрлық графика 

Графикалық ақпараттың нүктелер жиыны немесе пиксельдер түрінде 

ұсынылуы растрлық түрдегі ұсынылу деп аталады. 

Растрлық кескіннің әрбір нүктесіне компьютер жадында ұяшық сәйкес келеді. 

Графикалық кескінді сақтаған жағдайда жадқа енгізілетін элементтер саны 

экранның графикалық кескін алып тұрған нүктелерінің санына сәйкес келеді. 

Нүктелерден тұратын растрлық бейне үшін белгілі бір ұзындық бірлігіндегі 

нүкте санын сипаттайтын кӛрсетілім түсінігінің маңызы зор. Бұл жерде 

мыналардың ара-жігін ажырата білу керек, яғни: 

  түпнұсқаның кӛрсетілімі; 

  экрандық бейненің кӛрсетілімі; 

  басылған бейненің кӛрсетілімі. 

Түпнұсқаның көрсетілімі (Оригинал.). Түпнұсқаның кӛрсетілімі дюймдегі 

нүктемен (dots per inch – dpi) ӛлшенеді және бейненің сапасына және файл 

кӛлеміне, сандық түрлендіру тәсіліне немесе иллюстрация құру әдісіне, 

таңдалынған файл форматына сондай-ақ ӛзге де параметрлерге қойылатын 

талап неғұрлым жоғары болса, түпнұсқаның кӛрсетілімі де соғұрлым жоғары 

болуы керек деген ереже сақталады. 

Экрандық бейненің көрсетілімі. Бейненің экрандағы кӛшірмесіндегі растрдың 

элементарлық нүктесін пиксель деп атау қабылданған. Пиксель кӛлемі 

таңдалынған экрандық кӛрсетілімге (стандартты мәндегі диапазонға), түпнұсқа 

кӛрсетіліміне және бейнелену масштабына байланысты. 

Бейнелерді ӛңдеуге арналған диагоналы 20-21 дюймдік мониторлар (кәсіби 

кластағы), ережеге сай стандартты 640х480, 800х600, 1024х768, 1280х1024, 

1600х1200, 1600х1280, 1920х1200, 1920х1600 нүктелі экрандық 

кӛрсетілімдермен қамтамасыз ете алады. Сапалы мониторлардың 
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люминофорларындағы іргелес жатқан нүктелер арасындағы арақашықтық 0,22-

0,25 мм құрайды. 

Экрандық кӛшірме үшін 72 dpi, түрлі-түсті және лазерлі принтерде шығару 

үшін 150-200 dpi, фотоқұрылғылар арқылы шығару үшін 200-300 dpi кӛрсетілім 

жеткілікті. Баспаға шығаруда түпнұсқа кӛрсетілімі шығару құрылғысының 

растр линиатурасына қарағанда 105 есе үлкен болуы керек деген эмпирикалық 

ереже қалыптасқан. Егер материалдық кӛшірмесі түпнұсқаға қарағанда 

ұлғайтылатын жағдай болса, ұлғайған мәнді, кӛлемін ӛзгерту коэффицентіне 

кӛбейту керек. 

Басылған бейненің көрсетілімі және линиатура түсінігі. Қатты денедегі 

(қағаз, пленка т.б.), сондай экрандағы растрлық бейне нүктесінің кӛлемі, 

түпнұсқаны растрлеу параметрлеріне және қолданылған әдіске байланысты 

болады. Растр торының жиілігі дюймдегі түзу (lines per inch – lpi) санымен 

ӛлшенеді және линиатура деп аталады. 

Растр нүктесінің кӛлемі әрбір элемент үшін есептеледі және аталған 

ұяшық түсінің интенсивтілігіне байланысты болады. Интенсивтілік неғұрлым 

жоғары болса, растр элементі соғұрлым тығыз толтырады. Яғни егер бір 

ұяшыққа таза қара түс кезіксе, растр нүктесінің кӛлемі, растр элементінің 

кӛлемімен сәйкес келеді. Бұл жағдайды 100% толтырылды дейді. Таза ақ түс 

үшін толтырылу мәні 0%-ды құрайды. Іс жүзінде элементтің толтырылуы 3-тен 

98% құрайды. Бұл жағдайда растрдың барлық  нүктелері шын мәнінде 

абсалютті қара түске жақындайтын біркелкі оптикалық тығыздықта болады. 

Анағұрлым қою түсті иллюзия, нүктелердің кӛлемін ұлғайту есебінен, растр 

элементтерінің орталарын біркелкі қашықтықта орналастыру, олардың 

арасындағы бос орындарды қысқарту арқылы құрылады. Мұндай әдіс 

амплитудалық модульдеу арқылы растлеу деп аталады. Түстің интенсивтілігі 

бірдей кӛлемдегі кӛршілес нүктелердің арасындағы арақашықтықпен 

реттелетін жиілікпен модульдеу арқылы растрлеу әдісі де бар. Осылайша 

жиілікпен-модульденген растрлеуде әр түрлі интенсивті түстегі растр 

ұяшықтарында нүкте саны әрқилы болып келеді. Жиілікпен-модульдеу әдісімен 

растрланған бейне анағұрлым сапалы болады, себебі онда нүкте кӛлемі кіші 

болады, қалай болғанда да амплитудалық модульдеу арқылы растрлеудеғі 

нүктенің орташа кӛлемінен біршама кіші. Оның есесіне бейне сапасын ЖМ-

әдісінің әртүрлілігі, атап айтқанда стохастикалық растрлеу арттырады. Бұл 

жағдайда растр ұяшығындағы түстің интенсивтілігін бейнелеуге қажетті нүкте 

саны ғана есептеледі. Сонан соң бұл нүктелер ұяшық ішіне квазикездейсоқтық 

әдіспен есептелген арақашықтықта орналасады (шын мәнінде арнайы 

математикалық алгоритм қолданылады). Яғни ұяшық ішінде де бейнені тұтас 

алғанда да растрдың тұрақты құрылымы мүлдем болмайды. Сондықтан да 

стохастикалық ЖМ арқылы растрлеуде растр линиатурасы түсінігінің 

мағынасы жоғалады, тек шығару құрылғысының кӛрсеткіш қабілетінің ғана 

мәні болады. Мұндай тәсіл полиграфиялық құрал-жабдықтардың жоғары 

дәлдігі мен есептеуіш ресурстарға қомақты шығын жұмсауды қажет етеді: ол 

негізінен баспа кезінде бояу саны тӛртеуден асатын кӛркемдік жұмыстар үшін 

қолданылады. 
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Түстің интенсивтілігін (жарықтығы деп аталады) 256 деңгейге бӛліп қарау 

қабылданған. Адамның кӛзі саны артық градацияны қабылдамайды, сондықтан 

да артық болып саналады. Ал аз болуы бейне кӛрінісін тӛмендетеді, сапалы 

жартылай түсті иллюстрация үшін ең аз мӛлшер 150 деңгейлік мән болып 

табылады). Түстің 256 деңгейін кӛрсету үшін растр ұяшығының кӛлемі небары 

256=16х16 нүкте болу керек екендігін есептеу қиын емес. 

Түпнұсқа кӛрсетілімі, растр жиілігі, деңгейлер градациясы арасында тӛмендегі 

формуламен сипатталатын байланыс бар: 

 ;1

2











lpi

dpi
N   ,

1


N

dpi
lpi    мұнда N – түстің деңгейлер градациясының саны, 

dpi-шығару құрылғысының кӛрсетілімі (бейне), lpi-растр линиатурасы. Ал 

формуладағы бірлік растр ұяшығы мүлде толтырылмаған жағдайға, тек ақ түске 

ғана сәйкес келеді. 

Бейне кӛшірмесін принтерден немесе полиграфиялық құралдан шығаруда 

растр линиатурасы, баспа материалдарының параметрлері мен аппараттың 

мүмкіндіктері, талап етілетін сапа арасындағы ортақ пікірге қарай 

таңдалынады. Лазерлік принтерлер үшін ұсынылатын линиатура 65-100 lpi-ді, 

газет шығару үшін – 65-85 lpi-ді, кітап-журналдар үшін – 85-133 lpi-ді, кӛркем 

және жарнамалық жұмыстар үшін – 133-300 lpi-ді құрайды. 

Растрлары қабат орналасқан, мысалы, бірнеше түсті бейнелерді басып 

шығаруда, әрбір келесі растр қандай да бір бұрышқа бұрылады. Түрлі-түсті 

баспада әдетте мынадай бұру бұрыштары: кӛгілдір баспа түрі үшін 105 градус, 

күлгін түс үшін 75 градус, сары түс үшін 90 градус және қара түс үшін 45 

градус қолданылады. Бұл жағдайда растр ұяшығы қисық бұрышқа айналады 

және 150 lpi линиатуралы 256 түс градациясын шығару (кӛрсету) үшін 

16х150=2400 dpi кӛрсетілім жеткіліксіз болады. Сондықтан да кәсіби кластағы 

фото құрылғылар үшін растрдың әр түрлі бұрыштарында сапалы растрлеуді 

қамтамасыз ететін ең тӛменгі стандартты кӛрсетілім болып 2540 dpi 

қабылданған. Осылайша түрлі-түсті бейнелер үшін растрдың бұрылу бұрышын 

есепке алу коэффициенті 1,06 құрайды. 

Бейне параметрлері мен файл көлемі арасындағы байланыс. Растрлық 

графика құралдары түстерді беруде жоғары дәлдікті қажет ететін жұмыстарды 

иллюстрациялау үшін қолданылады. Дегенмен растрлық иллюстрация 

файлдарының кӛлемі кӛрсетілімі (разрешениясы) ӛскен сайын ӛсуде. Ӛздеріміз 

күнделікті үйде кӛріп жүрген фотосурет (сандық түрге түрлендірілген, 

кӛрсетілуі 200-300 dpi, түстік кӛрсетілімі 24 бит, стандартты кӛлемі 10х15) 

сығымдалған режимдегі TIFF форматында шамамен 4 Мбайт орын алады.  

Растрлық бейнелердің көлемін өзгерту. Растрлық графиктің бір кемшілігі 

бейнені ұлғайтқан кезде пайда болатын (егер арнайы бір шаралар 

қолданылмаса) пикселдену болып табылады. Егер түпнұсқада бірнеше нүктелер 

болатын болса, бейне кӛлемін ұлғайтқан кезде сапасы сақталуы үшін, 

түпнұсқаны кӛрсетілімімен алдын-ала сандық түрге түрлендіріп алу керек. 

Екінші бір әдіс пикселдену эффектісін қандай да бір шекке дейін азайтуға 

мүмкіндік беретін стохастикалық растрды қолдану болып табылады. Сондай-ақ, 
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кӛлемді ӛзгертуде, иллюстрация кӛлемін ұлғайту нүктелерді ұлғайту есебінен 

емес, бірнеше аралық нүктелер қосу жолымен шешуге болатын интерполяция 

әдісін қолданылу арқылы жүзеге асырылады. 

Растрлық кескіндеудің артықшылығы: растрлық кескінді түзетуге, 

әдемілей түсуге, яғни оның кез келген бӛлігін ӛзгертуге болады; нүктелерді, 

қажет болмаса ішінара алып тастауға немесе қоюлатуға, сондай-ақ кескіннің 

әрбір нүктесін ақ-қара немесе басқа кез келген түске ӛзгертуге болады. 

Кемшілігі: растрлық кескін ӛлшемінің масштабын әдісімен (бір немесе бірнеше 

бағытта созу немесе сығу) ӛзгерткенде, кескіннің сапасын жоғалтатыны. 

Мысалы, кескінді үлкейткенде, оның кӛрінісі дӛрекіленіп кетсе, ал 

кішірейткенде – кескін сапасы ӛте нашарлап кетеді (нүктелерін 

жоғалтатындықтан). 

Растрлық кескіндердің тағы бір кемшілігі – файлдар ӛлшемдерінің ӛте 

үлкендігінде (түстері неғұрлым кӛп және сапасы жоғары болған сайын, олар 

соғұрлым үлкен болады). 

Бірақ бұл кемшіліктеріне қарамастан, қазіргі техникада растр ӛте жоғары 

сапалы кескін алуға мүмкіндік береді. Сондықтан растрлық суреттер кӛркем 

графикада кеңінен қолданылады. 

 

Векторлық графика  

Кескін салудың векторлық түрі де бар, мұнда кескін элементтері нүкте 

түрінде емес, әріпті-цифрлық (математикалық формулалар жиынтығы) ақпарат 

түрінде беріледі. Кейіннен бастапқы кескінді салу үшін бұл ақпарат арнайы 

программаларда ӛңделеді. 

Векторлық кескіндер, бұл – сызық, доға, шеңбер және тікбұрыш сияқты 

геометриялық объектілер жинағынан тұратын кескіндер. 

Мысалы, сызба. Компьютерге оларды сипаттаушы параметрлердің мәнін 

енгізуге болады: 

- кесінді үшін оның екі нүктесінің координаттарын; 

- шеңбер үшін центрінің координаттары мен радиусының ұзындығын; 

- доға үшін доғаның басы мен соңының, центрінің және радиусының 

координаталарын; 

- әрбір сызық үшін оның типі жіңішке, штрихталған, пунктирлі және т.с.с. 

кӛрсетіледі. 

Содан кейін бұл ақпарат арнайы программамен ӛңделеді (яғни суреттің 

әрбір нүктесінің орны векторлық графикалық файлда жазылған формулалар 

бойынша есептеледі) де, сызба экранға шығарылады. Бұл элементтер дискретті 

болып табылады, олар ӛзара байланыспаған, сондықтан олардың ӛлшемін сурет 

сапасын жоғалтпай-ақ оңай ӛзгертуге болады. 

Сонымен қатар бұл сызбаның параметрлерімен берілетін әріпті-цифрлық 

ақпараттың ақпараттық кӛлемі сызбаны компьютерге растрлық түрде енгізгенге 

қарағанда жүздеген, мыңдаған есе кіші болады. Векторлық әдістің тағы бір 

артықшылығы оған кескін сапасын жоғалтпай ӛзгеріс енгізуге, оңай 

кішірейтуге және үлкейтуге болатындығы. 
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Кейде сызық түсінігінің орнына контур түсінігі қолданылады. Бұл 

термин толығымен, жан-жақты сипаттайды, себебі контур кез-келген форманы 

қабылдай алады – түзудің, қисық сызықтың, сынық сызықтың, фигураның және 

т.б. 

Әр контурдың екі немесе одан да кӛп тіреу нүктелері болады, сонымен 

қатар оларды түйіндер деп те атайды. Екі қатар тіреу нүктелерінің арасында 

орналасқан контур элементі, контур сегменті деп аталады. Контурдың 

формасын тіреу нүктелерін қозғалту, олардың қасиеттерін ӛзгерту, жаңа 

түйіндерді қосу немесе бар түйіндерді жою арқылы ӛзгертуге болады. Контур 

ашық немесе тұйықталған болуы мүмкін. Ашық және тұйықталған 

контурлардың қасиеттері әр түрлі. 

Контур графикалық объект болып табылады. Контурлардан жаңа 

нысандар немесе олардың топтамалары құрылады. Нәтижесінде құрылады: 

нысандар ттоптамалары, құрама контур, жаңа контур. Топтау операциясынан 

кейін әрбір контур ӛз қасиеттерін және түйіндерін сақтайды. Комбинациялау 

операциясынан кейін құрама контурда жаңа қасиеттер пайда болады, бірақ 

түйіндер сол күйінде қалады. Біріктіру операциясынан кейін жаңа түйіндер 

пайда болып, бастапқы контурлардың қасиеттері ӛзгереді. Контурдың сыртқы 

сызығының параметрлері оның кӛрсетудегі түрін анықтайды. Оның 

параметрлері болып табылады: 

  сызықтың қалыңдығы; 

  сызықтың түсі; 

  сызықтың типі  (тұтас, пунктирлі және т.б.); 

  соңының  формасы (бағытталған, дӛңгелектелген және т.б.). 

Тұйықталған контурлар ерекше қасиеттерге ие – бояу, яғни алып жатқан 

аймақты параметрлермен толтыру. Бояу да нысан болып табылады және ӛз 

қасиеттері болады. Бірнеше бояу типтерін ажыратуға болады: 

  негізгі түспен бояу, яғни ішкі аймақты таңдаған түспен толтыру; 

  градиентті бояу – екі түспен бояу; 

  текстуралы бояу – бірқалыпты құрылымды ӛрнекпен толтыру; 

  карта бейнемен бояу – карта деп аталатын дайын растрлық бейнемен 

толтыру. 

  Векторлық кескіндер векторлық графикалық редакторларда жасалады. 

Олардың ішіндегі ең кең таралғаны, сонымен қатар Windows-та жұмыс 

істейтіні CorelDraw болып табылады. Жұмыс істегенде сегменттер мен 

аймақтардың барлық мүмкін математикалық сипаттамалары, бекітілген 

белгілері, бағыттаушы нүктелері және т.с.с. қолданылады. 

Сызықтармен салынатын суреттерді және бірнеше объектілерден тұратын 

суреттерді векторлық графикалық редакторларды пайдаланып салған дұрыс. 

  Растрлық графикалық редактордың артықшылығы – векторлық 

графикалық редактордың кемшілігі болып табылады. Мысалы, векторлық 

кескінді оңай масштабтауға, яғни оның ӛлшемдерін бір немесе бірнеше бағытта 

созу немесе сығу арқылы ӛзгертуге болады. Векторлық кескіндермен жұмыс 
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істеудің кемшілігі – оларды растрлық сияқты жай ғана ӛзгерте салуға 

болмайтындығы.  

Векторлық графиканың қолданылу саласы ӛте кең: 

- біріншіден, ол компьютерлік полиграфияда ӛте үлкен рӛл атқарады. Оңай 

масштабталатын және баспа ӛнімдері мен бейнематериалдарда қолданылатын 

жүздеген түрлі түсті сурет (адамдардың, заттардың бейнесінен бастап, оюлар 

мен әшекейлерге дейін) векторлық әдіспен түсіріледі; 

- екіншіден, векторлық әдіс конструкторлық және ғылыми жұмыстардағы 

компьютерлік сызу автоматтандырылған жобалау жүйелерінде, үшӛлшемді 

графикада және т.с.с. таптырмайтын әдіс болып табылады. 

Векторлық графиканы құруға және ӛңдеуге арналған программалық құралдарға 

графикалық редакторлар (мысалы Adobe Illustrator, Macromedia Freehand, Corel 

Draw) және векторизаторлар (трассирлеушілер – растрлық бейнелерді 

векторлыққа ауыстыратын программалық кешендер, мысалы Adobe StreamLine, 

CorelTrace)  жатады.  

Векторлық редактор Adobe Illustrator осы тектес  программалардың ішіндегі 

ең танымалы. Оның ең басты ерекшелігі Adobe компаниясының басқа 

ӛнімдерімен жақсы қарым-қатынасында, оның ішінде ең алдымен Photoshop 

және PageMarker кешендерімен. Бұл программалар бір стильде орындалып, бір 

кешенді құрайды. 

Векторлық редактор Macromedia Freehand қарапайым интерфейсімен 

жаңадан үйренушілерге қолайлы құрал болып табылады. Программа аз 

мӛлшерімен және жақсы жылдамдығымен ерекшеленеді. Аппараттық 

ресурстарға қоятын талабы аз болғандықтан орташа деңгейдегі 

компьютерлерде жұмыс істей береді. Программа құралдары күрделі 

құжаттармен жұмыс істеуге жеткілікті, тек кейбір элементтерде ғана Adobe 

Illustrator және Corel Draw сияқты қуатты құралдарға жол береді. 

Векторлық редактор Corel Draw Windows платформасында жұмыс істейтін 

негізгі векторлық графиканы құру және ӛңдеу кешені болып саналады. Оның 

ерекшеліктеріне дамыған басқару жүйесі және кеңейтілген құралдар жатады. 

Ең күрделі кӛркем композицияларды құру мүмкіндіктеріне қарай Corel Draw 

бәсекелестерінен әлдеқайда алда тұр. Алайда  программаның интерфейсі 

игеруге күрделі. 

Трассирлеуші Adobe StreamLine ӛзі тектес программалардың ішінде заңды 

түрде алдыңғы қатарда тұр. Сызбаларды  ӛңдеуге арналған басқа да қуатты 

кешендер бар болғанымен олардың аппараттық құралдарға қоятын талабы 

күшті, әрі бағалары да қымбаттырақ. Adobe StreamLine растрлық графикадан 

векторлық графикаға ауыстырғанда ӛлшемдерді ӛте дәл қоюға мүмкіндік 

береді. Векторизациялау ең алдымен сызбалар, ақ-қара суреттер және басқа 

қарапайым графика үшін қолайлы. Күрделі және түрлі-түсті бейнелерді 

нашарлау ӛңдейді, және нәтижесі түпнұсқаға ұқсау үшін біраз жұмыс жасауды 

қажет етеді.  

Компьютерлік графика растрлық пен векторлық болып қана қоймай, 

фракталдық болып та бӛлінеді. 
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Фракталдық графика. Фракталдық графика векторлық графика сияқты, 

математикалық есептеулерге негізделген. Егер растрлық графикада негізгі 

элемент растр (пиксель), ал векторлық графикада – сызық болса, фракталды 

графикада негізгі элемент – математикалық формула, яғни компьютер жадында 

ешқандай объектілер сақталмайды, бейнелер тек теңдеулер кӛмегімен ғана 

салынады. 

Компьютерлік графиканың қолдану салалары 

 Қазіргі кезде компьютерлік графикасыз жұмыс істеу ӛте қиын. Ол тек 

мультфильм, компьютерлік ойын, кӛркем иллюстрация жасайтын мамандардың 

ғана емес, кӛптеген адамдардың іскерлік, ғылыми және инженерлік қызметінің 

ажырамас бӛлігі. 

Әрбір сала үшін графикалық редакторлар деп аталатын арнайы программалық 

қамтамасыз етулері жасалады. Компьютерлік графиканың тӛмендегідей 

бағыттары бар: 

1. Ғылыми графика 

2. Іскерлік графика 

3. Конструкторлық графика 

4. Безендірмелік графика. 

5. Кӛркемдік және жарнамалық графика 

Ғылыми графика. Бұл бағыт бірінші пайда болды. Оның міндеті - 

объектілерді кӛрнекі бейнелеу. Ғылыми және инженерлік қызметте ғылыми 

графика, ғылыми зерттеулер мен сынаулар жүргізгенде, есептеу нәтижесін 

графиктік ӛңдеу үшін, есептеу, експеримент жүргізгенде және олардың 

нәтижесін кӛрнекі кӛрсету үшін қолданылады. Медициналық қызметте ғылыми 

графика кардиограмма, рентгенограмма және т.с.с. түрінде қолданылады. Ал, 

білім беруде – мультимедиалық программалық құралдар түрінде қолданылады. 

Іскерлік графика.  Компьютерлік графиканың бұл саласы әр түрлі мекемелер 

жұмысында жиі қолданылатын безендірмелер (иллюстрация) жасауға арналған.  

Іскерлік графика кӛмегімен жасалынатын безендірме материалдар объектісі - 

жоспарлық кӛрсеткіштер, есеп құжаттар, статистикалық мәліметтер, бұл 

графиктер кӛбінесе диаграмма түрінде болады. Білім беруде компьютерлік 

графика университеттердегі дәріс оқуда, мектептегі сабақ беруде, компьютерлік 

оқыту программаларында, сонымен бірге Internet беттерінде қолданылады. 

Іскерлік графиканың программалық құралдары әдетте кестелік 

процессорлардың (электрондық кестелердің) құрамына кіреді. 

Конструкторлық графика. Бұл автоматтандырылған проектілеу жүйесінің 

элементі. Оның міндеті: 

- техникалық конструкцияны проектілеу процесінде (жазық және үшӛлшемді 

бейнелерді алу) сызба дайындау; 

- модельдеу (графика+есептеу) – оптимальды конструкциялау. 

Безендірмелік графика. Компьютерде графикалық редакторлар кӛмегімен 

сурет салу; 

Көркемдік және жарнамалық графика. Ӛте күшті графикалық пакеттерді 

пайдаланып жарнамалық роликтер, компьютерлік ойындар, мультфильмдер, 

қиын шынайы графикалық бейнелер құру.  Яғни, графикалық бейнелерді құру 
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және ӛңдеу үшін қолданылады, мысалы, баспа басылымдарын, жарнамалық 

роликтерді, фотобейнені қалпына келтіру және ӛңдеу,  мультфильм құру, 

видеосабақ, компьютерлік ойын жасау үшін қолданылады. Архитектурада 

сызба дайындау процесін автоматтандыруға және  ғимараттарды қабаты 

бойынша жобалауға мүмкіндік береді.  

Графика  форматтары 

  Компьютерлік графикада мәліметтерді сақтау үшін аз дегенде 

файлдардың отыз шақты форматтары қолданылады. Бірақ солардың ішінде 

бірнешеуі ғана кӛпшілік программада қолданылып, стандарт ретінде 

қалыптасқан. Ережеге сай, сәйкес келмейтін форматтар растрлық, векторлық, 

үш ӛлшемді бейнелі файлдар болып келеді, дегенмен әр түрлі класқа жататын 

мәліметтерді сақтауға мүмкіндік беретін форматтар да жоқ емес. Кӛптеген 

қосымшалар ӛзінің жеке «ӛзіне тән» (спецификалық) форматтармен ғана жұмыс 

істейді; олардың файлдарын ӛзге программаларға ауыстыру арнайы 

фильтрлерді қолдануға немесе бейнені «стандартты» форматқа алмастыруға 

мәжбүрлейді. 

TIFF  (Tagged Image File Format). Формат жоғары сапалы растрлық 

бейнелерді сақтауға арналған (файл атының кеңейтілуі TIF). Кеңінен таралған 

форматтар қатарына жатады, кӛптеген графикалық, дизайнерлік программалар 

тарапынан қамтамасыз етілген. СМҮК түсбӛлінісінің монохромды ақ-қара 

түсінен бастап 32-разрядты модельдерге дейінгі түстердің кең диапазонын 

қамтиды. 6.0 версиясынан бастап TIFF форматында бейненің маскілері 

(контурлары) жайлы мәліметтерді сақтауға болады. Файлдың кӛлемін азайту 

үшін ішкі LZW сығымдау алгоритмі қолданылады. 

PSD (Photoshop Document). Растрлы графикалық  ақпаратты сақтау 

мүмкіншілігіне қарай анағұрлым қуатты программалардың бірі (файл атының 

кеңейтілуі PSD). Кӛптеген маскілерді, айқындық дәрежесін, арналарды, қабат 

параметрлерін сақтауға мүмкіндік береді. Әр түрлі түстік модельдер мен түс 

бӛлу, түсті 48-разрядпен кодтау қолданылады. Басты кемшілігі, ақпаратты 

сығымдаудың тиімді алгоритмінің болмауынан файл кӛлемінің ӛсуіне алып 

келетіндігінде. 

PСX. Формат Z-Soft фирмасының PC PaintBrush программасының растрлық 

мәліметтерін сақтау форматы ретінде пайда болды және анағұрлым кең 

таралғандардың бірі болып табылады. (файл атының кеңейтілуі . PSХ). Түске 

бӛлінген бейнені сақтау мүмкіндігінің болмауы, түстік модельдердің 

жетіспеушілігі мен ӛзге де шектеулер форматтың танымалдылығының 

жоғалуына алып келді. Қазіргі кезде формат кӛнерген болып саналады. 

PhotoCD. Формат жоғары сапалы сандық растрлы бейнелерді сақтау үшін 

Kodak фирмасында жасалған. (файл атының кеңейтілуі .PSD). Мәліметтерді 

файлда сақтау форматы Image Pac деп аталады. Файл бейнені кӛрсетілімнің 

белгіленген шамасында сақтауға мүмкіндік беретін ішкі құрылымнан тұрады, 

сондықтан да бұл форматта сақталған кез-келген файл кӛлемінің бір-бірінен 

айырмашылығы болмашы ғана және 4-5 Мбайт аралығында болады. Әрбір 

кӛрсетілімге 512х768 нүктеден тұратын базалық деп аталатын (Base) деңгейден 

оқылатын жеке деңгей бекітілген. Файлда барлығы Base/16-дан (128х192 нүкте) 
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бастап Baseх 16-ға (2048-3072 нүкте) дейін бес деңгей бар. Бастапқы бейнені 

бірінші мәрте сығымдауда іс жүзінде сапа жоғалмайтын субдискреттеу әдісі 

қолданылады.  

Windows Bitmap. Windows операциялық жүйесінде растрлық бейнелерді 

сақтау форматы (файл атының кеңейтілуі .ВМР). Сәйкесінше бұл ортада жұмыс 

істейтін барлық қосымшаларда қолданылады. 

JPEG (Joint Photographic Experts Groups). Формат растрлық бейнелерді 

сақтауға арналған (файл атының кеңейтілуі . JPG). Бұл формат файлды 

сығымдау дәрежесі мен бейне сапасы арасындағы арақатынасты реттеуге 

мүмкіндік береді. Сығымдауда қолданылатын әдістер «артық» ақпаратты 

ӛшіруге негізделген, сондықтан да форматты тек электрондық жарияланымдар 

үшін қолданған жӛн. 

GIF (Graphics Interchange Format). Түстердің саны (256) белгіленген 

сығымдалған бейнелерді сақтау құралы ретінде 1987 жылы стандартталған 

(файл атының кеңейтілуі .GIF). Жоғары дәрежеде сығымдалуы арқасында 

Интернетте танымал болды. Форматтың соңғы нұсқасы бейненің жолтастап 

жүктелуіне және түссіз фонды суреттер құруға мүмкіндік береді. Түстер санына 

шектеу қойылуына байланысты бұл формат тек электрондык жарияланымдарда 

ғана қолданылады. 

PNG (Portable Network Graphics). Бейнелерді Интернетте жариялауға 

арналған салыстырмалы түрде жаңа (1995 жыл) сақтау форматы (файл атының 

кеңейтілуі .PNG). Бейненің үш типі – түрлі-түсті 8 немесе 24 биттік тереңдікпен 

және сұр түстің 256 градациясы бар ақ-қара түс қолданылады. Ақпаратты 

сығымдау іс жүзінде ешбір жоғалыссыз жүргізіледі және 254 деңгейлі альфа-

канал қарастырылған. 

WMF (Windows MetaFile). Windows операциялық жүйесінің векторлық 

бейнелерін сақтау форматы (файл атының кеңейтілуі .WMF). Анықтама 

бойынша жүйенің барлық қосымшаларында қолданылады. Бірақ полиграфияда 

қабылданған стандартты түстік палитралармен жұмыс істеуге арналған 

құралдардың болмауы және ӛзге де кемшіліктер оның кеңінен қолданылуына 

кедергі жасайды. 

EPS (Encapsulated PostScript). Векторлық, сондай-ақ растрлық бейнелерді іс 

жүзінде баспаға дейінгі процестер мен полиграфия саласында стандарт болып 

табылатын Abode фирмасының PostScript тілінде сипаттау форматы (файл 

атының кеңейтілуі .EPS).  PostScript тілі әмбебап болып табылатындықтан, 

файлда векторлық және растрлық графика, қаріптер, контурлар (маскілер), 

құрал-жабдықтарды пішімдеу параметрлері, түстік профильдер бір уақытта 

сақтала алады. Экранда векторлық мәнді кӛрсету үшін – WMF, ал растрлық 

үшін – TIFF форматы қолданылады. Бірақ экрандық кӛшірме жалпы алғанда 

EPS-тің елеулі кемшілігі болып табылатын тек нақты бейнені ғана кӛрсетуге 

қабілетті. Шынайы бейнені шығару құрылғыларының, не болмаса арнайы кӛру 

программарының кӛмегімен немесе файлды Acrobat Reader, Acrobat Exchange 

қосымшаларының PDF форматына түрлендіргеннен кейін ғана кӛруге болады. 

PDF (Portable Document Format). Abode фирмасы шығарған құжаттарды 

сипаттау форматы (файл атының кеңейтілуі .PDF). Дегенмен, бұл формат 
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негізінен құжатты тұтастай сақтауға арналған, оның таңқаларлық мүмкіндіктері 

бейненің шынайы кӛрінуін қамтамасыз етуге жағдай жасайды. Формат 

аппаратты-тәуелсіз болып табылады, сондықтан да бейнені монитор экранынан 

бастап фотоқұрылғыға дейінгі кез келген құрылғыдан шығаруға болады. 

Бейненің аяқталған кӛрсетілімін басқару құралдарының кӛмегімен 

сығымдаудың қуатты алгоритмі жоғары сапалы иллюстрациялары бар 

файлдарды ықшамдауға мүмкіндік береді.  

Түс ұғымы 

 Түс бейненің ақпараттық маңызын кӛтеруге және кӛрініс әсерін күшейту 

құралы ретінде компьютерлік графикада ӛте маңызды орын алады. Түс жарық 

шығаратын немесе шағылысатын объектілерден кӛзге түсетін жарықты 

адамның миы талдау нәтижесінде қабылданады. Түстік рецепторлар әрқайсысы 

тек бір ғана түсті қабылдайтын үш топқа бӛлінеді. Олар қызыл, жасыл және кӛк 

түстер. Топтағы бір түстің жұмысының бұзылуы дальтонизмге – түсті дұрыс 

қабылдамауға, түсті ажырата алмауға соқтыруы мүмкін. 

Жарық ағыны үш «таза» спектрлі түстердің құрылымынан (қызыл, жасыл, кӛк – 

ҚЖК) және олардың туындысынан құралады (ағылшын тіліндегі әдебиеттерде 

(RGB – Red, Green, Blue қолданылады). Жарық шығаратын нысандар үшін 

аддитивті түс шығару тән де, ал (жарық сәулелерінің қосындысымен) 

шағылысатын нысандар үшін субтрактивті түс шығару (жарық сәулелері 

алынады) тән. Бірінші типті нысанға мысал ретінде монитордың электронды-

сәулелі түтігін, ал екінші типке полиграфиялық баспаны айтуға болады. Жарық 

ағындарының физикалық сипаттамасы қуаттылық, ашықтық және 

жарықтандырылу  параметрлерімен анықталады. Түстеудің визуалды 

параметрлері жарықтығымен яғни жарықты әлсіз немесе күштерік шығаратын 

аймақтарды ажыратумен сипатталады. Нысандардың жарықтығы бойынша 

ажыратылатын ашық түстер арасындағы минималды айырмашылықты тоғыс 

деп атайды. Тоғысу шамасы ашық түстер қатынасының логарифміне 

пропорционал. Ашық түстер логарифмінде немесе оптикалық жазықтықта 

берілген нысандардың оптикалық сипаттамаларының реті (ӛсу немесе кему 

бойынша орналасқан) градацияны құрайды және бейнені ӛңдеу мен талдаудың 

маңызды құралы болып табылады. 

 Монитор экранынан бейненің дәл түсін шығару үшін түстік температура 

түсінігінің маңызы зор. Классикалық физикада Кельвин шкаласы бойынша 0 

градустан жоғары температуралы кез-келген дене сәуле шығарады деген 

анықтама бар. Температура кӛтерілген кезде сәуле шашу спектрі оптикалық 

сәулелер арқылы инфрақызылдан бастап ультра күлгінге дейін араласады. Таза 

қара түсті дене үшін сәуле толқынының ұзындығы мен дене температурасы 

арасындағы байланыс жеңіл табылады. Осы заңдылық негізінде күннің 

температурасы қашықтықтан есептегенде 6500 К болған. Түстерді дұрыс түрде 

алу үшін кері әрекет орындалады. Яғни түстік температурасы 6500 К-ге тең 

монитор осынша дәрежеге дейін қыздырылған қара түсті дененің сәулелену 

спектрін жоғары дәлдікпен шығаруы керек. Осылайша түс температурасының 

стандартты мәндерін әр түрлі сәуле шығару құрылғыларынан бірдей түс алуды 

қамтамасыз ететін жалпыға ортақ тәсіл ретінде қолданады. 
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 Іс жүзінде адамның жанары жарық кӛздерінен шығатын сәулелердің түстік 

температурасына тән спектрлерге үздіксіз бейімделіп отырады. Мысалы 

даладағы шуақты күнде түстік температура шамамен 7000 К-ді құрайды. 

Айталық  даладан тек электр шамымен жарықтанып тұрған ғимаратқа кірсеңіз, 

алғашқыда шам күңгірт (түстік температура шамамен 2800 К) сары болып 

кӛрінеді. Тіпті ақ қағаздың ӛзі сары рең береді. Сонан соң жанарымыз 2800 К 

түстік температураға тән жаңа ҚЖК түске сәйкес бейімделеді де шам жарығы 

мен қағазымыз ақ түс ретінде қабылданады. 

 Түстің қанықтылығы (насыщенность) аталмыш түстің сол түстің 

монохроматикалық («таза») сәулеленуінен қаншылықты дәрежеде 

ерекшеленетінін кӛрсетеді. Компьютерлік графикада бірлік ретінде түстердің 

спектрі сәулеленуінің қанықтылығы қабылданған. Хроматикалық түстерде 

түстің ӛңі мен жарықтылығы, қанықтылық  параметрлері бар. 

Түстеу тәсілдері 

 Компьютерлік графикада түстік кӛрсетілім ұғымын (басқаша атауы – түс 

тереңдігі) қолданады. Ол оны монитор экранынан кӛрсету үшін түстік 

ақпаратты кодтау әдісін анықтайды. Ақ-қара түсті бейнені алу үшін екі бит 

жеткілікті. Ал сегіз разрядты кодтау түстердің 256 градациясын бейнелеуге 

мүмкіндік береді. Екі байт (16 бит) 65536 реңді анықтайды (мұндай режим  

High Color аталады) 24-разрядты кодтау әдісімен 16,5 миллионнан астам түсті 

сипаттауға болады (бұл режим True Color аталады). Тәжірибе жүзінде 

монитордың түстік кӛрсетіліміне түстік қамту  ұғымы жақын. 

Онымен қандай да бір шығару құрылғысының кӛмегімен түстер диапазонын 

шығару түсіндіріледі (монитор, принтер және т.б.). 

 Бейнені аддитивті немесе субтрактивті әдістермен құру ұстанымдарына 

сәйкес, түстік модельдер деп аталатын түс реңдерін құрамдас бӛліктерге бӛлу 

тәсілі жасалған. Компьютерлік графикада негізінен RGB және HSB (аддитивті 

бейнені құру мен ӛңдеуге арналған) сондай-ақ CMYK (бейне кӛшірмесін 

полиграфиялық құралдармен басып шығаруға арналған) модельдері 

қолданылады.  

СІЕLab түстік моделі 

 1920 жылы түстік кеңістік моделі СІЕLab (Communication International del 

Eclairage – жарықтандыру бойынша халықаралық комиссия. L,a,b – осы 

жүйедегі координаталар ӛсінің белгіленуі) жасалады.  

CIELab моделінде кез келген түс жарықтығымен (L) және хроматикалық 

құрамымен: жасылдан қызылға дейін ӛзгеретін диапазон параметрімен (a), және 

кӛктен сарыға дейін ӛзгеретін диапазон параметрімен (b) анықталады. CIELab 

моделінің түсті қамтуы баспа құралдары мен монитор мүмкіндіктерінен 

біршама асып түседі, сондықтан бұл модельмен бейнені баспаға шығармас 

бұрын оны түрлендіріп алуға тура келеді. Аталмыш модель түрлі-түсті 

химиялық процестерді полиграфиялық процестермен үйлестіру үшін жасалған 

болатын. Бүгінге ол Adobe Photoshop программасы үшін бірауыздан 

мақұлданған стандарт болып табылады. 
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RGB түстік моделі  

 RGB түстік моделі аддитивті болып табылады, яғни кез келген түс әр түрлі 

деңгейде үш негізгі түстің – қызыл (Red), жасыл (Green), кӛк (Blue) 

қосындысынан тұрады. Ол – электрондық түрде кӛрсетуге арналған 

(мониторда, телевизорда) компьютерлік график құру мен оны ӛңдеуде негізгі 

қызмет атқарады. Негізгі түстің бір компонентін, екіншісінің үстінде қолдануда 

сәулеленудің сомалық жарықтығы ұлғаяды. Үш компоненттің араласуы, 

жарықтығын ұлғайтқан кезде ақ түске жақындайтын ахроматикалық сұр түсті 

береді. Ӛңнің 256 градациялық деңгейінде қара түске RGB–дің нӛлдік мәні, ал 

ақ түске (1,1,1) координатымен ең жоғарғы мәні сәйкес келеді. 

HSB түстік моделі                     

 HSB түстік моделі адамның түс қабылдау ерекшеліктерін жан-жақты есепке 

ала отырып жасалған. Ол Манселдің түс шеңбері негізінде тұрғызылған. Түс үш 

компонентпен: ӛңмен, қанықтылықпен, жарықтықпен сипатталады. Түстің 

мәнін шеңбердің центрінен шыққан вектор түрінде таңдайды. Центрдегі нүкте 

ақ түске, ал шеңбердің периметріндегі нүктелер – таза спектрлі түстерге сәйкес 

келеді. Вектор бағыты градуспен беріліп, түстің реңін сипаттайды. Вектордың 

ұзындығы түстің қанықтылығын сипаттайды. Ахроматикалық деп аталатын 

ӛсте жарықтығы беріледі, бұл жағдайда нӛлдік нүкте қара түске сәйкес  келеді. 

HSB моделінің түс қамтуы нақты түстердің бізге белгілі барлық мәндерін 

қабылдайды. HSB моделін компьютерде бейне құруда суретшінің жұмыс 

әдістерін имитациялау мен құралы ретінде қолдану қабылданған. Қаламсап, 

сауыт, кисттерді имитациялайтын арнайы программалар бар. Олар арқылы әр 

түрлі тұстармен және бояулармен жұмыс имитациясы қамтамасыз етіледі. 

Бейне құрғаннан кейін жарияланым түріне қарай оны ӛзге түстік модельге 

түрлендіру ұсынылады. 

СМYK түстік моделі 

 CMYK түстік моделі субстрактивті болып табылады және оны 

жарияланымды баспаға дайындауда қолданады. СМҮK-дің түстік 

компоненттеріне ақ түстен бӛлініп алынған негізгі түстер қызмет етеді. 

кӛгілдір (cyan) = ақ – қызыл =  жасыл + кӛк 

күлгін (magenta)  =ақ – жасыл = қызыл + кӛк 

сары(yellow)  = ақ – кӛк = қызыл + жасыл  

 Мұндай әдіс түпнұсқадағы баспадан шағылған сәуленің физикалық 

табиғатына сай келеді. Кӛгілдір, күлгін және сары түстерді толықтырушы деп 

аталады, себебі олар негізгі түстерді ақ түске дейін толықтырады. Бұдан СМҮK 

түстік моделінің басты проблемасы – толыктырушы түстерді іс жүзінде бірінің 

үстінде бірін қолдану таза қара түсті алуға мүмкіндік бермейтіндігі келіп 

шығады. Сондықтан да түстік модельге таза қара түс компоненті қосылған. 

СМҮК түстік моделінің аббревиатурасындағы тӛртінші әріп (Cyan, Magenta, 

Yellow, black) осылайша пайда болған. Түрлі-түсті компоненттерлік бейнені 

полиграфиялық құралда басу үшін СМҮК түстік моделінің компоненттерімен 

сәйкес келетін құрамдас бӛліктерге бӛлу қажет. Бұл процесті түс бӛлу деп 

атайды. Нәтижесінде түпнұсқада компоненттің түсінен тұратын тӛрт жеке 

бейне алынады.  
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Түстік палитра 

 Компьютерлік графикадағы электрондық түстік палитра мақсаты бойынша 

суретші  палитрасына ұқсас, бірақ мұнда анағұрлым кӛп түс қолданылады. 

Электрондық палитра әрқайсында жекелеген түс рендері бар қандай да бір 

ұяшықтардан тұрады. Нақты бір түстік палитра  қандай да бір түстік модельге 

жатады, себебі ондағы түстер сол модельдің түс кеңістігі негізінде құрылады. 

Дегенмен егер түстік модельде онда сипатталатын барлық түсті кӛрсетуге 

болатын болса, түстік модель стандартты деп аталатын түстердің шектелген 

жиынынан тұрады. 

 Компьютерлік графиктерді құруға және ӛңдеуге арналғаң программалар 

ережеге сай RGB, HSB, CIELab, CMYK түстік модельдеріндегі бірнеше түстік 

палитраларды таңдауыңызға ұсынады. 

RGB түстік палитрасының құрамы таңдалынған түстік кӛрсетілімге -24, 16 

немесе 8 битке тәуелді. Соңғы жағдайда түстік палитра индекстік деп аталады, 

себебі әрбір түстік рең пиксел түсін емес, түс индексін (нӛмірін) білдіретін бір 

ғана санмен кодталады. Осылайша индекстік палитрада құрылған түрлі–түсті 

бейне файлына, компьютерлік графиканы ӛндеу программасына нақты қай 

палитра қолданылатындығы белгісіз болғандықтан, палитраның ӛзі қоса 

жазылуы керек. Интернетте жариялауға арналған бейне түстердің қауіпсіз 

палитрасы деп аталатын палитрадан құрылады. Ол әуелде аталған индекстік 

палитралардың бір нұсқасы болып табылады. Бірақ Web графикадағы бейне 

файлдарының кӛлемі кіші болу керектігі ескеріліп, оның құрамына индекстік 

палитраны қосудан бас тарту қажет болады. Ол үшін «қауіпсіз» деп аталатын, 

яғни кез келген құрылғыда түстердің дұрыс кӛрінуін қамтамасыз ететін, бірегей 

палитраны қолдануға мүмкіндік беретін бірегей белгіленген түстер палитрасы 

қабылданған. Қауіпсіз палитра  IBM PC класына жатпайтын компьютерлермен 

сәйкестік талаптарынан туындайтын шектеулерге байланысты бар-жоғы 216 

түстен тұрады. 

 

2. ADOBE PHOTOSHOP ПРОГРАММАСЫНДА ОРЫНДАЛАТЫН 

ПРАКТИКАЛЫҚ ТАПСЫРМАЛАР 

Практикалық тапсырма №1. Көлемді батырмалар құру 

1-әдіс. Жаңа файл құрыңыз (фонның түсі - ақ). 

Шеңбер салыңыз. Фон түсі - қызыл, ал алдыңғы түс – қара қылып алдын-ала 

таңдап алып, бӛліп алынған шеңберге градиентті құюды қолданыңыз. 

 Мәзірден Выделение  Модифицировать  Сжать командасын таңдаңыз. 

Қарама-қарсы бағытта жаңа шеңберге градиентті құюды қолданыңыз.  

Батырмаға әріп, сан немесе сӛз енгізіңіз. Кӛлеңкемен толықтырыңыз (1-сурет). 

                                                                         

 

 

 

 

 

                                                              1-сурет (нәтиже) 



17 

2-әдіс. Ең бірінші, дайындаманы салып алу керек. Ол үшін Rounded Rectangle 

(Бұрыштары дӛңгелектелген тіктӛртбұрыш, Скругленный прямоугольник) 

құралын немесе ерекшелеу құралдарының бірігуін пайдалануға болады. Біз 

екіншісін таңдайық, себебі, оны Photoshop-тың ескі версияларын 

пайдаланушылар да қолдана алады. 

  Rectangle Marquee (Тіктӛртбұрышты ерекшелеу, Прямоугольное 

выделение) құралын алып ӛлшемі батырмаға сәйкес келетіндей аймақты 

ерекшелеп алыңыз. Содан кейін Elliptical Marquee (Эллипстік ерекшелеу, 

Эллиптическое выделение) құралын алыңыз және мәндер панеліндегі Add to 

Selection (Ерекшеленгенге қосу, Добавить к выделению) батырмасын шертіп, 2-

суреттегіге сәйкес ерекшелеуді құрыңыз. 

  Ерекшеленген аймақты ақ түске бояп, оның кӛшірмесін алыңыз (Ctrl+C) 

және оны қойып (Ctrl+V), Free Transform (Еркін тасымалдау, Свободное 

трансформирование) құралының кӛмегімен оны айналдырыңыз. Нәтижесінде 

батырманың дайындамасын аламыз (3-сурет). Сосын батырма бӛліктері 

орналасқан қабаттарды біріктіріңіз. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Сосын Paint Bucket (Құю, Заливка) құралының кӛмегімен батырманы басқа 

түске бояйық. Мысалы кӛк түс (R 85, G 140, B 187). Алайда ақ пен қарадан 

басқа кез келген түсті таңдай аласыз. 

Дайындамаға қабаттың Bevel and Emboss (Скос және рельеф) стилін 

қолданайық: Layer  Layer Style  Bevel and Emboss (Қабат  Қабат стилі  

Скос және рельеф). Оның баптаулары 4-суретте кӛрсетілген. Осы әрекеттің 

нәтижесі 5-суретте кӛрсетілген.  

 

 

 

 

 

 

 

2-сурет 
3-сурет 
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Осыдан кейін Layer Style (Қабат стилі) терезесін жаппай тұрып, құрылған 

стильге 6-суреттегі баптауларды бере отырып Gradient Overlay (Градиентті 

орнату, Наложение градиента) әсерін қосыңыз. Егер барлығы дұрыс орындалса, 

онда нәтижесі 7-суреттегіге сәйкес келуі керек. 

 

 

 

 

 

 

 

 

 

 

 

 

Алдыңғы екі әсерге Inner Shadow (Ішкі кӛлеңке, Внутренняя тень) әсерін 

қосыңыз (8-сурет). Inner Shadow (Ішкі кӛлеңке, Внутренняя тень) әсерін 

қосқаннан кейінгі нәтиже 9-суретте кӛрсетілген. 

 

 

 

 

 

 

 

 

 

 

 

 

4-сурет 
5-сурет 

6-сурет 7-сурет 

8-сурет 9-сурет 
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Жаңа қабат құрыңыз (Shift+Ctrl+N). Жаңадан ерекшелеу енгізіңіз және оны 

басқа түске бояңыз (мысалы, R 111, G 176, B 225). Жаңа элементтің ӛлшемі мен 

формасын 10-суреттен кӛре аласыз. 

Оны Gaussian Blur (Гаусс бойынша шаю) сүзгісінің кӛмегімен шайыңыз: Filter 

 Blur  Gaussian Blur (Сүзгі  Шаю  Гаусс бойынша шаю, Фильтр  

Размытие  Размытие по Гауссу) (11-сурет).  

 

 

 

 

 

 

 

 

 

 

Нәтижесінде 12-суреттегідей батырма аласыз.  

Қайтадан жаңа қабат құрыңыз. Бірақ осы жолы ерекшелеуді батырманың 

жоғарғы бӛлігіне орнатыңыз (13-сурет). Gradient (Градиент) құралын алып, 

ерекшеленгенді қарадан ақ түске ӛтетін стандартты сызықтық градиентпен 

бояңыз (14-сурет).  

 

 

 

 

 

 

 

 

 

 

 

 

 

Layers (Қабаттар) палитрасын ашып градиенті бар қабат үшін Blending Options 

(Орналастыру мәндері, Параметры наложения) мәнін - Screen (Экран), ал 

Opacity (Мӛлдір еместік, Непрозрачность) мәнін – 75% деп алыңыз. Нәтижесі 

14-суретте кӛрсетілген. 

Кез келген мәтін жазып, қабаттың Drop Shadow (Сыртқы кӛлеңке, Внешняя 

тень) стилінің кӛмегімен оған аздап кӛлеңке қосыңыз. Layers палитрасындағы 

мәтіні бар қабатты градиенті бар қабаттан тӛмен орналастырыңыз. Соңғы 

нәтиже 15-суретте кӛрсетілген. 

 

 

 

10-сурет 
11-сурет 

12-сурет 13-сурет 
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Практикалық тапсырма №2. От түрінде жанып тұрған мәтін 

    Photoshop-та кез-келген жұмысты бастамас бұрын қолданыста болған 

бейнені ашу керек немесе жаңа бейне құру керек. Біздің жағдайымызда біз 

жаңа бейнемен жұмыс істейміз. Кез-келген ӛлшем беріп, Crayscale (Жарты 

тондық) режимінде бейне құрыңыз. Фон түсі ақ болуы керек. Horizontal Type 

(Кӛлденең орналасқан мәтін) құралын пайдаланып сӛзді қара әріптермен 

жазыңыз. Біз жұмыс істейтін сӛз 16-суретте кӛрсетілген. Мәтіннің ӛлшемі мен 

формасын оны жазып болғаннан кейін де ӛзгертуге болады. Сызықтық 

ӛлшемдерін ӛзгерту қажет болған жағдайда кӛбінесе Edit → Free Transform 

(Ӛңдеу → Еркін тасымалдау) командасы қолданылады (немесе Ctrl+T). Ал егер 

мәтінді майыстырып жазу (мысалы, шеңбер бойымен) керек болса, онда 

параметрлер тақтасындағы Create Warped Text (Мәтінді деформациялау) тетігін 

немесе мәтінді контур бойымен жазу мүмкіндігін пайдаланған дұрыс. 

         

 

 

                                               16-сурет. 

     Енді мәтін орналасқан  қабат пен фон қабатын біріктіру қажет. Бұл 

әрекетті  Layer → Merge Down (Қабат → Алдыңғысымен біріктіру) командасын 

қолданып немесе  Ctrl+E  қос пернелер комбинациясын басу арқылы орындай 

аламыз. 

Келесі сатыда алынған мәтінді кристалдаңыз. Кристалдау сүзгісі Filter → 

Pixelate → Crystallize (Сүзгі → Безендіру → Кристалдау) мәзір командасы 

арқылы орындалады. Crystallize (Кристалдау) диалогтық терезесінде 

кристалдаудың ұяшық ӛлшемін 3–5 пиксел аралығында беріңіз (17-сурет). 

Ал енді бейнені шайыңыз. Ол үшін Caussion Blur сүзгісін қолданыңыз,  яғни  

Filter → Blur → Caussion Blur (Сүзгі → Шаю → Гаусс әдісі бойынша шаю). 

Шаюдың радиусы (Radius) бейненің ӛлшемі мен таңдалынған шрифтқа 

байланысты болады, яғни неғұрлым әріптер үлкен болса, соғұрлым радиусы да 

үлкен болуы ерек (18-сурет). 

 

 

 

 

 

14-сурет 15-сурет (нәтиже) 
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Image → Adjustments → Inverse (Бейне → Баптаулар → Инвертирлеу) 

командасы арқылы немесе  Ctrl+I  қос пернелер комбинациясын басу арқылы  

сурет түсін инвертирлеңіз. Бұл команда барлық түстерді қарама–қарсы түстерге 

ауыстырады. Сіз Crayscale режимінде жұмыс істеп отырғандықтан қара түстер 

ашық түстерге, ал ашық түстер қара түстерге ауысады. Егер  барлығы дұрыс 

орындалса, сіздің бейнеңіз 19–суреттегідей болады. 

 

 

 

 

19-сурет. Кристалдағаннан және шайғаннан кейінгі мәтін 

 

 Бейнені сағат тілінің бағытына қарсы 90
0
–қа бұрыңыз: Image → Rotate Canvas 

→ 90 CCW  (Бейне → Бұру → Сағат тілінің бағытына қарсы 90
0
–қа) (20-сурет). 

Бұл амал келесі сатыда тек кӛлденең бағытта орындалатын Wind  (Жел) сүзгісін 

пайдалану үшін қажет.  

От жалынын әзірше ақ–қара түсті нұсқада жасайық, ол үшін Filter → Stylize → 

Wind (Сүзгі → Стилдеу → Жел) (21-сурет). Мұнда From the left (Сол жақтан 

соққан жел) ауыстырғышын таңдаңыз. Егер сізге жалын ұзындығы жеткіліксіз 

болса, онда Ctrl+F қос пернелер комбинациясын пайдаланып осы әрекетті тағы 

да қайталауға болады. Біздің мысалда ол екі рет қолданылған.  

 

 

 

 

 

 

 

17-сурет. Crystallize (Кристалдау) 

әдісі сүзгісінің диалогтық терезесі 

18-сурет. Caussion Blur (Гаусс 

бойынша шаю) сүзгісінің диалогтық 

терезесі 
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Шындыққа сай келу үшін от жалынына толқындар қосыңыз. Оны Filter → 

Distort → Ripple (Сүзгі → Деформациялау → Бұлдыр) командасы арқылы 

орындай аласыз. Біздің мысалда параметрлерге мынандай мәндер берілген: 

Amount (Әсер) – 50%, Size (Ӛлшемі) – орташа (Medium) (22-сурет). 

 

 

 

                                       

 

    

 

 

 

 

 

 

 

 

 

 

Енді суретіңізді бастапқы қалпына бұрыңыз: Image → Rotate Canvas → 90 CW 

(Бейне → Бұру → Сағат тілінің бағытымен 90
0
–қа), нәтижесі 24-суретте 

кӛрсетілген. 

 

 

 

 

 

 

20-сурет. Инвертирленген және 

бұрылған бейне 

 

21-сурет. Wind ( Жел) сүзгісінің 

диалогтық терезесі 

22-сурет. Wind ( Жел) сүзгісін 

пайдалан-ғаннан кейін пайда болған 

жалын 

23-сурет. Ripple (Бұлдыр) сүзгісінің 

баптаулары 
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24-сурет. Кӛлденеңінен қойылған бейне 

 

 Filter → Distort → Ripple  (Сүзгі → Деформациялау → Бұлдыр) командасын 

тағы бір рет қолданайық. Бірақ енді Amount – 30%, ал  Size – High (Жоғары) 

болсын. 

  Енді от жалынын бояу ғана қалды. Ол үшін ең бірінші бейнені индекстелген 

түстер режиміне ауыстыру керек: Image → Mode → Indexed Color (Бейне → 

Режим → Индекстелген түстер). Осыдан кейін жартытондық  бейнеге лайық 

түстік модельді таңдау керек. От жалыны үшін ең лайық команда: Image → 

Mode → Color table (Бейне → Режим → Түстік таблица) Осы кезде түстік  

таблицаның баптаулары бар диалогтық терезе пайда болады. Ашылатын 

тізімнен Black Body кестесін таңдаңыз (25-сурет). 

Жұмыстың соңғы нәтижесі 26–суретте кӛрсетілген. 

 

                       

 

  

 

 

 

 

 

 

 

 

                                           

 

 

 

 

 

 

 

 

 

25-сурет. Түстік кесте      26-сурет (нәтиже). 
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Практикалық тапсырма №3. Мұз түрінде жазылған мәтін 

Crayscale (Жартытондық) режимінде кез келген форматтағы жаңа бейне 

құрыңыз. Фонның түсі – ақ, ал алдыңғы жоспар түсі – қара болуы керек (бұлар 

келісім бойынша басты түстер болып саналатындықтан, түстер палитрасына 

кірмей–ақ, D пернесін басу арқылы осы амалды бірден орындай  аламыз). 

Шриф ӛлшемін массивті және жартылай жуан етіп алып, 27-суретте кӛрсетілген 

мәтінді теріңіз. Мәтінді ӛңдеп, оған қолайлы орынды таңдаңыз (тӛменгі 

жағынан мұз орналасатындай орын қалу керек). 

 

 

 

 

 

                                                 

                                                  27-сурет 

 

  Layer (Қабат) палитрасын ашып, мәтін орналасқан қабаттың үстіне 

апарып, тышқанның оң жақ  тетігін басыңыз. Пайда болған контекстік мәзірден  

Rasterize  Layer (Қабатты растрлеу) пунктін таңдаңыз. Осы кезден бастап сіз  

Photoshop–тың растрлық бейнені ӛңдеуге арналған стандартты құралдарының 

кез келгенін мәтінге қолдана аласыз. 

  Ал енді жазбаны мұзға айналдыруды бастайық. Ең алдымен 

кристалдауды орындаймыз, яғни  Filter → Pixelate → Gistallize (Сүзгі → 

Безендіру → Кристалдау) (28-сурет). Кристалдаудың ұяшық ӛлшемін 10-ға тең 

деп алыңыз.  

Мұздың беті теп–тегіс болмағандықтан, оған кедір-бұдырлар қосу керек. Ол 

үшін шу қосыңыз: Filter → Noise → Add Noise  (Сүзгі → Шу  → Шу қосу). Ең 

бастысы Monochromatic (Монохромды) – деген жерге белгі қойыңыз, Amount 

(Әсер) мәнін 70%  етіп орнатыңыз (29-сурет).  

 

 

                         

 

 

 

 

 

 

 

 

 

 

 

 

 

28-сурет. Gistallize (Кристалдау) 

сүзгісінің диалогтық терезесі 
29-сурет. Add Noise  (Шу қосу) 

сүзгісінің диалогтық терезесі 
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  Кристалдау мен шу қосудан алынған әсерді жұмсартайық. Оны Caussisan 

Blur сүзгісі арқылы  орындауға болады, яғни Filter →  Blur → Caussian Blur 

(Сүзгі → Шаю → Гаусс әдісі бойынша шаю). Ӛте қатты шаюдың қажеті жоқ, 

себебі кедір-бұдырды жоғалтып алуымыз мүмкін. Ең дұрысы шаюдың 

радиусын 2–ге тең етіп алыңыз (30-сурет). 

  Енді сіз түсті коррекциялаудың екі әдісінің бірін таңдай аласыз. 

a) Қарапайым, бірақ аз әсерлі әдіс:  Filter → Blur → Blur (Сүзгі → Шаю →Шаю) 

командасы арқылы орындалады. Енді жазу орналасқан  қабат пен фон қабатын 

жабыстыру қажет, ол үшін Layer → Merge Down (Қабат → Алдыңғысымен 

біріктіру) командасын немесе  Ctrl+E қос пернелер комбинациясын басу керек. 

Осыдан кейін бейнені инвертирлеген жӛн (қабаттарды жабыстыруды қажет еді, 

себебі келесі ӛңдеулер мәтінге ғана емес фонға да байланысты орындалады). 

Image → Adjustments → Inverse (Бейне → Баптаулар → Инвертирлеу) 

командасын орындаңыз немесе Ctrl+I қос пернелер комбинациясын басыңыз. 

б) Бұл әдіс қиындау болғанымен кӛптеген мүмкіндіктер береді. Image → 

Adjustments → Curves (Бейне → Баптаулар → Қисықтар) командасын таңдаңыз 

немесе Ctrl+M қос пернелер комбинациясын басыңыз. 31-суретте 

кӛрсетілгендей етіп қисық салуға тырысыңыз.  

 

                               

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Егер соңғы нәтиже сізді қанағаттандырмаса, қисықты қалауыңызша 

ӛзгертіп сала аласыз. Қисықты салғаннан кейін пайда болған нәтиже 32–суретте 

кӛрсетілген. Ал енді бірінші әдістің соңғы операцияларын орындауымыз қажет, 

яғни  Сtrl+E және Ctrl+I қос пернелер комбинациясын  басу арқылы сәйкесінше 

қабаттарды жабыстырамыз және бейнені инвертирлейміз. 

Қай әдіс ұнайтынын анықтап, ӛңдеуді аяқтағаннан кейін келесі сатыға кӛшеміз.       

 

 

 

 

 

30-сурет. Caussian Blur (Гаусс әдісі 

бойынша шаю) сүзгісінің диалогтық 

терезесі 

31-сурет. Мысалда қолданылған 

қисық 
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                       32-сурет. Қисықты қолданғаннан кейінгі мәтін 

Image → Rotate Canvas → 90 CW (Бейне → Бұру → Сағат тілінің бағытымен 

90
0
–қа) командасын, сосын Filter → Stylize → Wind (Сүзгі → Стилдеу → Жел) 

командасын таңдаңыз. Wind (Жел) сүзгісінің баптаулары: Method (Әдіс) – Wind 

(Жел), Direction (Бағыты) - From the Right (Оң жақтан) (33-сурет).  

Сүзгіні бір рет қолданған жӛн, бірақ егер сіз мұзды ұзынырақ етіп жасағыңыз 

келсе, онда бұл операцияны Ctrl+F қос пернелер комбинациясын басу арқылы 

бірнеше рет орындай аламыз. Нәтиже 34-суретте кӛрсетілген.  

 

 

                                 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

  Енді, Image → Rotate Canvas → 90 CCW  (Бейне → Бұру → Сағат 

тілінің бағытына қарсы 90
0
–қа) командасын орындау арқылы бастапқы қалпына 

бұрамыз.  

Мұзды бояудың уақыты келді. Біздің мысалымызда кӛгілдір түс таңдалынған. 

Бейнені RGB түстік режиміне ауыстырыңыз: Image → Mode →RGB Color 

(Бейне → Режим → RGB). 

Image → Adjustments → Hue/Saturation (Бейне → Баптаулар → Түс/Қоюлығы) 

командасын таңдаңыз немесе Ctrl+U қос пернелер комбинациясын басыңыз. 

Пайда болған терезедегі  Colorize (Түстендіру) мәніне  белгіше қойыңыз және 

сізді қанағаттандыратын нәтижеге жеткенше түстің (Hue), қоюлығының 

(Saturation) және ашықтылығының (Lightness)  мәндерін ӛзгертіп кӛріңіз (35-

сурет). 

Кедір-бұдырын анық кӛрсету үшін бейненің контрасын ӛзгертуге болады (36-

сурет). 

 

33-сурет. Wind (Жел) сүзгісінің 

диалогтық терезесі 
34-сурет. Wind (Жел) сүзгісін 

қолданғаннан кейінгі мәтін 



27 

 

 

                  

 

 

 

 

 

 

 

 

                                                                                                 

 Мұзды жарқырап тұрғандай етіп кӛрсету үшін, Brush (Қылқалам) құралын 

таңдап, оның Air Brush  Capabilities (Аэрограф мүмкіндіктері) режимін активті 

етіңіз. 

Жұлдызға және қарға ұқсас қосымша қылқаламды пайдалану арқылы күнге 

шағылысып, жарқырап жатқан мұздың әсерін қалыптастырамыз. 

Егер сіз бәрін дұрыс жасасаңыз сіздің бейнеңіз 37-суреттегідей болуы керек. 

 

 

 

 

 

 

 

 

 

 

                                   

                                           37-сурет (нәтиже) 

 

Практикалық тапсырма №4. Қардағы (қар астындағы) әріптер 

 Ӛлшемі 300х300 пиксель болатындай жаңа бейне құрыңыз (Ctrl+N). Қар 

шындыққа сай келуі үшін бейне ӛлшемін осыдан артық бермегеніңіз жӛн. 

Фон ретінде қандай да бір қысқы пейзаж немесе кӛгілдір түсті орнатыңыз. 

 Type (Мәтін, Текст) құралын пайдаланып 38-суретте кӛрсетілген сӛзді 

жазыңыз. Әріптердің түсі маңызды емес, бірақ кӛк түстес болғаны жақсы 

кӛрінеді. Фон түсін кӛгілдір етіп алған жақсы.  

 

 

 

 

 

 

                                                       38-сурет 

35-сурет. Hue/Saturation (Түс/Қоюлығы) 

командасының диалогтық терезесі 
36-сурет. Brightness/Contrast (Ашық- 

тығы/Контраст) диалогтық терезесі 
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 Ал енді қарды салуға кірісейік. Brush (Қылқалам, Кисть) құралын 

таңдаңыз. Осы құралды аэрограф ретінде де пайдалануға болады (ол үшін Brush 

құралының Airbrush Capabilities (Аэрограф мүмкіндіктері) параметрін екпінді 

күйге келтіру керек), яғни бұл жиектерді айқын емес етіп салу мүмкіндігін 

береді. 

Енді жазудың үстіне жиналып қалған қарды кӛрсету үшін 39-суреттегідей етіп 

ақ түске бояңыз. Ӛте кӛп қардың қажеті жоқ. 

 

 

 

 

 

 

 

 

 
                                            

                                                       39-сурет 
 

 Шындыққа ұқсас болу үшін Smudge (Саусақ, Палец) құралын пайдаланып 

қарды шайыңыз. Бұл кенептегі кеппеген бояуды саусақпен шайған сияқты әсер 

қалыптастырады. 

Сонымен, Smudge (Саусақ, Палец) құралын алып қардың шеттерін тегістеңіз. 

Егер сізде дұрыс шықпаса құралдың параметрлерін ӛзгертіп, нақтылай 

айтқанда Pressure (Басу, Нажим) мәнін үлкейтіп кӛріңіз. Нәтижесі 40-суретте 

кӛрсетілген. 

 

 

 

 

 

 

 

 

                                               

                                                    40-сурет 

 

 Сәл еріген қардың әсерін қалыптастыру үшін алдыңғы Smudge (Саусақ, 

Палец) құралын пайдаланыңыз. Тек осы жолы қарды жоғарыдан тӛмен қарай 

тегістеңіз. Қар мүлдем жоғалып кеткен жерлерді қылқалам кӛмегімен қайта 

жӛндеуге болады. 

Қар тегіс нәрсе емес және түйіршіктерден тұратындығын кӛрсету үшін Add 

Noise (Шу қосу, Добавить шум) стандартты сүзгісін пайдаланыңыз: Filter → 

Noise → Add Noise (Сүзгі → Шу → Шу қосу). Сүзгінің баптаулары 41-суретте 

кӛрсетілген.  
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                                                   41-сурет 

 

 Мұндағы Amount (Әсер, Эффект) мәні неғұрлым кӛп болса, түстер 

соғұрлым қарама-қарсы түстерге кӛбірек ауысады. Мысалы, егер сіз RGB 

түстік моделімен жұмыс жасап отырып, Amount мәнін - 20 деп берсеңіз, онда 

жаңа түс ескі түстен қызыл, жасыл және кӛк каналдар бойынша 20 түспен 

ерекшеленеді. Ал егер Amount мәні 255-тен асатын болса, онда бағдарлама 16 

млн. түстердің арасынан кез-келгенін таңдайды. 

 Ең ақырғы қадам – бейнеге су құйғанда суреттің жиектері жайылғандай әсер 

қалыптастырайық. Ол үшін Blur (Шаю, Размытие) сүзгісін 

қанағаттандырарлық нәтижеге жеткенше бірнеше рет пайдаланыңыз: Filter → 

Blur → Blur (Сүзгі → Шаю → Шаю).  

Енді жауып тұрған қарды салайық. Ол үшін Brush (Қылқалам, Кисть) 

құралын алып, қасиеттер терезесі арқылы Assorted қылқалам жиынтығын (Load 

Brushes (Қылқаламдарды жүктеу) командасы арқылы) жүктеңіз. Оның 

құрамына әр түрлі стандартты емес қылқаламдар, сонымен қоса қар ұшқынына 

ұқсас қарша (снежинка) да кіреді. Соны таңдап алып керекті мӛлшерде суретке 

орналастырыңыз. Нәтиже 42-суретте келтірілген. 

 

 

 

 

 

 

 

 

                            

                                       42-сурет (нәтиже)  
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Практикалық тапсырма №5. Хромды әріптер 

  Жаңа канал құрыңыз. Ол үшін Channels (Каналдар) палитрасында 

орналасқан ақ қағаздың суретін шертсеңіз жеткілікті. Нәтижесінде бірден 

екпінді күйде болатын альфа-каналды аласыз. 

Type (Мәтін) құралын алып кез келген сӛз жазыңыз, мысалы, “hrom” (43-сурет). 

Әріптердің түсіне назар аударыңыз – ол ашық-сұр түсті болуы керек (ашықтық 

градациясы (басқыштаушылық) бойынша шамамен 130). 

 

 

 

 

 

 

 

 

                                                 43-сурет 

 Альфа-каналына жазылған кез келген мәтін автоматты түрде ерекшеленеді. 

Бірақ келесі амалдарды орындау үшін бұл ерекшелеуді алып тастау керек. Оны 

Select  Deselect (Ерекшелеу  Ерекшелеуді алып тастау, Выделение  

Отменить выделение) командасы арқылы немесе Ctrl+D пернелер 

комбинациясының кӛмегімен орындай аласыз. 

 Келесі әрекет - әріптерді шаю (размытие). Бұл мақсатта қандай да бір 

шаюшы сүзгіні (размывающий фильтр) қолданған жӛн. Біз, Gaussiаn Blur (Гаусс 

бойынша шаю, Размытие по Гауссу) сүзгісін пайдаланайық: Filter  Blur  

Gaussiаn Blur (Сүзгі  Шаю  Гаусс бойынша шаю, Фильтр  Размытие  

Размытие по Гауссу). Шаю радиусын (Radius) 3 пиксель деп беріңіз (44-сурет). 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                   

                                                  44-сурет 
 

 Сіздің әріптеріңіздің жиектері анық емес болуы мүмкін. Оны 45-суретпен 

салыстырып кӛріңіз, егер сіздің әріптеріңіздің жиектері анығырақ болса, онда 

Ctrl+E пернелерін басу арқылы шаюды қайталаңыз. 
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                                                   45-сурет 
 

 Осымен бір каналдағы бейнені ӛңдеу аяқталды. Енді каналдар 

палитрасындағы сәйкес пиктограмманы шерту арқылы RGB каналына ӛтіңіз. 

Жазудың жоғалып кеткеніне таң қалмаңыз. Әріптер альфа-каналында 

құрылғандықтан бейненің құрамдас бӛлігі болмайды және сол себепті олар 

кӛрінбейді. 

 Lighting Effects (Жарық әсерлері, Эффекты света) сүзгісін орындаңыз: Filter 

 Render  Lighting Effects (Сүзгі  Жарықтандыру  Жарық әсерлері, 

Фильтр  Освещение  Эффекты света). Қажетті баптаулар 46-суретте 

кӛрсетілген. Дегенмен, назар аударатын жайт: ең бастысы, Texture Chanel 

(Текстура каналы) ретінде Alpha 1 каналды, яғни, жазу орналасқан каналды 

орнатыңыз.  

 

 

 

 

 

 

 

 

 

 

 

                                                

                                                 46-сурет 

 

Сонымен, егер сіз барлық параметрлерді дұрыс орнатсаңыз, сіздің 

жұмысыңыздың нәтижесі 47-суреттегідей болуы керек. 

 

 

 

 

 

 

 

                                                  47-сурет 
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Кӛлем байқалып тұр. Бірақ, жай ғана кӛлемін кӛрсетіп қоймай, беткі жағын 

күрделі сатылы етіп кӛрсетуіміз керек. Ол үшін түстік қисықтарды (тоновые 

кривые): Image  Adjustments  Curves (Бейне  Баптаулар  Қисықтар, 

Изображение  Настройки  Кривые) пайдаланайық (48-сурет). 

 

 

 

 

 

 

 

 

 

 

 

                                                  48-сурет 

 

 Осы құралдың кӛмегімен әріптердің кез келген дерлік симметриялы 

формасын алуға болады. Егер Curves (Қисықтар, Кривые) диалогтық 

терезесінде барлығы дұрыс орындалса, онда сіздің бейнеңіз 49-суретке ұқсас 

болуы керек. 

 

 

 

 

 

 

                                           

49-сурет 

 

 Келесі қадамды ең маңызды деп атасақ та болады, себебі нәтиженің сыртқы 

түрі осыған байланысты болады. Қазір біз әріптерге түс береміз. Ол үшін Image 

 Adjustments  Hue/Saturation (Бейне  Баптаулар  Түс/Қанықтылық, 

Изображение  Настройки  Тон/Насыщенность) командасын пайдаланған 

жӛн. 50-суретте кӛрсетілген баптауларды орнатыңыз және Colorize (Түстендіру, 

Тонирование)-ке белгіше қойыңыз. Қою сары түсті пайдалану қажет.  
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50-сурет 

 

51-суреттегідей нәтиже алуға тырысыңыз. 

 

 

 

 

 

 

 

                                                    

51-сурет 

 

 Енді беткі бӛлікті металды түрге келтіру керек. Ол үшін бізге қайтадан түстік 

қисықтар (тоновые кривые) құралы қажет болады. Ctrl+M пернелерін басып 52-

суретте кӛрсетілген қисықты салыңыз.  

 

 

 

 

 

 

 

 

 

 

 

                                                 52-сурет 
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Нәтиже 53-суретте кӛрсетілген. 

 

 

 

 

 

 

 

                                         53-сурет (нәтиже) 

 

Практикалық тапсырма №6. Алтын әріптер 

RGB түстік режимінде жаңа бейне құрыңыз (Ctrl+N). Кез келген сурет салу 

немесе ерекшелеу құралын пайдаланып алтын кесегінің дайындамасын 

салыңыз (54-сурет).  

 

 

 

 

 

 

 

 

                                               54-сурет 

 

  Содан кейін Gradient (Градиент) құралын алып, Gradient Editor 

(Градиенттер редакторын) ашыңыз да, 55-суреттегіге сәйкес үлгі құрыңыз. 

Осының кӛмегімен біз кесекке алтынға ұқсас түс береміз. 

 

 

 

 

 

 

 

 

 

 

                                              55-сурет 
 

  Құрылған градиентті пайдаланып кесекті бояңыз (56-сурет). Алтын 

кесегінің ортаңғы бӛлігіне градиенттің радиалды типін пайдаланған жӛн. 

Алтын кесегі дайын болғаннан кейін Type (Мәтін) құралының кӛмегімен сӛзді 

(57-сурет) сұр түспен жазыңыз. Массивті қаріпті (жартылай қарайтылған) 

таңдаған жӛн, алайда қаріп ӛлшемін ӛте үлкен етіп алмаңыз.  
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                    56-сурет                                              57-сурет 
 
 

  Мәтінді ӛңдеуді ары қарай жалғастыру үшін оны растрға ауыстыру керек. 

Мәтін орналасқан қабатта тышқанның оң жақ батырмасын шертіп, ашылған 

мәзірден Rasterise Layer (Қабатты растрлеу, Растрировать слой) командасын 

таңдаңыз. 

  Енді мәтінді ерекшелеңіз. Ең жеңіл әдіс - Layers (Қабаттар) 

палитрасындағы осы қабатта тышқанның сол жақ батырмасын екі рет шерту. 

Ерекшеленгенді маска ретінде жеке каналға сақтаңыз. Ол үшін Channels 

(Каналдар) палитрасының тӛменгі жағында орналасқан, штрихталған 

сызықтармен шектелген, ақ дӛңгелекке шертсе немесе Select  Save Selection 

(Ерекшелеу  Ерекшеленгенді сақтау, Выделение  Сохранить выделение) 

командасын орындау жеткілікті. 

  Жаңа ғана құрылған каналды екпінді күйге келтіріңіз (каналдар 

палитрасында оған шерту арқылы) және оны Blur (Шаю, Размытие) бӛліміндегі 

радиусы 2-3 пиксель болатын Gaussian Blur (Гаусс бойынша шаю, Размытие по 

Гауссу) сүзгісінің кӛмегімен шайыңыз (58-сурет). 

RGB каналына қайтып келіп, Layers (Қабаттар) палитрасын ашыңыз. Мәтін 

орналасқан қабат екпінді екеніне  кӛз жеткізгеннен кейін, Filter  Render  

Lighting Effects (Сүзгі  Жарықтандыру  Жарық әсерлері, Фильтр  

Освещение  Эффекты света) командасын орындаңыз. Texture Channel 

(Каналдың текстурасы, Текстура канала) бӛлімінде шайылған мәтін орналасқан 

каналды таңдаңыз. Қалған баптаулар мынадай (111-сурет): Light type (Қайнар 

кӛзі, Источник) - Spotlight (Прожектор), Intensity (Ашықтығы, Яркость) – 35, 

Focus (Фокус) – 69, Gloss (Фактура) – 0, Material (Материал) – 69, Exposure 

(Ұстап тұру, Выдержка) – 0, Ambience (Орта, Среда) – 8, баптаулардағы екі түс 

те – ақ. 

 

 

 

 

 

 

 

 

 

 

 

               58-сурет                                                     59-сурет 
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Нәтижесі 60-суретте кӛрсетілген. 

 

 

 

 

 

 

 
 

                                                  60-сурет 
 

Әріптерге металды түр беру үшін түстік қисықтарды пайдалану керек: Image  

Adjustments  Curves (Бейне  Баптаулар  Қисықтар, Изображение  

Настройки  Кривые). 61-суреттегідей қисықты салыңыз. 

Осы қисықты пайдаланғаннан кейінгі нәтиже 62-суретте кӛрсетілген. 

 

 

 

 

 

 

 

 

                                                                             62-сурет 

               61-сурет                   

                                                                                

  Енді жазуды жарқыраған алтынға ұқсатып бояймыз. Ол үшін Image  

Adjustments  Hue/Saturation (Бейне  Баптаулар  Түс/Қанықтылық, 

Изображение  Настройки  Тон/Насыщенность) командасын немесе Ctrl+U 

пернелерін пайдалану керек. Colorize (Түстендіру, Тонирование)-ке белгіше 

қойыңыз да, сырғымаларды жылжыту арқылы қажетті мәндерді беріңіз. Ал 

біздің жағдайда 63-суретте кӛрсетілген мәндер қолданылған. 

  Жазуға аз ғана кӛлеңке қосу арқылы нәтижені жақсартуға болады. Ол 

үшін қабаттың Drop Shadow (Сыртқы кӛлеңке, Внешняя тень) стилін 

қолданыңыз: Layer  Layer Style  Drop Shadow (Қабат  Қабат стилі  

Сыртқы кӛлеңке, Слой  Стиль слоя  Внешняя тень). Оның баптаулары 64-

суретте кӛрсетілген. 
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                63-сурет                                                         64-сурет 

 

 Егер сіздің бейнеңіз жеткілікті мӛлшерде ашық болмаса, онда оны алдыңғы 

мәзірдегі Brightness/Contrast (Ашықтық/Контраст) командасы-ның кӛмегімен 

жӛндеуге болады.  

Соңғы нәтиже 65-суретте кӛрсетілген. 

 

 

 

 

 

 

 

 

                                         65-сурет (нәтиже) 

 

Практикалық тапсырма №7. Компакт-диск жасауды үйрену 

  

 Бұл жұмыста сізге бірнеше қабаттармен орындалатын ӛте кӛп әрекеттер 

жасауыңызға тура келеді.  

 RGB форматында ӛлшемі 400х400 пиксель болатын жаңа бейне құрыңыз 

(Ctrl+N). Фондық түс ретінде ақ түсті таңдаңыз. 

Компакт дискіні салу фигураларды бейненің центріне қатысты туралауды талап 

ететіндіктен, бейнеңізге сызғыштар қосыңыз, яғни  View → Rulers (Түр → 

Сызғыштар). Егер сызғыш ӛлшемі пиксельмен емес сантиметрмен берілсе, онда 

бағдарламаның баптауларын ӛзгертіңіз: Edit → Preferences → Units & Rulers 

(Түзету → Баптаулар → Бірліктер және сызғыштар).  

Сізге сызғыштардан басқа тағы бір кӛмекші құрал – бағыттаушылар қажет. 

Меңзерді (курсорды) жоғарыдағы  кӛлденең орналасқан  сызғышқа апарып, 

тышқанның сол жақ тетігін басып тұрып бағыттаушыны 200 пиксельге дейін 

созыңыз. Сол сияқты тік бағыттаушыны да созыңыз. Олардың қиылысу нүктесі 

- бейненің дәл центрі болады. 
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  Дискіні салуға кӛшейік. Elliptical Marquee (Элипстік ерекшелеу) құралын 

таңдап, оның параметрлер тақтасынан  Fixed Size (Бекітілген ӛлшем) режимін 

қосыңыз және ӛлшемін 340х340  пиксель деп беріңіз. Бұл салынатын дискінің 

негізгі диаметрі. 

Бейненің  дәл ортасына жоғарыдағы баптаулармен берілген эллипстік 

ерекшелеуді орнатыңыз. Ол үшін тышқанның  сол жақ тетігін басып тұрып, 

меңзерді бейне центріне алып келіңіз де Alt пернесін басыңыз. Ерекшеленген 

аймақ бағыттаушыларға, яғни центрге қатысты тураланады. 

  Одан кейін Elliptical Marquee (Эллипстік ерекшелеу) құралын  Subtract 

From Selection (Ерекшелеуден шығару) режиміне ауыстырыңыз. Fixed Size 

(Бекітілген ӛлшем)  баптауын екпінді етіп қалдырыңыз, бірақ ӛлшемді 42х42 

пиксельге ӛзгертіңіз. Сосын жоғарыда кӛрсетілген әдісті пайдаланып бұл 

ерекшелеуді бейненің центріне орналастырыңыз. Нәтижесінде дискіге ұқсас 

ерекшеленген форма пайда болады. Paint Bucket (Құю) құралын пайдаланып, 

оны ашық сұр түске бояңыз. (66-сурет). Жаңа қабат құрыңыз да атын «кӛлеңке» 

деп беріңіз. Сол қабатқа ӛтіңіз. Бізге құрылған ерекшелеу қайтадан қажет 

болады, бірақ оның ішкі радиусын ӛңдеуге тура келеді. Elliptical Marquee 

(Эллипстік ерекшелеу) құралының ӛлшемін 102х102 пиксельге ӛзгертіңіз және 

Subtract From Selection (Ерекшелеуден шығару) режиміндегі жаңа ерекшелеуді 

бейне центріне орналастырыңыз. Ерекшеленген бӛлікті ақ түске бояңыз.  

Енді бізге бірінші рет қабат әсерлері, дәлірек айтқанда Gradient Overlay 

(Градиенттік бояу) қажет болады. Оны Layers (Қабаттар) палитрасында 

орналасқан Add Layers Style (Қабаттық әсер қосу) тетігінің кӛмегімен жіберген 

ыңғайлы. 

  Бізге қарадан аққа ӛтетін қарапайым градиент керек болады. Бірақ оны 

кішкене ӛңдеуіміз керек. Gradient (Градиент) құралының үстінен тышқанның 

сол жақ тетігін шертеміз де қара түсті – қара-сұр  түске, ал ақ түсті – ақ–сұр 

түске ауыстырыңыз. Gradient Overlay (Градиенттік бояу)-дың қалған 

баптаулары  67–суретте кӛрсетілген. 

  Егер барлығы дұрыс орындалса, 68-суреттегідей бейне алынады. Егер де 

сіздің бейнеңізде ӛзгешелік кӛп болса, барлығын Layers (Қабаттар) 

палитрасынан–ақ жӛндеуге болады. Қабаттық әсердің жақсы қасиеті де осы, 

яғни оның баптауларын кез келген уақытта ӛзгертуге болады. Ол үшін әсер 

белгісіне шертсеңіз, оны ӛңдеу терезесі бірден ашылады. 

Ctrl+D қос пернелері арқылы ерекшелеуді алып тастаңыз. 
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 Жаңа қабат құрып, оған «кемпірқосақ» деген ат беріңіз. Gradient (Градиент) 

құралын алып, оның параметрлер тақтасында орналасқан, кемпірқосақтың 

барлық түстері бар, Spectrum деген дайын нұсқаны таңдаңыз. Оны бейнеге 

жоғарыдан тӛменге қарай орнатыңыз (69-сурет). 

 

 

 

                                   

 

             

 

 

 

 

 

 
 

 Сосын «кемпірқосақ» қабатына  Distort (Қисайту) режиміндегі  Free 

Transform (Еркін тасымалдау) (Ctrl+T) құралын қолданыңыз. Сектор пайда 

болатындай етіп, сол жақтағы тірек нүктелерін бейне центріне қарай тартыңыз. 

«Кемпірқосақ» қабатын дубльдеңіз, ол үшін Layers (Қабаттар) палитрасында 

оны ақ қағаздың суреті бар (Create New Layer) белгіше үстіне тартып апарыңыз. 

Сосын Edit →  Transform → Rotate 180 (Түзету → Тасымалдау → 180
0
-қа бұру) 

командасын орындап, «Кемпірқосақ» қабатын кӛшірмемен біріктіріңіз (Ctrl+E) 

(70-сурет). 

«Кемпірқосақ» қабатын тағы бір рет дубльдеңіз де, енді оны 90
0
-қа бұрыңыз,  

 

 

 

 

 

 

66-сурет. Сұр түске боялған 

диск дайындамасы 

67-сурет. Gradient Overlay  

(Градиенттік бояу) баптаулары. 

68-сурет. Градиентпен боялған диск 69-сурет. Құрылған градиент 
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Нәтижесі 71–суретте кӛрсетілген. 

 

                    

 

 

 

 

 

 

 

 

 

 

 

 

 

 Бізге дискінің негізгі бӛлігін кӛрсететіндей ерекшеленген аймақ керек. Ол 

үшін «кӛлеңке» қабатын құрғанда қолданған операцияларды қайталауымызға 

болады, бірақ одан да жеңілірек әдіс бар. Ctrl пернесін басып тұрып «кӛлеңке» 

қабатының үстіне апарып тышқанның сол жақ тетігін басыңыз. Осы қабаттағы 

мӛлдір еместің барлығы ерекшеленіп қалады. «Кемпірқосақ» қабатына 

ауысыңыз. Ерекшеленгенді  инвертирлеңіз (Ctrl+Shift+I). Del-пернесін басыңыз. 

Ерекшелеуді алып тастаңыз (Ctrl+D). 

Компакт дискінің дайындамасы дайын (72-сурет), ары қарай оны шындыққа сай 

келетіндей етіп жасаймыз. 

Blending Mode режимін Overlay режиміне ауыстырыңыз, ал тұнықтықты 65%-ға 

дейін азайтыңыз. 

 Диск ӛте ашық түсті болып қалды. Оны түзету үшін екі әрекет жасау керек. 

Біріншісін қазір, ал екіншісін сәл кейінірек жасаймыз. Hue/Saturation 

(Түс/Қоюлығы) режимінде жаңа қабат құрыңыз: Layer → New Adjustment Layer 

→ Hue/Saturation (Қабат → Жаңа корректіленетін қабат → Түс/Қоюлығы). 

Қолданылған баптаулар 73-суретте кӛрсетілген. 

Layers (Қабаттар) палитрасында корректіленетін қабат үшін тұнықтылықты 

(Opacity) 25-40% аралығында орнатыңыз.  

Енді диск ортасында орналасатын «жазылмайтын» аймақты салуға тырысайық. 

Ол үшін «Кемпірқосақ» қабатына қайтып келіп, Elliptical Marquee (Эллипстік 

ерекшелеу) құралының кӛмегімен радиусы 130 пиксель болатын дӛңгелек 

ерекшелеу құрыңыз. Одан кейін келесі операцияларды: кӛшірмесін алу (Ctrl+C) 

және қою (Ctrl+V) орындаймыз. 

 

 

 

 

 

 

70-сурет. «Кемпірқосақ» қабатын 

дубльдегеннен және кӛшірмесін 

орналастырғаннан кейінгі нәтиже 

71-сурет. Дайын Кемпірқосақ» 

қабаты 
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 Алынған жаңа қабат үшін Layers (Қабаттар) палитрасындағы Blending Mode 

режимінің мәнін Screen (Экран) деп беріңіз. Тұнықтылықты (Opacity) 60–70%-

ға дейін азайтуға да болады Осы қабатты  «Кемпірқосақ» қабатымен біріктіріңіз 

(Ctrl+E). 

 Енді компакт дискіге жазу қосайық. Ол үшін Photoshop CS-тың жаңа 

құралын, дәлірек айтқанда контур бойынша мәтінді теріп жазу құралын 

пайдаланамыз. Paths (Контурлар) режиміндегі  Ellipse (Эллипс) құралын 

пайдаланып «жазылмайтын» аймақтың ішкі жағына қарай домалақ контур 

сызыңыз. 

 Horizontal Type (Кӛлденең орналасқан мәтін) құралын таңдап, контурдың 

бойына меңзерді апарып шертеміз де кез келген мәтін тереміз. Мәтін ӛлшемін 

және басқа да параметрлерін қалауыңызша ӛзгертуіңізге болады. 

 Paths (Контурлар) палитрасын ашып, Work Path контурын жоямыз. Осы кезде 

домалақ контур экран бетінен жоғалып, тек мәтін ғана қалады.  

Енді, бірінші қабатты екпінді күйге келтіріңіз. Дискінің сұр бӛлігінің 

жартысындай домалақ аймақты ерекшелеңіз. Select → Modify → Border 

(Ерекшелеу → Ӛзгерту → Шекара) командаларын орындаңыз. Ашылған 

терезеде шекара мәнін 2 пиксель деп беріңіз. Нәтижесінде біз жіңішке сақина 

формасындай ерекшеленген аймақ аламыз. 

Кӛшірмесін алу (Ctrl+C) және қою (Ctrl+V) операцияларын орындаңыз. Жаңа 

құрылған қабатқа  74-суретте кӛрсетілген баптауларды  орнатып, Bevel and 

Emboss (Фаска және рельеф) қабаттық әсерді қолданыңыз. Сосын осы қабатты 

фонмен біріктіріңіз (Ctrl+E). 

 Суретіміз әлі толығымен дискіге ұқсамайды. Әсіресе, «Кемпірқосақ» 

қабатындағы  түстердің бір-біріне тез ӛтуі. Оны жӛндеуіміз керек. 

Ол ӛте оңай.  Radial Blur сүзгісін:  Filter → Blur → Radial Blur (Сүзгі → Шаю → 

Радиалды шаю) пайдаланып, 75-суретте кӛрсетілген баптауларды орнатыңыз. 

Осыдан кейін бейненің тӛменгі жағында  түрлі түсті пиксельдер пайда болады. 

Ол қолданылған сүзгінің әсері болып табылады. Оны Eraser (Ӛшіргіш) 

құралының кӛмегімен алып тастаймыз. Нәтижесі 76-суретте кӛрсетілген. Егер 

сіздің дискіңіз оған ұқсамаса, онда Radial Blur (Радиалды шаю) сүзгісін тағы бір 

рет қолданып кӛріңіз. 

72-сурет. «Кемпірқосақ» қабатын 

ӛңдегеннен кейінгі компакт диск 

73-сурет. Hue/Saturation (Түс/Қоюлығы) 

режиміндегі қабаттың баптаулары 
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 Корректіленетін қабаттан тӛмен, ал басқаларынан жоғары орналасатындай 

етіп жаңа қабат құрыңыз. Жұмыстың ең басында жасаған амалдарды 

қайталаңыз - ӛлшемі 340х340 пиксель болатын дӛңгелек ауданды ерекшелеп 

оны бейне центріне  орналастырыңыз. Select → Modify → Border (Ерекшелеу → 

Ӛзгерту → Шекара)  командасын орындаңыз. Шекара ӛлшемін 3 пиксель деп 

беріңіз. Алынған ерекшеленген аймақты диск  центрі боялған түспен бояңыз. 

Сосын Drop Shadow (Сыртқы кӛлеңке) қабаттық әсерін қолданыңыз. Оның 

баптаулары 77-суретте кӛрсетілген.  

 

                    

 

 

 

 

 

 

 

 

 

 

 

 

 

Онымен қоса алдыңғы баптауларды пайдаланып Inner Shadow (Ішкі кӛлеңке) 

әсерін де қолдануға болады. Барлық қабаттарды біріктіріңіз (Shift+Ctrl+E). Ең 

соңғы нәтиже 78-суретте кӛрсетілген.    

 

 

 

 

74-сурет. Bevel and Emboss (Фаска 

және рельеф) әсерінің параметрлері 

75-сурет. Radial Blur (Радиалды 

шаю) сүзгісінің баптаулары. 

76-сурет. Radial Blur (Радиалды шаю) 

сүзгісін қолданғаннан кейінгі диск 
77-сурет. Drop Shadow (Сыртқы 

кӛлеңке) әсерінің баптаулары 
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Практикалық тапсырма №8. Кристалл жасауды үйрену 

 RGB түстік режимде ӛлшемі 400х400 пиксель болатын жаңа бейне құрайық. 

Бірден Paint Bucket (Құю) құралын пайдаланып, оны қара түске бояңыз. 

Содан кейін 79-суретте кӛрсетілген баптауларды орнатып, Filter→ Render → 

Lens Flare (Сүзгі → Жарық түсіру → Дақ) қолданыңыз. Ескере кететін жағдай, 

түсірілген дақ  бейненің дәл ортасында орналасуы керек. 

Енді бейне  ӛлшемдерін екі есе арттырамыз: Image → Canvas Size (Бейне → 

Кенеп ӛлшемі). Бұл операцияның баптаулары 80-суретте кӛрсетілген. 

 

 

  

 

 

 

 

 

 

 

 

                         

                                                                                                                                                             

 

 

Егер барлығы дұрыс орындалса, сіздің жұмысыңыздың нәтижесі 81-

суреттегідей болады.  

Ал енді бейнеге түсірілген дақты түрлі-түсті теңбілге айналдыруымыз керек. 

Ол үшін Filter → Artistic → Fresco (Сүзгі → Кӛркемдік → Фреска) 

командаларын пайдаланған тиімді. (82-сурет).  

 

 

 

 

 

79-сурет. Lens Flare (Дақ) 

сүзгісінің диалогтық терезесі 
 

80-сурет. Canvas Size (Кенеп ӛлшемі) 

баптаулары 
 

78-сурет. Дайын компакт дискі 
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 Осыдан дақты не үшін бейненің дәл ортасына  орналастырғанымызды 

түсінуге болады. Ӛйткені дақ кӛп ӛлшемге ұлғайып кетті, яғни, егер ол шетке 

қарай орналасқан болса, ол бейнеге сыймас еді. 

 Біз жұмыстың ең басты қадамына келдік, яғни кристалдарды пішінге 

келтіреміз. Ол үшін Extrude сүзгісін қолданайық: Filter → Stylize → Extrude 

(Сүзгі → Стильдеу → Сығу).  

Қажетті баптауларды 83-суреттен кӛре аламыз. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Кристалдар дайын, бірақ олар түрлі-түсті болғандықтан кӛз тартарлық емес. 

Сондықтан оларды бір түске бояуымыз керек. 

Кристалдарды кӛгілдір түске бояған жӛн, себебі кӛркем фильмдерде барлық 

кристалдар осы түспен кӛрсетіліп, адамдардың кӛбі соған үйреніп қалған. 

Кристалды бояу үшін Colorize (Сырлау) режиміндегі Hue/Saturation 

(Рең/Қанықтылық) құралын қолданыңыз. Қолданылатын баптаулар 85-суретте, 

дайын бейне 86-суретте кӛрсетілген. 

 

 

81-сурет. Үлкейтілген 

бейнедегі дақ 

82-сурет. Fresco (Фреска)  

сүзгісінің параметрлері 

83-сурет. Fresco (Фреска) 

сүзгісін пайдаланғандағы 

нәтиже 

84-сурет. Extrude (Сығу) 

сүзгісінің баптаулары 
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86-сурет. Кристалдың бейнеленуі (нәтиже) 

 

Практикалық тапсырма №9. Ғарышты салайық 

 Бұл мысалда бірден үш табиғат құбылыстарын салу әдістері қарастырылады.  

Жаңа бейне құрыңыз. Бұл мысалдың басқа мысалдардан тағы бір 

айырмашылығы мұнда жұмысты «таза беттен» бастаймыз. 

 Ең бірінші жер шарын салудан бастайық. Elliptical Marqule (Эллипстік 

ерекшелеу, Эллиптическое выделение) құралын пайдаланып дӛңгелек ауданды 

ерекшелеп алыңыз. Оны бейнеде тӛрттен бір бӛлігі ғана қалатындай етіп 

орналастырыңыз. 

 D пернесін басу арқылы негізгі түстерді орнатыңыз (алдыңғы – қара; фонның 

түсі - ақ). Ерекшеленген аймаққа  Render (Жарық түсіру, Освещение) 

бӛліміндегі Clouds (Бұлттар, Облака) сүзгісін қолданыңыз. Содан кейін сол 

бӛлімдегі  Difference Clouds (Бұлттар қондыру, Облака с наложением) сүзгісін, 

ақ және қара түстердің бір–біріне ӛту мӛлшері сізді қанағаттандырғанша, 

пайдаланыңыз (87-сурет). 

 Жер шарының қыртысы тегіс емес екендігін кӛрсетуіміз керек. Ол үшін 

келесі әдісті ұсынамыз: Filter → Texture → Craquelure (Сүзгі (Фильтр) → 

Текстура → Кракелюралар). Осы сүзгінің диалогтық терезесіндегі 

баптауларының мәнін ӛзгерте отырып, эксперимент жүргізіп кӛріңіз. Ал біздің 

мысалда қолданылған параметрлер мәндері 88-суретте кӛрсетілген. 

 

 

 

85-сурет. Hue/Saturation (Рең/ Қанықтылық) баптаулары 
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 Егер қаласаңыз осы сүзгіні, параметрлер мәнін азайтып беріп, тағы бір рет 

қолдануыңызға болады. 

Жерді шар тәріздес етіп қалай кӛрсетеміз? Ол үшін:  Spherize (Сфералау, 

Сферизация) сүзгісін пайдаланамыз: Filter → Distort → Spherize  (Сүзгі → 

Деформациялау → Сфералау, Фильтр → Деформация → Сферизация) (89-

сурет). Amount (Әсер, Эффект) параметрі  ең жоғарғы мән қабылдау керек, ал 

Mode (Қондыру режимі, Режим наложения) параметрінің мәні сіздің 

қалауыңызша таңдалады. Осы операцияны бірнеше рет орындауыңызға да 

болады. 

 Жерді бояуды әр түрлі тәсілмен орындауға болады, бірақ келесі команданы 

пайдаланған тиімдірек: Image → Adjustments → Color Balance (Бейне → 

Баптаулар → Түстік баланс, Изображение → Настройки → Цветавой баланс). 

Жерді қандай түске боясаңыз да қазір оның маңызы жоқ, себебі жұмыс соңында 

ол ӛзгеріп кетеді. Бірақ ыңғайлы болу үшін оны негізгі түске бояйық, яғни 

қоңыр немесе жасыл түске. Қолданылған баптаулары бар диалогтық терезе 90-

суретте кӛрсетілген. 

 Түстік қисықтардың терезесін ашыңыз: Image → Adjustments → Curves 

(Бейне → Баптаулар → Қисықтар, Изображение → Настройки → Кривые). 

Түрлі түсті бейнелермен жұмыс істегенде қисықтардың кӛмегімен оның тек 

жарықтығын ғана емес, түсін де ӛзгерте аламыз. Жер шары бір түсті болмас 

үшін каналдардың әрқайсысын (түстік құраушыларды) жеке–жеке ӛңдеуіміз 

керек. Келтірілген мысалда 91-суретте кӛрсетілген қисықтар қолданылған. 

 

 

 

 

 

 

 

 

 

87-сурет. Жердің 

алғашқы кӛрінісі 

88-сурет. Craquelure сүзгісінің 

диалогтық терезесі 
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91-сурет. Қолданылатын қисықтар 

 

 Ӛзіңіздің суретіңізге байланысты, кӛлдер, таулар мен ормандар пайда 

болатындай етіп, түстерді ӛзгертіңіз. Керек болған жағдайда ортақ қисықты да 

ӛңдеуге болады. 

Әсер ету радиусын үлкен емес етіп алып, Gaussion Blur (Гаусс бойынша шаю, 

Размытие по Гауссу) сүзгісін пайдаланыңыз. Бұл тек салынған сурет қиып 

алынған суретке ұқсамас үшін оның шеткі жақтарын жұмсартады.  

 Ғарыштан түсірілген жер шарының суретінен планетаның айналасы 

атмосфераның кӛгілдір жиегімен қоршалып тұратындығы бізге мәлім. Олай 

болса, оны кӛрсету үшін Gradient (Градиент) құралын пайдаланайық. 

Layers (Қабаттар, Слои) палитрасын ашып жаңа қабат құрыңыз. Ол үшін 

палитраның тӛменгі жағында орналасқан ақ қағаздың суреті бар батырманы 

шертіңіз немесе келесі команданы таңдаңыз: Layer → New → Layer (Қабат) → 

Құру → Қабат, Слой → Создать → Слой). 

89-сурет. Spherize (Сфералау) 

диалогтық терезесі. 

90-сурет. Color Balance (Түстік баланс) 

сүзгісінің диалогтық терезесі 
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 Градиент параметрі орналасқан палитраға ауысыңыз. Қара және кӛк 

түстерден тұратын градиент құрыңыз немесе таңдаңыз. Қара түстің бір бӛлігі 

мӛлдір болатындай етіп тұнықтығын ӛзгертіңіз.  

Құралдың баптауларында Radial (Радиалды, Радиальный) типін орнатып, кӛк 

түстің орналасу радиусы планета радиусынан үлкенірек болатындай етіп 

градиентті суретке орналастырыңыз. Градиенттің орналасуындағы 

кемшіліктерді түзету үшін еркін тасымалдау (CTRL+T) пайдалануға болады. 

Осы амалдың нәтижесі  92-суретте кӛрсетілген. 

 Егер градиент ӛте ашық түсті болып қалса, онда ол орналасқан қабаттың 

тұнықтылығын азайтамыз. 

Енді ғарыштық кеңістікті құруымыз керек. Ол ӛте қараңғы екені бәрімізге 

белгілі, бірақ біркелкі қара түспен боясақ ол шындыққа жанаспайды және әдемі 

болмайды. Бұл жағдайда осындай түрлі табиғат құбылыстарын беруге арналған 

ең жақсы құрал – Clouds (Бұлттар, Облака) сүзгісі пайдаланылады. 

Алдыңғы екі қабаттың ортасына тағы бір қабат қосыңыз. Атмосферасы бар 

қабатқа қайтып келіп, Magic Wand (Сиқырлы таяқша, Волшебная палочка) 

құралының кӛмегімен планета мен кӛгілдір жиектің сыртында орналасқан 

аймақтың барлығын ерекшелеңіз. Соңында құрылатын фонға ӛту процесі баяу 

жүру үшін шегін мүмкіндігінше үлкен етіп алыңыз. 

 Жаңа құрылған қабатқа қайтып келіп Clouds (Бұлттар, Облака) сүзгісін 

қолданыңыз: Filter → Render → Clouds (Сүзгі → Жарық түсіру → Бұлттар, 

Фильтр → Освещение → Облака). Мұндағы негізгі түстер қара және қою кӛк 

болуы керек. Қажет болған жағдайда, Image → Adjustments (Бейне → 

Баптаулар, Изображение → Настройки) мәзіріндегі Brightness/Contrast 

(Ашықтығы/Контраст, Яркость/Контраст) командасы-ның кӛмегімен түстердің 

ашықтығын баптауға және қабаттың тұнықтылығын  ӛзгертуге болады. 

Енді суретімізге жұлдыздар қосайық. Ол үшін Brush (Қалам, Кисть) құралын 

немесе Airbrush Capabilities (Аэрограф мүмкіндіктері, Возможности аэрографа) 

параметрін орнатып, оны аэрограф ретінде пайдалануға болады. Керекті 

қылқаламдар жүйесін орнатып, оның ішінен жұлдызға ұқсасын таңдап алып, 

оны бейненің бірнеше жеріне  орналастырыңыз. Осыдан кейін суретіңіз 93-

суреттегідей  болу керек. 

 Ең соңғы қадам - кометаны салу. Оны жаңа бейнеге салған жӛн. Кез келген 

ӛлшемдегі жаңа файл құрыңыз, бірақ ондағы сурет кейін ғарыш суреті бар 

бейнеге кӛшірілетінін ескеріп, оның ӛлшемін кішірек етіп алғаныңыз жӛн. 

Бейне фоны қара болсын, ал алдыңғы жоспар ретінде ақ түсті таңдаңыз. Негізгі 

түске боялған дӛңгелек құрыңыз. Ол үшін сіз фигураларды пайдалана аласыз. 

Кометаға бұрыс пішін беру үшін  Class (Шыны, Стекло) сүзгісін пайдаланыңыз: 

Filter → Distort → Class (Сүзгі → Деформациялау → Шыны, Фильтр → 

Деформация → Стекло). Баптауларға кез келген мән беруге болады, ең бастысы 

сурет біраз бұрмалануы керек. Сүзгінің диалогтық терезесі мен қолданылған 

баптаулар 94-суретте кӛрсетілген. 
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94-сурет. Class (Шыны) сүзгісінің диалогтық терезесі 

 

 Комета құйрығын салу үшін  Stylize (Стильдеу, Стилизация) бӛліміндегі 

Wind (Жел, Ветер) сүзгісін пайдаланыңыз. Желдің қай бағытта болатыны 

маңызды емес, себебі керек болса бұл кометаны тӛңкеріп қоюға да болады.  Бұл 

сүзгіні комета құйрығы жеткілікті мӛлшерге ұзарғанша пайдаланыңыз (Бұл 

амалды қайталау үшін CTRL+F пернелер комбинациясын басуға болады). 

Комета  құйрығын да бұрыс пішінге келтіру үшін Class (Шыны, Стекло) 

сүзгісін пайдаланып, комета формасын тағы да бұрмалаңыз. 

Түс беру үшін түстік кестені пайдаланған тиімдірек, бірақ та бұдан бұрын 

келесі командалар тізбегін орындауыңыз керек: Image → Mode → Grayscale 

(Бейне → Режим → Сұр түс, Изображение → Режим → Оттенки серого),  Image 

→ Mode → Index Color  (Бейне → Режим → Индекстелген түстер, Изображение 

→ Режим → Индексированные цвета) және Image → Mode → Color Table  

(Бейне → Режим → Түстік кестелер, Изображение → Режим → Цветовая 

таблица).  

92-сурет. Атмосферасы бар 

планета 

93-сурет. Дайын аспан, Жер, 

жұлдыздар 
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Ашылған кестелер тізімінен Black Body деп аталатын кестені таңдап алыңыз. 

Осының арқасында бейне түгелімен қара–қызыл–сары түске боялып, нәтижесі 

95-суреттегідей болады. 

 

 

 

 

 

 

          95-сурет. Түстік кестені пайдаланғаннан кейінгі нәтиже 

 

 Magic Wand (Сиқырлы таяқша, Волшебная палочка) құралының кӛмегімен 

кометаны ерекшелеп алыңыз. Жұмысты жеңілдету үшін фонды ерекшелеп, 

сосын ерекшеленгенді жасырып қоюға  да болады  (Shift+CTRL+I немесе Select 

→ Inverse (Ерекшелеу → Инвертирлеу, Выделение → Инвертировать) . 

Алмастыру буферіне ерекшеленген аймақтың кӛшірмесін алып (CTRL+C), 

ғарыштың суреті бар бейнеге ӛтіңіз де кометаны сонда орналастырыңыз 

(CTRL+V). Кометаны қоюға ыңғайлы жерді белгілеу үшін және оның қисаюын   

беру үшін және де қажет болған жағдайда оны тӛңкеру үшін (оның 

құйрығының ұшы жерден бағытталуы керек) еркін тасымалдауды (CTRL+ T) 

қолданыңыз. Барлығын орындап болғаннан кейін бейне 96-суретке ұқсас болуы 

керек. 

 

 

 

 

 

 

 

 

 

 

                                   

                                   96-сурет. (соңғы нәтиже) 

 

Практикалық тапсырма №10. Фотомонтаж жасау 

        Кез келген ӛлшемдегі жаңа бейне құрыңыз. Белгілі бумадан, алдын-ала 

сақталған, ӛзіңізге ұнайтын портретті ашыңыз. Біздің жұмыста 97-суретте 

кӛрсетілген портрет таңдалынып алынды. 
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97-сурет. Ашылған портрет 

 

 Осы портретті бейнеге орналастырыңыз. Ол үшін суреттің үстіне апарып 

тышқанның сол жақ тетігін басып тұрып бейне үстіне  апарыңыз.  

Ӛз фотосуретіңізді сканерден ӛткізіп, оны файлда сақтаңыз. Осы фотосуретті 

Photoshop-та ашыңыз (98-сурет).  

 Layers (Қабаттар, Слои) палитрасын ашып жаңа қабат құрыңыз. Ол үшін 

палитраның тӛменгі жағында орналасқан ақ қағаздың суреті бар батырманы 

шертіңіз немесе келесі команданы таңдаңыз: Layer → New → Layer (Қабат → 

Құру → Қабат). Лассо құралының кӛмегімен ӛз фотосуретіңіздегі керек 

аймақты бӛліп алып, құрылған  қабатқа орналастырыңыз.  

Барлық қабаттарды біріктіріңіз (Shift+Ctrl+E). Ең соңғы нәтиже 99-суретте 

кӛрсетілген.  

                                               

 

                                       

 

 

 

 

 

 

 

 

                     98-сурет                                      99-сурет. (соңғы нәтиже) 

 

Практикалық тапсырма №11. Кемпірқосақ суретін салу 

 Ең алдымен керек фотосуретті таңдап алыңыз. Ондағы аспан анық кӛрінуі 

керек және бұлттары жоқ болса тіптен жақсы. Бірақ бұлттар үлкен қиындық 

туғыза қоймас, себебі бұлтты аспанды ашық аспанға түрлендіру ӛте жеңіл. Ол 
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үшін ерекшелеу немесе бүркемелеу (маскировать) құралдарының кӛмегімен 

аспан бӛлігін ерекшелеп алып және оны кӛк түсті градиентпен бояу жеткілікті. 

Тӛменде таңдалынған сурет кӛрсетілген (100-сурет). 

 

 

 

 

 

 

 

 

 

 

 

                                               100-сурет 

 

 Бізге жаңа қабат керек (Shift+Ctrl+N). Gradient (Градиент) құралының 

кӛмегімен жаңа үлгі құрыңыз. Оның баптаулары 101-суретте кӛрсетілген. Біз 

радиалды (Radial) градиентті қолданамыз. Себебі, градиентті орналастыру 

радиусы үлкен, ал кемпірқосақтың түстік құраушылары онда айтарлықтай 

жіңішке жолақты алып тұратындықтан, оны қолданудың нәтижесінде 

шындыққа сай кемпірқосақ саламыз. 

Осының нәтижесінде градиенті бар қабат 102-суреттегідей болуы керек. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Енді кемпірқосақты артық қызыл және күлгін түсті (фиолетовый) 

аймақтарынан бӛліп алу керек. Ол үшін кез келген ерекшелеу құралын 

пайдалануға болады, мысалы, Elliptical Marquee (Эллипстік ерекшелеу, 

Эллиптическое выделение). Алдымен кемпірқосақтың сыртқы контурын 

ерекшелеп алу керек (ыңғайлы болу үшін Shift пернесін басуға болады). Сосын 

алдын-ала Alt пернесін басып, күлгін түсті аймақты ерекшелеуден алып 

тастаңыз. Нәтижесі 103-суреттегідей болуы керек. 

101-сурет 102-сурет 
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Shift+Ctrl+I пернелерін басу арқылы ерекшеленген аймақты инвертирлейміз. 

Сосын артығын ӛшіріңіз (Delete). Бейне 104-суреттегідей болады. Сосын 

ерекшелеуді алып тастауға болады (Ctrl+D). 

 

 

 

 

 

 

 

 

 

                
 

 

 

 Енді Gaussian Blur (Гаусс бойынша шаю, Размытие по Гауссу) сүзгісін 

қолданыңыз: Filter  Blur  Gaussian Blur (Сүзгі  Шаю  Гаусс бойынша 

шаю, Фильтр  Размытие  Размытие по Гауссу). Оның баптаулары 105-

суретте кӛрсетілген. 

Free Transform (Еркін тасымалдау) құралының кӛмегімен қабатты жылжытыңыз 

(106-сурет) . Бұл нұсқа кӛмегімен тек қабаттың орнын ауыстырып қана қоймай, 

кемпірқосақтың ӛлшемін ӛзгертуге және оны кішкене бұруға болады. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Қазір біз аспанда орналаспаған градиентті алып тастауымыз керек. Оны 

ӛшіргішпен (ластик) ӛшіру ӛте қиын. Сондықтан пейзаж орналасқан қабатқа 

ӛтіңіз және Magnetic Lasso (Магнитті лассо) құралын таңдаңыз. 107-суретте 

кӛрсетілгендей етіп бедердің кедір-бұдырларының бойымен жүріп ӛтіңіз 

(қалған бӛлікті қалағанынша ерекшелеуге болады, ең бастысы, оған жойылуы 

керек кемпірқосақтың бӛлігі кірсе жеткілікті). 

Градиенті бар қабатқа қайта ӛтіп, артық бӛлікті ӛшіру үшін Delete пернесін 

басыңыз. Сосын Layers (Қабаттар, Слой) палитрасында Opacity (Мӛлдір 

103-сурет 104-сурет 

105-сурет 106-сурет 
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еместік, Непрозрачность) баптауының мәнін 30-50%-ға ӛзгертіңіз. Соңғы 

нәтиже 108-суретте кӛрсетілген.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Практикалық тапсырма №12. Кірпіштерді қалайық 

 Кез келген ӛлшемдегі жаңа бейне құрыңыз. Paint Bucket (Құю, Заливка) 

құралын пайдаланып оны келісімді түске бояңыз. Біздің жағдайда кірпіштер ақ 

емес қызыл түсті болғаны дұрыс. 

Енді осы бейнеде жаңа қабат құрыңыз. Ол үшін Layer (Қабат, Слой) 

палитрасындағы ақ қағаздың суреті бар батырманы шерту немесе Shift+Ctrl+N 

пернелер комбинациясын басу жеткілікті. Бұл қабат кедір-бұдырды кӛрсетудің 

дайындамасын жасауға арналған. Оны ақ түске бояңыз. 

Енді Texturizer (Текстуризатор) сүзгісін: Filter  Texture  Texturizer (Сүзгі  

Текстура  Текстуризатор) пайдаланайық. 

 Бұл сүзгіде арасынан біреуін таңдауға болатын бірнеше дайын текстуралар 

бар. Бірден Brick (Кірпіш) текстурасын пайдаланбағаныңыз жӛн. Себебі, 

біріншіден, сіздің кӛп мүмкіншіліктеріңіз шектеледі. Ал екіншіден егер сіздің 

бейнеңіз жеткілікті мӛлшерде үлкен ӛлшемді болса, онда кірпіштер ӛте 

кішкентай болып қалады. Сондықтан 109-суретте кӛрсетілген баптауларды 

беріп, Sandstone (Құмдық, Песчаник) текстурасын қолданыңыз. 

Нәтижесінде сіз қатпарлы ақ бет аласыз. Осы қатпарды негізгі қабатқа 

ауыстыру қажет және текстура алдыңғысынан да әдемірек болуы керек. Ол 

үшін қабатты орнатудың баптауларын пайдаланайық. Layers (Қабаттар) 

палитрасындағы екінші қабатты шертіңіз және Blending Options (Орнату 

мәндері, Параметры наложения) мәнін таңдаңыз. Ашылған терезеден бізге 

Blend Mode (Орнату режимі, Режим наложения) мәні ғана керек. Multiply 

(Кӛбейту, Умножения) режимін таңдаңыз. Егер барлығы дұрыс орындалса 

нәтижесі 110-суреттегідей болады. 

 

 

 

 

107-сурет 108-сурет (нәтиже) 
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Кірпіштердің ӛзін салайық. Ол үшін жаңа қабат құрыңыз. Кірпіштерді бір-

бірінен бӛліп тұратын кӛлденең және тік орналасқан сызықтар сызайық. 

Кейінірек бұл сызықтар цементке ұқсайтын болады. Мұны орындау үшін 

бірнеше құралдар бар. Мысалы: Brush (Қылқалам, Кисть), Pencil (Қарындаш), 

Line (Сызық, Линия). Бірақ қылқалам құралын пайдаланған тиімдірек. Ал 

сызықтарды түзу сызу үшін қылқаламды Shift пернесін басып тұрып 

пайдаланған жӛн. 

  Қабатты цементпен шаяйық. Ол үшін Gaussian Blur (Гаусс бойынша шаю) 

сүзгісін пайдаланайық: Filter  Blur  Gaussian Blur (Сүзгі  Шаю  Гаусс 

бойынша шаю, Фильтр  Размытие  Размытие по Гауссу). Radius (Радиус) 

мәні сызықтарды сызу үшін қолданылған қылқалам диаметрінің жартысына тең 

болу керек (111-сурет). 

  Алынған бейнедегі сызықтар цементке ұқсамайды. Оны жӛндеуге 

кірісейік. Алдымен цементтің кӛлемін кӛрсетейік. Ол үшін Emboss (Барельеф) 

сүзгісін пайдаланамыз: Filter  Stylize  Emboss (Сүзгі  Стильдеу  

Барельеф, Фильтр  Стилизация  Барельеф). Сүзгі баптаулары  112-суретте 

кӛрсетілген. Алайда Angle (Бұрыш) мәнін ӛзіңіз беріңіз, себебі ол бедерлі 

әсерді қалыптастыру үшін жарық қай жақтан шығу керектігін кӛрсетеді. 

 

 

 

 

 

 

 

 

 

 

 

 

 

109-сурет 110-сурет 

111-сурет 112-сурет 
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  Ақырғы екі сүзгіні қолданғаннан кейінгі нәтиже 113-суретте 

кӛрсетілген. Осы нәтиже шындыққа жанасады. Алайда цементке қатпарлар 

жетіспей тұр. 

Бұл жағдайда цементке қатпарлар қосу кірпіштердің фактурасын жасаған 

әдіспен орындалады. Бірақ ол кезде жаңа қабат фон қабатынан жоғары 

құрылған және ол қызыл түске боялған. Ал енді жаңа қабат цементі бар 

қабаттан жоғары құрылуы керек. Қалған амалдар қайталанады. Соңғы нәтиже 

114-суретте кӛрсетілген. 

 

 

 

 

 

 

 

 

 

 

 

 

 

3. CORELDRAW ПРОГРАММАСЫНДА ОРЫНДАЛАТЫН 

ПРАКТИКАЛЫҚ ТАПСЫРМАЛАР 

Практикалық тапсырма №1. CorelDRAW векторлық редакторында 

объектілермен жұмыс  

Объектіге: сызықтар, фигуралар, графика, мәтін жатады. 

Объектілерді ерекшелеу 

Объектіні ӛзгерту үшін алдымен оны ерекшелеп алу керек. Бір ғана объектіне 

немесе бірнеше объектінің тобын ерекшелеуге болады. Ерекшеленген 

объектінің айналасында шектейтін блок, ал оның центрінде «Х» белгісі 

кӛрінеді.  

Объектіні қиып алу, көшірмесін алу және қою 

Объектіні қиып алғанда немесе кӛшірмесін алғанда, ол алмасу буферіне 

орналасады. Ол жерден оны басқа да қосымшаларға қоюға болады.  Қиып 

алғанда объект суреттен алынып басқа жерге қойылады. Ал, кӛшірмесін 

алғанда түпнұсқа орнында қалады, тек кӛшірмесі ғана алмасу буферіне 

орналасады.  

Объектінің дубликатын жасау 

Дубликат жасағанда объект алмасу буферіне түспей тікелей сурет салу 

терезесінде пайда болады. Дубликат жасау кӛшірмесін алғаннан және қиып 

алғаннан тез орындалады. Онан басқа, объектіге дубликат жасағанда оның х 

және у осьтері бойында бастапқы қалпы мен дубликат жасалған ара 

қашықтығын кӛрсетуге болады, Бұл арақашықтық орын ауыстыру деп аталады.  

113-сурет 114-сурет (нәтиже) 
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Объектілерді клонировать ету 

 Объектіні клонировать еткенде оның түпнұсқасымен байланысқан кӛшірмесі 

пайда болады. Бастапқы объектіге қандай ӛзгеріс жасалса да, ол клонға 

автоматты түрде әсер етеді. Ал, клонда жасалған ӛзгеріс бастапқы объектіге 

әсер етпейді. Клонда жүргізілген ӛзгерісті жойып, бастапқы объектіге қайта 

оралуға болады. Клонирование арқылы объектінің бірнеше кӛшірмесіне 

объектінің шаблонын ӛзгерте отырып, ӛзгеріс жасауға болады. Суретте жұлдыз 

екі рет клонировать етілген. Оған әр түрлі бояу және абрис қасиеті 

қолданылған. Сонымен қатар клонның формасы ӛзгерген. Ол үшін адымен 

объектіні ерекшелеп, Правка –Клонирование командасын орындау керек. 

Клонның шаблонын таңдау үшін клонның үстінде оң батырманы басып, 

Выбрать шаблон  командасын орындау керек. Клон жасалған объектілердің 

шаблонын таңдау үшін шаблонның үстінде оң батырманы басып, Выбрать 

клоны батырмасын басу керек. 

Бір объектіден екінші объектіге эффектілер көшіру 

 

1.  мәзірін және  құралын таңдаңыз. 

2. Қасиеттер панелі тізімінен Объектілер атрибуттарын таңдаңыз 

3. Эффекті мәзірін шертіп, келесі жалаушалардың кез-келгенін орнатыңыз:  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

4. Эффект жасайтын объектінің шетін шертіңіз 

 

5.  мәзірін және   құралын таңдаңыз. 

 

6. Эффект кӛшірілетін объектінің шетінен шертіңіз 
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Объектілерді бекіту 

1.Соңғы объектіге бекітілетін объектіні ерекшелеп алыңыз. 

2. Бекіту нүктесі ерекшеленгенше курсорды объект бойынша жылжытып 

отырыңыз. 

3. Бекіту нүктесі кӛрінбей қалғанша объектіні соңғы объектке жылжытыңыз. 

Объектілерді бұру 

1.Объектіні ерекшелеу  

2. Окно → Окна настройки→ Преобразования → Поворот командасын 

орындаңыз 

3. Преобразование-дегі Относительно центра жалаушасын алып тастаңыз 

4. Угол ӛрісінде бұру бұрышын кӛрсетіңіз. 

Объектіні теріс қарату 

1. Объектіні ерекшелеу  

2. Окно → Окна настройки → Преобразования → Масштаб командасын 

орындаңыз 

3. Преобразование-дегі келесі батырмалардың біреуін басыңыз: 

- Кӛлденеңінен теріс қарату – объектіні солдан оңға қаратады. 

- Тігінен теріс қарату – объектіні жоғарыдан тӛмен қаратады. 

Объектілерді топтау 

 Бір немесе бірнеше объектілерді топтау уақытында бұл объектілер тұтас 

қарастырылады. Топтастырылған объектілердің барлығына бірдей параметрлер 

қолданылады. Объектілерді топтау үшін  оларды ерекшелеп, Упорядочить → 

Сгруппировать командасын орындау керек.  Объектіні топқа қосу үшін, Окно 

→ Окна настройки → Диспетчер объектов командасын орындап, объект атын 

топ атына алып бару керек. 

PowerClip объектілерін құру 

 CorelDRAW-да векторлық объектілер мен растрлық бейнелерді 

орналастыруға болады. Мысалы, суреттерді басқа объектілердің немесе 

контейнердің ішіне орналастыруға болады. Контейнер ретінде кез-келген 

объект алына береді. Мысалы фигуралық мәтін немесе тіктӛртбұрыш. Ӛлшемі 

контейнердің ӛлшемінен үлкен объект контейнерге кіргізілгенде, сол 

контейнердің ӛлшемін қабылдайды. Ол контейнердің ішіндегі заты деп аталып, 

PowerClip объектісі жасалады. PowerClip объектісін жасайтын объектілер: 

фигуралық мәтін және растрлық бейне.  

1. Объектіні ерекшелеу керек.  

2. Эффекты –PowerClip--Поместить в контейнер командасын орындау керек. 

3. Контейнер ретінде қолданылатын объектіге шерту керек. 

Объектіні бұрмалау 

 Объектілерге үш түрлі бұрмалау эффектілерін қолдануға болады: сығу және 

созу, молния-застежка, бұрау. 

Ол үшін: 
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1.Интерактивные инструменты  мәзірін ашып,     

құралын таңдау 

2.Қасиеттер панелінде келесі батырмалардың бірін  басып, қажетті 

параметрді орнатыңыз. 

3.Бұрмалау центрі орналасатын жерді таңдап, объект қажетті формаға келгенше 

курсорды жылжытыңыз. 

 

 «Эмблема жасау» 

 

1.    батырмасын пайдаланып шеңбер сызыңыз. 

 

2.    «Заливка» батырмасын таңдап шеңберді градиентті түспен бояңыз. 

 

 

3.  Мәтін жазу батырмасын таңдап, команда атын теріңіз. 

 

4. Мәтінді           батырмасын таңдау арқылы белгілеп, Текст - 

 

Преобразовать в фигурный текст командасын орындаңыз. 

5. Мәтінді шеңбер ішіне орналастырыңыз. 

6. Файл → Импорт → Диск С → ProgramFales → MS Office → ClipArt бумасын 

ашып қажетті суреттерді таңдап алыңыз. 

7. Суретті шеңбер ішіне орналастырыңыз. 

 

Практикалық тапсырма №2. CorelDRAW векторлық редакторында 

стандартты фигуралар салу және оларға мәтін енгізу 

Тіктөртбұрыш. Тіктӛртбұрыш саймандар тақтасындағы Rectangle (тікбұрыш) 

 құралының кӛмегімен тұрғызылады. Rectangle батырмасын басқан кезде, 

тышқан кӛрсеткіші айқас сызыққа айналады. Қалып-күй қатарындағы тышқан 

кӛрсеткішін Rectangle құралына апарып, диоганаль бойынша созу  керек. 

Тышқанмен  жылжытып  болғаннан кейін оның батырмасын жібергенде, 

экранда  тіктӛртбұрыштың  жан-жақтарына  жиектерін  белгілеу  және  орталық  

маркері шығады. Ал қалып-күй қатарына тіктӛртбұрыш  тобына  жататын 

обьекті  белгіленеді  деген  хабарлама шығады. Бӛліп алу  жақтауы дегеніміз  

экранда  бӛлініп  алынған  бірнеше  обьектілерді белгілейтін 8 қара кішкене 

шаршыдан құралған топ. Бӛліп алу жақтауы  қисық  крестик  түрінде маркер 

ортасында орналасады. 

CorelDRAW-да кез келген графикттік обьектіні  құрағаннан кейін  ол бӛлініп 

алынған  болып  табылады  және  оның  айналасында  бӛліп  алу  жақтауы 

пайда  болады. 
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115-сурет. Тіктӛртбұрыштармен жұмыс жасаудағы атрибуттар құралы 

 

 Тіктӛртбұрыштардың атрибуттар құралы (115-сурет) мына қасиеттерден 

тұрады: тӛртбұрыштың  ӛлшемін,  тӛртбұрыштың  орналасуын, масштаб 

коэффициенттерін  және  т.б. қасиеттерін    ӛзгертуге  мүмкіндік  береді.  

Сонымен  бірге  онда  обьектілермен  жұмыс  жасау  батырмалары  орналасқан 

(бұрау, айналық бейнелеу, бұрыштарды дӛңгелектеу және т.б) 

Объектінің еркін қозғалыспен орталықтан айналдыру жағдайын ӛзгертуден 

басқа, тышқанның кӛмегімен  орталықтан айналдыру жағдайының нақты және 

дәл берілген мүмкіндері бар. Ол үшін 116-суретте кӛрсетілгендей Ӛзгерту 

(Преобразование) атрибуттар тақтасын кӛрсетіп қою қажет. Ӛзгерту тақтасы 

бізге сол тікбұрышты бейненің формасын ӛзгерту үшін қолданылады. 

  
 

116-сурет. Ӛзгерту атрибуттар тақтасы 

 

 Бұл атрибуттар тақтасын іске қосу үшін Терезе (Окна) → Тақталар (Панели) 

→ Ӛзгерту (Преобразование) командаларын орындаймыз. 

Енді салынған фигуралардың бұрышын дӛңестетуге болады. Ол үшін фигураны 

ерекшелеп, қасиеттер панеліндегі сол жақ және оң жақ бұрышын дӛңестету 

құралдарын пайдалынып, шаршыны немесе тіктӛртбұрышты дӛңес етіңіз.  

 

 

 

 

 

 

 

 

 

 

Тіктӛртбұрышты Shape (Форма) құралы арқылы да түрін ӛзгертуге болады. 

Сонда тіктӛртбұрышыңыз  жағдайда болуы тиіс. Тышқанның курсорын 

объектінің бір бұрышына апарсаңыз күйге келеді. Оның үстінен ұстап 

тұрып, тӛмен қарай тікбұрыштың ішкі жағына қарай тартсаңыз  күйінен 

 жағдайына келеді.  

Эллипс. Эллипс салғанда мына  құралды таңдау керек. Салу әдісі 

тіктӛртбұрышты салумен бірдей. Егер салынған дӛңгелекті немесе эллипсті 
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доғаға немесе секторға айналдыру керек болса, онда фигураны ерекшелеп, 

қасиеттер панеліндегі  батырмаларды басу керек. 

 

 

 

 

Бұл фигураларды эллипстің атрибуттар тақтасынан кӛре аласыз. Бұлардан 

басқа эллипс құралын пайданып, әр түрлі ӛзгерістер келтіруге болатын бірнеше 

батырмалар орналасқан (117-сурет) . 

 

 

 

 

 

Эллипстің атрибуттар тақтасының ішінен тӛменде эллипстің қасиеттер 

тақтасының параметрлерін қарастырайық: 

 

 

 

 

 

 

 

 

 

 

 

Сектор (Pie) және Доға (Arc) объектілердің сыртқы түрін анықтайтын келесі 

параметрлер бар: 

  Бастапқы және соңғы бұрыштар (Starting and Ending Angles)  - доға 

дӛңгелегінің ұзындығының бұрыштық ӛлшемі.  

  Сағат тіліне қарсы доға мен сектор (Clockwise/Counterclockwise  Arcs or Pies) 

батырмасы доға мен секторды инверсиалды түрде бейнелейтін санап шығару 

бағытына сұраныс қояды. 

«Эллипс» құралының кӛмегімен салынған жаңа объектілердің үнсіз келісім 

бойынша қасиеттерін ӛзгерту 

1. Мәзір қатарынан Инструменты → Параметры командасын орындаңыз. 

2. Категориялар тізімінен Рабочее пространство, сонан соң Набор 

инструментов, келесі ашылған тізімнен эллипсті таңдаңыз. 

3. Жаңа объектілердің формасын ӛзгерту үшін сектор немесе доғаның біреуін 

таңдау керек 

4. Бастапқы және соңғы бұрышын кӛрсету 

5. Сағат тілімен бағыттас немесе қарама-қарсы екеуінің біреуін таңдаңыз. 

Сонан соң фигураға әрекеттерді орындауға болады.  

117-сурет. Эллипстің атрибуттар тақтасы 

Эллипс (Ellipse) 

Сектор (Pie) 

Доға (Arc) 

Бастапқы және соңғы бұрыштар (Starting and Ending Angles) 

Сағат тіліне қарсы доға мен сектор 

(Clockwise/Counterclockwise  Arcs or Pies) 



62 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 Қасиеттер тақтасындағы сектормен доғаның бастапқы және соңғы 

бұрыштарына нұсқау үшін берілген жолдарды қолдануға геометрия ілімін 

білуді талап етеді. Кӛбінесе қолданатын ыңғайлы әрекеттің бірі, ол Форма  

құралын пайдалану болып келеді. (118-сурет) 

 

 

 

 

 

 

 

118-сурет. Бақылау түйін нүктесінің кӛмегімен доға, сектор және эллипстің 

ӛзгеруі 

 

Эллипсті пайдалана отырып, мынадай фигураларды жасауға болады. 

  

 

 

 

 

 

 

 

Түйіндер – объектінің контурында орналасқан, оны Shape құралымен 

ерекшелеу кезінде пайда болатын боялған қара квадраттар. Сызықтың сегменті 

- екі түйіннің арасындағы контурындағы бӛлігі. 

Түйін және сегмент ұғымдары CorelDRAW-мен жұмыс барысында негізгі 

ұғымдар. Түйіндер мен сегменттерді редактрлеу, сызықтар мен объектілердің 

формасын ӛзгертудің үлкен мүмкіндіктерін ұсынады. Түйіндермен жұмыс 
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жасау үшін  Shape (Форма) құралы пайдаланылады. Егер Shape құралымен 

түйінді шертетін болсақ, ол белгіленіп қара түске боялады, бір немесе екі 

бақылау нүктелері мен оларды түйінмен біріктіретін үзік сызықтар пайда 

болады. Бақылау нүктелері контурдың қисық сызықты сегментінің ұзындығы 

мен формасын береді, ал жанама сызықтар – таңдап алынған түйінге қандай 

бақылау нүктелері сәйкес келетіндігін кӛрсетеді (120-сурет). Түзу сызықты 

қисықтың бақылау нүктесі болмайды. 

 

                                                       
                                            

 

     119-сурет                                              120-сурет 

 

Көпбұрыштар мен жұлдызшалар салу 

 Кӛпбұрыш (Poligon)  құралы кӛпбұрышты фигураларды салу үшін 

берілген. Биіктіктігін 3 тен 500-ге дейінгі аралықта беруге болады. Кӛпбұрыш 

құралынан кӛпбұрыш фигурасынан басқа жұлдызша, кӛп бұрышты жұлдызша, 

спираль және тор кӛз бейнелері бар (121-сурет). 

Егер де 5 саны берілсе, онда бесбұрышты кӛпбұрыштың бір бейнесі шығады. 

Ал егер де 20 немесе одан да кӛп бұрыш санын бергіңіз келсе, оны ӛзіңіз  

батырмалары арқылы ӛзгертесіз, сонда сізге жиырма бұрышты немесе одан да 

кӛпбұрышты фигура бейнеленеді. 

 

 

 

 

 

 

 

 

 

121-сурет 

 

 

 

 

 

Кӛпбұрыш Жұлдызша 

Қиын жұлдызша 
Тор кӛз 

Спираль 
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Тӛменде градиентті боялған фигуралар: 

 

 

 

 

 

 

 

                кӛпбұрыш  дұрыс жұлдызша       күрделі жұлдыз 

 

Кӛпбұрыштар мен жұлдыздарды ӛзгертуге болады, мысалы, жақтары мен 

тӛбелерінің санын, тӛбелерін үшкірлеу етуге болады.  

 

Форма  құралының кӛмегімен кӛпбұрыштың сыртқы бейнесін ӛзгерту 

мүмкіндігі бар. 

1. Полигон құралының кӛмегімен бес бұрышты бӛліп аламыз.                                                                                                                                                                                                                                                                                              

 
Кӛпбұрыштың тӛбелерінің санын 11-ге жеткіземіз. Сол кезде бесбұрышымыз 

мынандай фигураға айналады. 

 
 

Пайда болған фигураның  бір бұрышын тышқанның сол жақ батырмасын  

басулы күйінде центрге қарай жылжытамыз. Осы кезде фигурамыз мынандай 

күйге келеді. Пайда болған 11 бұрышты жұлдызшаның түсін қалауымыз 

бойынша әр түрлі түске бояймыз. 
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2. мына формадан келесі фигураларды және т.б. фигураларды 

шығаруға болады.   

 

 

 

 

 

 

 
 

 

Кӛпбұрышты пайдалана отырып, мынадай фигураларды салуға болады. 

 

   

   

 

 

 

3. Полигон құралының кӛмегімен жұлдызшаны бӛліп аламыз.   

 

 
 

Жұлдызшаны белгілей отырып, интерактивті контурдың кӛмегімен 

жұлдызшаны центрден бастап  ішке қарай тартамыз. Құйылма арқылы түсін 

ӛзгертеміз. Осы кезде жұлдызшамыз мынандай түрге келеді.                   

 

Кӛпбұрышты пайдалана отырып, саймандар тақтасындағы   интерактивті 

созу (интерактивное выдавливание) батырмасының кӛмегімен  мына 

фигураларды  алуға болады. 
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Көпбұрышты өзгерту 

 Кӛпбұрыштың жақтарының санын ӛзгерту – ол үшін қасиеттер панелінде  

кӛпбұрыштың, жұлдыздың, күрделі жұлдыздың жақтарының немесе 

тӛбелерінің санын енгізіп, Enter пернесін басу керек. Кӛпбұрышты жұлдызға 

ауыстыру үшін, кӛпбұрышты және форма сайманын таңдап, кӛпбұрыштың 

түйінінде тышқан батырмасын жылжыту арқылы қажетінше жұлдызша жасау 

керек.  

 

 

 

 

 

Спираль салу 

Спираль салудың екі түрі бар: симметриялы және логарифмдік. Симметриялы 

спираль біркелкі оралымдардан тұрады, ал логарифмдік орам айналған сайын 

оның қадамдары үлкейе түседі. 

 

 

 

 

 

 

 

 

Тор салу 

Торды бағаны мен қатарының санын кӛрсетіп салуға болады. Тор – 

тіктӛртбұрыштардың тобы, оларды ажыратуға болады.  

Саймандар қатарынан  таңдап,  қасиеттер панелінде жоғарғы сан 

– бағандар санын, тӛменгі сан – қатарлар санын кӛрсетіңіз. Егер торды 

центрінен бастап салу керек болса, SHIFT  батырмасын басып тұрып, ал 

торлардағы ұялар ӛлшемі бірдей болу керек болса, онда CTRL пернесін басып 

тұрып салыңыз. Ал егер де, торды алып тастау керек болғанда,  сайманын 

таңдап, Упорядочить → Отменить группировку командасын орындау керек. 
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Стандартты фигуралар салу 

Дұрыс фигуралар коллекциясын пайдаланып, стандартты фигуралар салуға 

болады. Белгілі бір фигуралар, мысалы, негізгі фигуралар, бағыттауыш 

фигуралар, баннер фигураларын және ескертпе фигураларында глифтер бар. 

Глифті жылжыту арқылы фигураны ӛзгертуге болады. . 

Глиф – ромб түріндегі маркер, оны жылжыту арқылы  фигураны ӛзгертуге 

болады.  

Стандартты фигураға мәтін қосу 

1.   мәтін сайманын таңдаңыз. 

2. Курсорды мәтін жағдайына  ӛзгеретіндей етіп фигура абрисінің ішіне 

орналастырыңыз.  

3. Мәтінді енгізіп, қарібін таңдап, форматтаңыз. 

 

CorelDRAW-та түйіннің үш типін ажыратады: 

- тегіс түйін (smooth), тегіс қисықты (122-сурет) салу үшін тағайындалған. Екі 

бақылау нүктелері де, түйін де бір түзуде орналасады, бірақ жанама 

сызықтардың ұзындықтары әр түрлі. Бір бақылау нүктесінің орын ауыстыруы, 

бақылау нүктесінің бір жағынан қисық сызықты сегменттің қисықтығының 

сәйкес ӛзгеруіне әкеледі, ал келесі жақтың ұзындығы ӛзгермейді;       

- симметриялы түйін (symmetrical) кӛп жағдайда тегіс түйінге ұқсас – бақылау 

нүктелері де, түйін де бір түзудің бойында жатады (123-сурет), бірақ жанама 

сызықтар ұзындықтары бірдей. Бақылау нүктесінің біреуі қозғалған жағдайда 

екіншісі де қозғалады, яғни жанама сызықтар үнемі тең болады. Бақылау 

нүктесі орнының ӛзгеруі, жанама сызықтың қисыққа еңкею бұрышының сәйкес 

ӛзгеруіне әкеледі; 

- сүйір түйін (Cusp) объектінің қисығында сүйір бӛліктерді жасау үшін 

пайдаланылады. Бұл түйіннің әр түрлі жағындағы жанама сызықтары бір түзуде 

жатпайды, демек, жанасқан қисық сызықты сегменттердің қисықтығы әр түрлі 

болады, ол мұндай түйіннен ӛтетін қисық сүйір бұрышпен иіледі (124-сурет). 

Әрбір сегмент үшін қисықтың радиусы мен жанаманың еңкею бұрышын, 

ұзындығы мен жанаманың еңкею бұрышынан ӛзгеруімен бір-бірінен тәуелсіз 

реттеуге болады, яғни бақылау нүктелерін жылжыта отырып. 

             
 

           122-сурет                                    123-сурет                   124-сурет 
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 Түйін типін ӛзгерту үшін ашылатын Shape Edit Flyout (Фигураны редактрлеу) 

тізімінде орналасқан Shape (форма) сайманын пайдалануға болады. Алдымен 

редактрленетін түйінді белгілеп алып, сонан соң тышқанның оң батырмасын 

басыңыз да, жанама менюден қажет пунктті таңдап алыңыз. 

Қисық түйіндерін Shape сайманымен редактрлеу 

 Түйіндерді редактрлеу әр түрлі операцияларды орындауды білдіреді, соның 

ішінде жаңа түйіндерді қосу, қажет емес түйіндерді жою, түзу сызықтарды 

қисыққа түрлендіру және керісінше, түйіндердің орнын алмастыру және 

олардың бақылау нүктелерін манипуляциялау және т.б. 

Барлық келтірілген операциялар Shape сайманының кӛмегімен орындалады, 

басқарушы элементтер қасиеттер панелінде кӛрініп тұрады (125- сурет), атап 

айтқанда: 

 

 

 

125-сурет 

 

- Add Node (S) батырмасы – сіз тышқанмен шерткен жерде жаңа түйін 

жасайды; 

- Delete Node (S) батырмасы – белгіленген түйіндерді жояды; 

- Join two Nodes – екі түйінді біреуге біріктіреді; 

- Break Curve – белгіленген түйіндегі пішінді үзеді; 

- Convert Curve to Line – белгіленген түйінге жақын орналасқан қисықты түзу 

сызыққа түрлендіреді; 

- Convert Line to Curve – белгіленген түйіннің қасындағы түзу сызықты 

қисыққа түрлендіреді; 

- Make Node a Cusp Convert батырмасы – белгіленген түйінді сүйірлену 

түйініне түрлендіру; 

- Make Node Smooth – белгіленген түйінді тегіс түйінге немесе созылу түйініне 

түрлендіреді; 

- Make Node Symmetrical батырмасы – белгіленген түйінді симметриялық 

түрге түрлендіреді; 

- Reverse Curve Direction – пішіннің жасалу бағытын ӛзгертеді; 

- Extend Curve to Close батырмасы – түзу сызықтың белгіленген екі шеткі 

түйіндерін біріктіреді; 

- Extract Sub path батырмасы – белгіленген түйінді пішінді бӛледі; 

- Auto Close Curve батырмасы – түзу сызықтың соңғы түйіндерін автоматты 

түрде тұйықтайды; 

- Stretch and Scale Nodes батырмасы – белгіленген түйіндерді жылжыту және 

масштабтау режимдерін орнатады; 

- Rotate and Skew Nodes батырмасы – таңдап алынған түйіндерді бұруға, 

еңкейтуге мүмкіндік береді; 

- Align Nodes батырмасы – белгіленген түйіндерді түралайды; 

- Elastic Mode батырмасы – икемді қисық режимін қосады; 

- Select All Nodes батырмасы – бір мезгілде барлық түйіндерді белгілейді; 
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- Curve Smoothness батырмасы – белгіленген түйін қасындағы пішінді тегістеу 

деңгейін реттейді.   

Бір немесе бірнеше түйіндерді белгілеу 

 Түйінде редакциялау үшін оны алдымен белгілеп алу қажет. Әдетте, бұл 

үшін Shape сайманын пайдаланады. Алдымен кӛрсетілген сайманмен қисықтың 

ӛзін, сонан кейін таңдалынған түйінді белгілейсіз. Бірнеше түйінді бір мезгілде 

белгілеу үшін Shift пернесін басулы күйде әрқайсысын кезекпен шертіңіз 

немесе белгіленетін түйіндердің ішінде пунктирлі рамканы созыңыз (126-

сурет). Барлық түйіндерді бірден ерекшелеу үшін  

Edit → Select → Nodes (Түзету → Бәрін ерекшелеу → Түйіндер) командаларын 

орындаймыз. Барлық түйіндерден ерекшелеуді алып тастау үшін, қисықтан тыс 

жерде, сурет салу терезесінің кез-келген нүктесінде шертіңіз. Түйіндер мен 

объектілерді, олардың жасалу ретімен ерекшелеу үшін, Tab пернесін басыңыз. 

Shift + Tab пернелерін басу, түйіндер немесе объектілерді, олардың 

жасалуының кері ретімен ерекшелейді. 

 

Түзу сызықты қисыққа тікелей және кері түрлендіру 

 Түзу сызықта бақылау нүктелері болмайды (127-сурет). Мұндай сызыққа 

бақылау нүктелерін қосу үшін, түзу сызықты қисыққа түрлендіру қажет. Ол 

үшін түзуді ерекшелеңіз немесе объектіні Shape (Форма) сайманымен 

ерекшелеңіз, сонан соң қасиеттер панеліндегі (128-сурет) Convert Line to Curve 

(Түзуді қисыққа түрлендіру) батырмасын шертіңіз. Түрленгеннен кейін түзудің 

бӛлігінде екі жаққа бақылау нүктелері пайда болады (129- сурет). 

 

     
                126-сурет                                             127-сурет 

 

       

       
 

                          128-сурет                                                           129-сурет 
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 Егер бізге кері операция қажет болса, яғни қисықты түзу сызыққа түрлендіру 

үшін Convert Curve to Line (Қисықты түзуге түрлендіру) (130-сурет) 

пиктограммасын пайдаланыңыз. Бақылау нүктелері жоғалып, қисық сызық 

түзуге айналады (131-сурет).                      

           
 

                             130-сурет                                                           131-сурет 

 

Түйіндерді қосу және жою 

 Кейде объектінің формасын ӛзгерту үшін, бірнеше түйінді қосу немесе жою 

қажет.  

 Жаңа түйінді жасау үшін (132-сурет) объектіні Shape (Форма) сайманымен 

ерекшелеп, кӛрсеткішпен пішіннің қажетті нүктесінде шертіңіз – пішін 

сегментінде уақытша дӛңгелек түйін пайда болады. Әрі қарай ұсынылатын 

әрекеттердің бірін орындаңыз: уақытша түйінде тышқанның оң жақ 

батырмасын шертіп, жанама менюден (133-сурет) Add (Қосу) командасын 

таңдаңыз немесе қосымша цифрлық пернетақтадан + пернесін басыңыз немесе 

қасиеттер панеліндегі Add Node (Түйінді қосу) батырмасын шертіңіз.  

Түйіндіні бірнеше тәсілмен жоюға болады: 

- оны Shape сайманымен ерекшелеп, пернелер тақтасынан Del пернесін басу; 

- оны ерекшелеп, сонан соң қасиеттер панеліндегі Delete Node (Түйінді жою) 

белгісін шерту; 

- берілген түйінде тышқанды екі рет шертуді орындау. 

Түйіндерді жою жанама менюдегі Delete командасының кӛмегімен орындалады 

(134-сурет) 

 

Пішінді үзу және тұйықтау 

 Тұйық пішін ашық және керісіншеге түрлендіруге болады. Тұйық пішінді үзу 

үшін қисықтағы нүктені ерекшелеп, қасиеттер панеліндегі Reserve Curve 

(Қисықты бӛлу) (135-сурет) батырмасын шертіңіз.         
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             132-сурет                            133-сурет                            134-сурет 

 

 

Берілген операция тышқанның оң батырмасын шерту арқылы ашылатын 

жанама меню арқылы да орындалады. Пішінді үзуді аяқтау үшін, оны 

ерекшелеп, жаңа түйінді жылжыту арқылы қисықты үземіз (136-сурет). 

 

 

                                                                                        
   135-сурет                                136-сурет                         137-сурет                                                                                      

 

Пішінді тұйықтау үшін екі түйінді біріктіру қажет. Берілген операцияны 

бірнеше тәсілмен орындауға болады. Бірінші тәсіл: екі ақырғы түйіндерді 

ерекшелеп, қасиеттер панеліндегі (138-сурет) Join Two Nodes (Екі түйінді 

біріктіру) батырмасын шертіңіз. Нәтижесінде екі түйін бірігіп біреуге айналады 

(139-сурет). 

         
 

                         138-сурет                                                           139-сурет 
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 Бейнелерді құрып болғаннан кейін, әрбір бӛлек енгізілген бейнені 

топтастырып бір бейнеге келтіруге болады. Ол үшін әуелі    батырмасы 

арқылы барлық  құрастырылған бейнелерді ерекшелеп аласыз да, атрибуттар 

тақтасында орналасқан  Топтау (Группировать)  батырмасын басасыз. Ал 

егер де тағы да ӛзгерістер енгізгіңіз келсе топтаудан алып тастай аласыз. Ол 

үшін Топтауды алып тастау (Разгруппировать)  батырмаларын 

қолданасыз. 

 

« М е д а л ь о н »  с у р е т і н  с а л у   

Эллипс    құралын пайдаланып шеңбер сызыңыз. 

 

 

 

 

 

 

 

Еркін форма (F5-"свободная рука")    құралын пайдаланып, «Лавр» жапырағы 

формасын салыңыз.  

 

 

Оны белгілеп алып,  градиент(F11- градиентная заливка)  

батырмасын басып, жапырақты «gold» түсімен бояңыз. 

 

  

 

 

 

 

 

 

 

 

 

 

      

 Лавр жапырағы алтын түске боялған соң, оны белгілеп алып, Правка → 

Копировать және Правка → Вставить командасын орындап, жапырақ 

кӛшірмесін алыңыз. Оны белгілі бағытқа бұру үшін суретке барып тышқанды 

екі рет шертіңіз. Қалауыңызша жапырақты бұрыңыз. Осы әрекетті бірнеше рет 

орындаңыз.  
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 Пайда болған гүл шоғын толық белгілеп алып, Изменение → Группировать 

командасын орындаймыз.  

Екінші дәл осындай гүл шоғын алу үшін, белгілеп кӛшірмесін алыңыз 

 Оны қарама-қарсы бағытта бұру үшін  Қасиеттер панеліндегі бұру 

батырмасын басыңыз 

Шеңбердің ішкі бӛлігіне заливка жасаймыз. Заливка түсі алтын түспен болуы 

қажет. 

 Құралдар қатарындағы  мәтін енгізу батырмасын таңдап, қаріп ӛлшемін 

120 пт қойып, Қалың қою түрін таңдап «KZ  kazakstan» сӛзін жазыңыз. 

Оны Шеңбер ішіне орналастырыңыз. 

 

 

 

 

 

 

 

 

 

 

 

 

 

Практикалық тапсырма №3. Мәтін және контурлармен жұмыс 

 Бағдарлама мәтіндік процессор мүмкіндіктеріне ие. Дегенмен, мәтіндік 

редакторлардың барлығы бірдей CorelDRAW сияқты, мәтінге әр түрлі фильтр 

мен эффектілерді қолдана алмайды. 

 Бағдарламада мәтіннің екі түрі пайдаланылады: кӛркемдік және жай. 

Кӛркемдік мәтін тақырыптарды безендіру үшін немесе мәтінге арнайы 

эффектілерді қолдану қажет болғанда пайдаланылады, себебі мұндай мәтінді 

жеке векторлық объект ретінде ӛңдеуге болады. Сондай-ақ, мәтіндік 

ақпараттың кӛлемі үлкен болған кезде мұндай мәтінмен жұмыс жасау қиын 

болады. Ол үшін мәтіннің басқа типі – жай мәтіннің блоктары пайдаланылады. 

Құжатқа мәтінді енгізу 

 CorelDRAW құжатына мәтінді енгізу үшін Text (Мәтін) құралы 

пайдаланылады (140-сурет). Оның кӛмегімен жай мәтінді жекелеген рамада, 

кӛркемдік мәтінді енгізуге болады. 

 

                         
                                              140-сурет 
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Жай мәтінді жекелеген рамкада қосу үшін келесі әрекеттерді орындаңыз: 

1. Қолайлы масштабта құжат бетінің қажетті орнын таңдап алыңыз. 

2. Саймандар панеліндегі Text Tool (Мәтін) белгісін таңдаңыз немесе F8 

пернесін басыңыз. Тышқанның кӛрсеткіші тӛменгі оң бұрышында А әрпі бар 

крест түріне айналады. 

3. Тіктӛртбұрышпен қоршалған рамка (141-сурет) жасаңыз. Ол үшін мәтіндік 

блоктың басы орналасатын нүктеде тышқанды шертіңіз де, тышқан 

батырмасын жіберместен курсорды диагональ бойынша жылжытыңыз. Тышқан 

батырмасын жіберсеңіз рамканың айналасында ерекшелену маркерлері пайда 

болады, ал ішінде мәтінді енгізу курсоры пайда болады. 

4. Пайда болған рамкаға пернелер тақтасынан мәтін енгізіңіз.  

5. Text → Edit Text (Мәтін → Мәтінді редактрлеу) командаларының кӛмегімен 

немесе қасиеттер панелінің (142-сурет) оң бұрышында орналасқан Edit Text 

батырмасын шерту кезінде ашылатын, Edit Text (Мәтінді редактрлеу) 

диалогтық терезесінде мәтіннің үлкен блоктарын енгізу қолайлы болып 

табылады. Сондай-ақ Ctrl+Shift+T пернелерінің комбинацияларын пайдалануға 

болады. 

6. Мәтінді енгізуді аяқтағаннан кейін Pick сайманын таңдап алыңыз немесе 

пробел пернесін басыңыз. 

                                           
                                                    141-сурет 

 

  
 

142-сурет 

 

Жекелеген қатарға кӛркемдік мәтінді қосу үшін келесі әрекеттерді орындаңыз: 

1. Қолайлы масштабта құжат бетінің қажетті орнын таңдап алыңыз. 

2. Саймандар панеліндегі Text Tool (Мәтін) белгісін таңдаңыз немесе F8 

пернесін басыңыз. Тышқанның кӛрсеткіші тӛменгі оң бұрышында А әрпі бар 

крест түріне айналады. 

3. Тышқанды шертіңіз. Таңдап алынған жерде мәтінді енгізу тігінен 

жыпылықтаған курсор пайда болады. 

4. Шақыру процедурасы жоғарыда келтірілген Edit Text диалогтық терезесінің 

кӛмегімен немесе пернелер тақтасынан  мәтінді енгізіңіз. 

5. Кӛркемдік мәтінді енгізіп болғаннан кейін Pick сайманын немесе пробел 

пернесін басыңыз. Мәтін қатарының айналасында ерекшелену маркерлері 

пайда болады.  
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Text → Convert to Paragraph Text (Мәтін → Жай мәтінге түрлендіру) 

командаларын орындау кезінде мәтіннің типі ауыстырылады. Сондай-ақ  Ctrl + 

F8 пернелерінің комбинациясын немесе мәтінде тышқанның оң жақ 

батырмасын басу арқылы ашылатын жанама менюден сәйкес команданы 

пайдалануға болады. 

 

 
 

 
 

Қаріпті өзгерту 

Мәтіндік объектінің қаріпін ӛзгерту үшін келесі әрекеттерді орындаңыз: 

1. Pick (Кӛрсеткіш) сайманының кӛмегімен мәтіндік объектіні таңдаңыз немесе 

мәтін бӛлігін ерекшелеу үшін Text (Мәтін) сайманын таңдап алыңыз. 

Жекелеген сӛзді жылдам ерекшелеу үшін тышқанды екі рет шертіңіз. Мәтіндік 

блоктың бәрін белгілеу үшін тышқан батырмасын үш рет шертіңіз. 

Келтірілген әдістердің бірін пайдаланыңыз: 

- қасиеттер панеліндегі ашылатын Font List (Қаріптер тізімі) тізімінен қажет 

қаріпті таңдаңыз (143-сурет). 

 

                                          
 

                                            143-сурет 

- Text → Format Text (Мәтін → Мәтінді форматтау) меню командаларын 

орындаңыз немесе Ctrl + T пернелерінің комбинациясын басыңыз. Экранда 

Format Text диалогтық терезесі пайда болады. Character (Символ) бетшесінің 

ашылатын Font (Қаріп) тізімінен қажет қаріпті таңдап (144-сурет), Ok 

батырмасын шертіңіз. Таңдап алынған мәтіндік объектінің қаріпі ӛзгереді. 
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                                                      144-сурет 

 

Қаріп көлемін өзгерту 

 Мәтіндік объектінің қаріп (шрифт) кӛлемін ӛзгерту үшін келесі әрекеттерді 

орындаңыз: 

Pick (Кӛрсеткіш) сайманының кӛмегімен мәтіндік объектіні таңдаңыз немесе 

мәтін бӛлігін ерекшелеу үшін Text (Мәтін) сайманын таңдап алыңыз. 

Жекелеген сӛзді жылдам ерекшелеу үшін тышқанды екі рет шертіңіз. Мәтіндік 

блоктың бәрін белгілеу үшін тышқан батырмасын үш рет шертіңіз. 

Келтірілген әдістердің бірін пайдаланыңыз: 

Қасиеттер панеліндегі ашылатын Font List (шрифтер тізімі) тізімінен қажетті 

кегльді таңдап алыңыз немесе енгізіңіз;   

 Text → Format Text (Мәтін → Мәтінді форматтау) меню командаларын 

орындаңыз немесе Ctrl+T пернелерінің комбинациясын пайдаланыңыз. Экранда 

Format Text диалогтық терезесі пайда болады. Character (Символ) бетшесінің 

Size (Ӛлшем) ашылатын тізімінен қажет кегльді бергеннен кейін, Ok 

батырмасын шертіңіз. Таңдап алынған мәтіннің кеглі ӛзгереді. 

 Ерекшелеудің тік және жатық маркерлерін жылжыта отырып, шрифтінің 

кӛлемін ӛзгертуге кеңес берілмейді (145-сурет). Бұл мақсат үшін тек бұрыштық 

маркерлерді пайдаланыңыз. Себебі, мұндай түрде шрифт мӛлшерін ӛзгертіп, 

мәтіндік символдардың түпнұсқалық кескіні бұрмалануы – мәтіндік    

объектілердің сыртқы түрі баспаға шығару кезінде шрифтінің аз ғана 

айырмашылықтарының әсерінен келісімді болып шықпайды. 

 

 
145-сурет 

Интерлиньяж. Қатар аралық интервал немесе интерлиньяж, кернинг сияқты 

мақсатта қолданылады, яғни бос кеңістіктің үлкен кӛлемін қысқаша мәтінмен 

толтыру (146-сурет).  
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146-сурет 

 

Кернинг сияқты, интерлиньяжды бірнеше әдіспен орнатуға болады.  

 Интерлиньяжды жылдам ӛзгерту үшін, Shape (Форма) сайманымен шерту 

арқылы, қажет мәтіндік объектіні ерекшелеп алыңыз. Объектіні тӛменгі 

бұрышында екі тілсызық пайда болады (147-сурет). Сол жақ бұрышта 

орналасқан тілсызықты шертіп, қатар аралық қашықтықты ұлғайту немесе 

кішірейту үшін, оны тігінен жылжытыңыз. 
 

                     
147-сурет 

 

Format Text диалогтық терезесінде интерлиньяжды ӛзгерту үшін: 

1. Pick сайманымен қажетті мәтіндік объектіні немесе мәтін бӛлігін таңдап 

алыңыз. 

2. Text → Format Text меню командаларын орындаңыз немесе Ctrl+T 

пернелерінің комбинацияларын басыңыз. 

3. Пайда болған Format Text диалогтық терезеде Paragraph (Абзац) бетшесінде 

шертіңіз. Line (Қатар) мәтіндік ауданына, символ биіктігіне пайыздық қатынас 

түріндегі немесе пункт мәндері ретінде қатар аралық қашықтықты енгізіңіз. 

Интерлиньяжды баптау жұмысын аяқтау үшін Ok батырмасын басыңыз. 

Қисық бойлай мәтін 

Қисық бойлай мәтін эффектісін тек қана жолдық мәтінмен орналастыруға 

болады. Қисық бойлай мәтін қою үшін келесі әрекеттерді орындаңыз: 

1. Кез келген сызбаны  құралын пайдалана отырып, сызыңыз. 

2.  құралын таңдаңыз 

3. Тышқан курсорын сызбаның қасына жақындатсаңыз курсорыңыз  

мынадай күйге айналады. Сол жағдайда курсорыңызды басып қалыңыз. 
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4. Енді тиісті мәтініңізді теріңіз. 

 

 

                                     

 

 

 

 

 Ал егер де қисық бойлай мәтінді кез келген фигураның, эллипстің не 

тікбұрыштың ішкі бетіне жазғыңыз келсе, ол үшін пішімдеу тақтасын қосып, 

сол тақтаның ішінен керекті командаларды орындап, ӛзгерістерді енгізуіңізге 

болады. 

  Мәтінді шеңбер бойына айналдыра жазу үшін келесі әрекеттерді орындаңыз: 

1.  Тышқанды тұйық объектінің немесе ашық пішіннің ішіне орналастырыңыз, 

кӛрсеткіш үлкен қара тілсызық түріне айналады. 

2. Екі объектінің арасында байланыс жасау үшін, тышқанды шертіңіз. 

 

            
 

Практикалық тапсырма №4. Әйнектің сынығын жасау 

 Corel Draw графикалық редакторын іске қосып, кез-келген суретті 

импорттаймыз: Файл → Импорт командасы арқылы (148-сурет).                                                                                                                                                                                                                                                                                                                                                                                                                                                                           

Импортталған суреттің үстіне Bezier (Кривая Безье) инструментінің кӛмегімен 

үшбұрыш сызамыз (149-сурет). 

 

 

 

 

 

 

 

 

 

                       148-сурет                        149-сурет 

 

Сызылған үшбұрыштан әйнектің сынығын жасаймыз. 

 Pick (Выбор) құрал-сайманының кӛмегімен үшбұрышты белгілеп: Effect → 

Extrude → Edit (Эффекты → Экструзия → Изменить) командасының кӛмегімен 

келесі параметрлерді беріңдер (150-сурет). 

Жоғарыдағы параметрлер берілсе, онда Apply батырмасын басыңыз. 
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Pick (Выбор) құрал-сайманының кӛмегімен үшбұрышты белгілеп: Arrange → 

Break Extrude Group Apart (Расположение → Разделить группу экструзии). 

Нәтижесінде үшбұрыш ӛзінің кӛлемінен бӛлектенеді, бірақ бұл әрекет 

байқалмайды. 

FillTool (Заливка) құрал-сайманының кӛмегімен кӛлемді үшбұрышты бояңыз. 

Outline Tool (Обводка) құрал-сайманының ішінен No Outline (Удалить обводку) 

құрал-сайманын таңдап алыңыз, сонда кӛлемді үшбұрыштың жиегі алынады 

(151-сурет). 

 

 

 

 

 

 

 

   

 

 

 

 

                          

                           150-сурет                                     151-сурет   

 

 Pick (Выбор) құрал-сайманының кӛмегімен үшбұрышты белгілеп: Effects → 

Lens (Эффекты → Линза) командасын орындағанда Линза сұқбат терезесі 

ашылады. Оның ішінен Линзаның Magnify (Увеличение) түрін таңдап алып 

келесі параметрлерді беріңіз (152-сурет). 

Параметрлерін беріп болсаңыз, Apply басыңыз. 

Нәтижесінде тӛмендегідей әйнектің сынығы пайда болады (153-сурет). 

 

 

                                                                             

 

 

 

 

 

 

 

 

 

 

                             152-сурет                          153-сурет (нәтиже) 
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Практикалық тапсырма №5.  Жанып тұрған фитиль салу 

 Corel Draw графикалық редакторын іске қосып, Ellipse (Эллипс) құрал-

сайманын алып, бомбаның суретін саламыз. Бомбаның бір жағы шығыңқы 

болғандықтан, Rectangle (Прямоугольник) құрал-сайманын пайдаланамыз (154-

сурет). 

 

 

 

 

 

 

 

 

 

 

 

                                                           154-сурет 

 

Салынған Ellipse (Эллипс) және Rectangle (Прямоугольник) объектілерін 

белгілеп, келесі команданы орындаймыз: Arrange → Shaping → Weld 

(Расположение → Изменение формы → Объединить). Нәтижесінде екі объект 

тұтас бір объектіге ӛзгереді (155-сурет). 

 

   

 

 

 

 

 

 

 

 

 

 

 

                                                           155-сурет 

 

Пайда болған бомбаны қара түске бояймыз. 

 Бомбаның шығыңқы бӛлігіне аса кӛңіл бӛлу керек: Shape (Форма) құрал-

сайманын пайдаланып, бұрыштарын дӛңгелектейміз. 

Бомбаның кӛлемін кӛрсету үшін, Ellipse (Эллипс) құрал-сайманының кӛмегімен 

овал салып, оны сұр түске бояймыз (156-сурет). 

Овал мен бомбаны біріктіреміз. 

 Basic Shape (Простые формы) құрал-сайманын пайдаланып, жұлдызша 

саламыз (157-сурет). Жұлдызшаның түрін жоғарғы панельден аламыз: 
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                   156-сурет                                                   157-сурет 

                                      

Pick (Указатель) құрал-сайманын пайдаланып, жұлдыздың ұштарын ұзартамыз. 

Жұлдызды ақ түске бояп, сыртқы контурын алып тастаймыз (158-сурет). 

Interactive Transparency (Интерактивная прозрачность) құрал-сайманын 

пайдаланып, жұлдызшаға мӛлдірлік (прозрачность) эффектісін береміз (159-

сурет). 

 

 

 

 

 

 

 

   
 

                                  158-сурет                                               159-сурет 

 

Осымен бомбаны салу аяқталды, енді оның фитилін салуға кӛшейік: 

 Ол үшін Rectangle (Прямоугольник) құрал-сайманын пайдаланып, 

тіктӛртбұрыш салып, Ellipse (Эллипс) құрал-сайманының кӛмегімен екі бірдей 

овал саламыз да суретте кӛрсетілгендей орналастырамыз (160-сурет). 

Arrange → Shaping → Weld     (Расположение → Изменение формы → 

Объединить) командасының кӛмегімен осы үш фигураны біріктіріңдер. 

  Пайда болған фигураны екі рет шертіп белгілейміз де шамамен 25
0 

 бұрышқа 

бұрамыз.  

 

 

 

 

 

 

                          

 

                                                         160-сурет 
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Pick (Указатель) құрал-сайманының кӛмегімен фигураны белгілеп алып, Fill 

(Заливка) құрал-сайманының ішінен Fountain Fill (Градиентная заливка) түрін 

таңдап алып, ашылған сұхбат терезеде тӛмендегі параметрлерді енгіземіз: Type 

(Тип заливки) – Radial (Радиальный) деп алып, негізгі түс ретінде сұр түсті 

беріңіз (161-сурет). 

 

 

 

 

 

 

 

 

 

 

                                                     161-сурет 

 

  Боялған фигураның кӛшірмесін жасау керек. Ол үшін: фигураны белгілеп, 

тышқанның сол жағымен орнын ауыстырып, қоятын кезде тышқанның оң 

жағын басу қажет. 

Interactive Blend (Интерактивное перетекание) құрал-сайманын пайдаланып 

(162-суретте кӛрсетілгендей) фигураның жиілік санын кӛбейтеміз. 

Енді дайын болған фитиль мен бомбаны біріктіреміз, Interactive Envelope 

(Интерактивная оболочка) құрал-сайманының кӛмегімен біраз майыстырамыз 

(163-сурет). 

 Бомбамыз жанып тұрған болғандықтан, оттың суретін салу керек. Ол үшін 

бізге таныс Star Shapes (Звезды) құрал-сайманын пайдаланамыз. Осындай 

жұлдыздың екеуін салу қажет. 

Салынған жұлдыздың біреуі - үлкен және түсі - сары болу керек, ал екіншісі - 

кішірек, түсі - қызыл болу қажет және екі жұлдыздың да  сыртқы контурын 

алып тастау қажет. 

 

 

 

 

 

 

 

 

 

 

                    162-сурет                                                    163-сурет 
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 Қызыл жұлдыз сары жұлдыздың үстіңгі жағында орналасуы керек (164-

сурет). 

Interactive Blend (Интерактивное перетекание) құрал-сайманын пайдаланып екі 

фигураның арасына ағым (перетекание) жүргіземіз (165-сурет). 

 

 

 

 

 

 

 

 

  

 

 

                               164-сурет                                                      165-сурет 
 

 Соңғы кезең барлық объектілерді біріктіру керек. Ол үшін барлығын 

белгілеп: Компоновать → Группа командасын орындау қажет. (165-сурет) 

 

 

 

 

 

 

 

 

                                                 165-сурет (нәтиже). 

 

Практикалық тапсырма №6. Жанып тұрған майшамды жасау 

 CorelDraw графикалық редакторын іске қосып, Basic Shapes (Базовые 

фигуры) құрал-сайманының ішінен, тамшыға ұқсайтын фигураны таңдап алып, 

бұл фигураның екі кӛшірмесін жасау қажет. Бірі-үлкен және түсі - сары, ал 

екіншісі - кіші, түсі - қызыл болу қажет. Қызыл түсті тамшыны сары түсті 

тамшының үстіңгі бетіне орналастырамыз (166-сурет). Пайда болған 

фигуралардың сыртқы контурын алып тастаймыз (167-сурет). 
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                        166-сурет                                                       167-сурет 

 

Interactive Blend (Интерактивное перетекание) құрал-сайманын пайдаланып, екі 

объектінің арасына ағым (перетекание) жүргіземіз (168-сурет). 

Оттың суретін салып болдық, енді майшамның фитилін  салу қажет. Ол үшін 

тӛртбұрыш құрал-сайманын пайдаланып, оны градиенттік бояумен (Gradient 

Fill) бояу қажет.  

 

 

                                                                                                                                                                   

               

 

 

 

 

 

 

 

                                                     168-сурет 

 

Салынған от пен фитильді біріктіру қажет: Компоновать → Группа 

командасының кӛмегімен. 

Енді майшамның ӛзін салу қажет. Ол үшін параллель  екі овал саламыз да, 

Fountain Fill (Градиентная заливка) құрал-сайманын таңдап алып, 169-суретте 

кӛрсетілген параметрлерді енгіземіз: (а - тӛменгі овалдың параметрі, б - үстіңгі 

овалдың параметрі). 

 

 

 

 

 

 

 

 

 

                                                         169-сурет    
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 Interactive Blend (Интерактивное перетекание) құрал-сайманын пайдаланып 

тӛменгі овалдан жоғарғы овалға ағым (перетекание) жүргіземіз (170-сурет). 

Ағым қадамын 120 деп беріңіз. 

Соңғы кезең барлық объектілерді біріктіру керек. Ол үшін барлығын белгілеп: 

Компоновать → Группа командасын орындау қажет (171-сурет). 

 

 

 

 

 

 

 

 

                              170-сурет                      171-сурет (нәтиже). 

                                                                                                                                                        

Практикалық тапсырма №7. Ұлғайтқыш лупа жасау 

 Corel Draw графикалық редакторын іске қосып, Basic Shapes (Базовые 

фигуры) құрал-сайманының кӛмегімен лупаның корпусын жасаймыз. Ол үшін 

ең алдымен, Basic Shapes (Базовые фигуры) құрал-сайманының ішінен, 

трапецияға ұқсайтын фигураны таңдап алып, лупаның тұтқасын және лупаның 

басқы бӛлігін  жасау керек (172-сурет) 

Pick (Указатель) құрал-сайманының кӛмегімен екі объектіні де белгілеп     

алып, келесі команданы орындаңыз: Arrange → Shaping → Weld (Расположение 

→ Изменение формы → Объединить). Нәтижесінде осы екі фигура бірігеді 

(173-сурет). 

 

 

 

 

 

 

 

  

 

 

 

                      172-сурет                                               173-сурет 

 

Пайда болған объектіні бояу керек. Ол үшін: Pattern Fill Dialog (Диалоговое 

окно узорной заливки) құрал-сайманын алып, келесі параметрлерді беру керек 

(173-сурет). 
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                                                               173-сурет 

 

 Пайда болған объектіге кӛлем беру керек. Ол үшін: Window → Dockers → 

Extrude (Окно → Докеры → Выдавливания), суретте кӛрсетілгендей 

параметрлерді береміз (174-сурет).  

 Параметрлер беріліп болса Applay (Применить) батырмасын басу қажет. 

Енді лупаның әйнегінің ұлғаюын келтіру қажет. Ол үшін Ellipse (Эллипс) 

құрал-сайманын алып екі дӛңгелек сызамыз.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                         174-сурет 

 

 Сызылған дӛңгелектің бірін белгілеп алып, Window → Dockers → Lens → 

Manify (Окно → Пристыковываемые окна → Линза → Увелечение) 

командасын орындап, келесі параметрлерді береміз (175-сурет). Сызылған 

дӛңгелектің екіншісін белгілеп алып, Window → Dockers → Lens → Fish eye 

(Окно → Пристыковываемые окна → Линза → Рыбый глаз) командасын 

орындап, келесі параметрлерді береміз (176-сурет).  

 



87 

                                                                                

 

 

 

 

 

 

 

 

 

 

 

 

                    175-сурет                                           176-сурет 

 

 Бірінші дӛңгелектің үстінгі жағына екіншісін орналастырып, екі объектіні 

біріктіріңіз (группировка). Дайын болған әйнекті лупаға орналастырып, бүкіл 

объектіні біріктіріңіз (177-сурет. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                                                   177-сурет (нәтиже) 

 

Практикалық тапсырма №8. Шынжыр жасау 

 CorelDraw графикалық редакторын іске қосып, Rectangle   (Прямоугольник) 

құрал-сайманын алып, тӛртбұрыш салыңыз. Оның бұрыштарын  Shape (Форма) 

құрал-сайманымен дӛңгелектеңіз (178-сурет) 

 

 

 

 

 

 

178-сурет 
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Пайда болған фигураның кӛшірмесін жасаңыз. 

Бірінші фигураны белгілеп, Outline (Обводка) құрал-сайманын алып, жиегінің 

қалыңдығын 24 Point Outline (24 пункт) деп беріңіз. 

Енді фигураның түсін алып тастаңыз. Ол үшін Fill (Заливка) құрал-сайманынан  

No Fill (Удалить обводку) таңдап алыңыз  (179-сурет). 

Шынжыр “алтын” болғандықтан, фигураны белгілеп, Outline (Обводка) құрал-

сайманынан Outline Color Dialog (Диалоговое окно цвета обводки) таңдап 

алыңыз. Ашылған сұхбат терезеде келесі параметрлерді беріңіз: С 5; М 2; У 63; 

К 8  (180-сурет). 

Енді екінші фигураны алып, оны бірінші фигураның үстіне орналастырыңыз да, 

Порядок → На передний план. 

 

 

 

 

 

 

 

 

 

 

 

 

                          

                         179-сурет                                                  180-сурет  

 

 Екінші фигураны белгілеп, ақ түс беріп, жиегінің мӛлшерін 1-пункт-қа 

ӛзгертіңіз (181-сурет). 

Екі объектіні де белгілеп, Interactive Blend (Интерактивное перетекание) құрал-

сайманын пайдаланып объектіге кӛлем беріңіз (182-сурет). Объектілерді 

біріктіріңіз (группировать). 

 

 

 

 

 

 

 

 
 

                          181-сурет                                       182-сурет 

                                                                               

 Енді Bezier (Кривая безье) құрал-сайманын пайдаланып, сызық сызыңыз. Ғ12 

клавишасын басып, Outline Pen (Форма обводки) сұхбат терезесін шақырып, 

келесі параметрлерді беріңіз: Color (Цвет) - сары,  Width (Ширина) - 8,467 мм 
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кіші (максималды) мәнін беріңіз.  Line Caps (Оформление конечных точек 

линий) деген жерде ұштары дӛңгелектенген типті таңдаңыз (183-сурет). 

 Бірінші жағдайдағыдай кӛшірмені құрылған фигураның үстіңгі жағына 

орналастырып, ақ түске бояп, Interactive Blend (Интерактивное перетекание) 

құрал-сайманын пайдаланыңыз (184-сурет). Пайда болған объектілерді 

біріктіріңіз. 

 

 

 

 

 

 

 

 

 

 

 

                                                         

                                                        183-сурет 

 

 Енді шынжыр салуға кӛшеміз. Ол үшін ең алдымен Freehand (Кривая) 

құрал-сайманын пайдаланып қисық сызу керек. 

Салынған қисықтың кӛшірмесін алу керек. 

Қисықтың басы мен соңына дайын болған шынжырдың бӛліктерін орналастыру 

қажет (185-сурет). 

 

 

 

 

 

 

                     184-сурет                                                        185-сурет 

 

        Interactive Blend (Интерактивное перетекание) құрал-сайманының 

кӛмегімен басы мен соңын біріктіріңіз. 

Құрал-сайманының қасиетін ӛзгерту қатарында Path (Траектоия) батырмасынан 

– New Path (Создать траекторию), Micellaneous Blend Option (Дополнительные 

параметры перетекания) деген жерден – Rotate Points Object (Поворачивать все 

объекты) және Blend Along Fill Path (Вдоль всей траектории) командаларын 

белгілеңіз. 

Жанынан кӛрінетін бӛлігіне де осы операцияны қолданыңыз және де 

шынжырдың бӛліктерінің қайталануын 2 есеге азайтыңыз (186-сурет). 

Шынжырдың бӛліктерін біріктіріңіз (187-сурет). 
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                         186-сурет                                           187-сурет (нәтиже) 

 

Практикалық тапсырма №9. Шық түйіршігін жасау 

 Corel Draw графикалық редакторын іске қосып, кез-келген суретті 

импорттаймыз: Файл → Импорт командасы арқылы  (188-сурет). 

Ctrl+C және Ctrl+V пернелері арқылы суреттің кӛшірмесін алыңыз. 

Нәтижесінде бір суреттен екі дана болу қажет.  

Basic Shapes (Базовые фигуры) құрал-сайманын алып, шық түйіршігіне 

ұқсайтын форманы таңдап, шықтың суретін салыңыз (189-сурет) 

 

 

                     

 

 

 

 

 

 

                               188-сурет                                                 189-сурет 

 

Екінші пункте кӛрсетілгендей «шықтың» кӛшірмесін алыңыз. 

 «Шықтың» бір кӛшірмесін суреттің үстіне орналастырып, келесі команданы 

орындаңыз: Effects → Power Clip → Place Inside Container (Эффекты → 

Фигурная обрезка → Поместить в контейнер). Пайда болған бағдаршамен 

фигураны белгілеңіз, нәтижесінде сурет фигураның ішіне енеді (190-сурет).  

 Бұл әрекетті жасау себебіміз, гүлге «шық» түйіршігінің ар жағынан 

қараймыз. Ондай эффектіні жасау үшін Sphere (Сфера) растрлы фильтрі 

қолданылады: Bitmaps → 3D Effects → Sphere (Точечная графика → 

Трехмерные эффекты → Сфера). Қажет ӛзгертулер кӛрсетілген (191-сурет). 

            

                           

 

 

 

 

 

 

                                                190-сурет 
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                                                             191-сурет 

 

 Шық түйіршігінің жиегін алып тастаңыз. Ол үшін Без контура құрал-

сайманы пайдаланылады (192-сурет). 

 

 

 

 

                       

 

                        

                      192-сурет 

 

 

«Шық» түйіршігін жасаудың бірінші кезеңі аяқталды. 

«Шық» түйіршігінің екінші кӛшірмесін алып, Interactive Fill (Интерактивная 

заливка) құрал-сайманын таңдап алып, 193-суретте кӛрсетілгендей ӛзгертулерін 

енгізіңіз де, екінші «шық» түйіршігінің кӛшірмесін біріншісінің үстіне 

орналастырыңыз. Егер екінші түйіршік кӛрінбей қалатындай болса, оны 

белгілеп алып, келесі командалар тізбегін орныдаңыз: түйіршікті белгілеп 

алып, тышқанның оң жағын басып, Oder → To Front  (Порядок → На перед) 

орындаңыз. 

 Interactive Transparency (Интерактивная прозрачность) құрал-сайманын 

таңдап алып келесі параметрлерді беріңіз (194-сурет). 

 

 

 

 

                                 

 

 

 

 

 

 

                   193-сурет                                                      194-сурет 
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Соңында барлық объектілерді белгілеп алып, тышқанның оң жағын басып, 

біріктіру (Группа) командасын таңдап алыңыз. Нәтижесі 195-суретте 

кӛрсетілген.  

 

  

                                        

 

 

 

 

 

 

                                                   

                                                   195-сурет (нәтиже) 

 

 Практикалық тапсырма №10. Парақтары ашылып жатқан кітап жасау 

 Біз бұл мысалда ашулы тұрған кітаптың суретін саламыз. Бұл мысалдың 

қиындығы кітаптың беттері бір-бірінен бӛлек болуы қажет. Мұны қолмен 

салуға болады, бірақ оған кӛп уақыт кетеді. Бірақ біз бұл мысалда оны оңай 

салу жолын келтірейік. Corel Draw графикалық редакторын іске қосып, Star 

Shapes (Звезды) құрал–сайманын таңдап алып, 32-бұрышты жұлдыздың суретін 

салыңыз (196-сурет). 

 Бұл құрал-сайманның параметрін суретте кӛрсетілгендей беріңіз, яғни Angle 

of Rotation (Угол поворота) батырмасына бұрылу бұрышы ретінде 20
о 

деп беру 

нәтижесінде фигураны кӛбейтеміз (197-сурет). 

 

 

 

 
 

 

              

 

 

 

 

 

 

      

                        196-сурет                                            197-сурет 

 

40, 60 және 80
о 
мәндерін беру арқылы осы операцияны қайталаңыз. 

Pick (Выбор) құрал-сайманының кӛмегімен барлық объектілерді белгілеп 

біріктіріңіз (198-сурет) 
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 Пайда болған фигураға ашылған кітап парағының эффектілерін жасайық. Ол 

үшін Eraser (Ластик) құрал-сайманын таңдап алып, артығын ӛшіріңіз (199-

сурет) 

 

 

                

 

 

 

 

 

                   

                     198-сурет                                                       199-сурет 

 

 Енді кітаптің мұқабасын жасауға кірісейік. Ол үшін құрал-саймандардың бір 

тобын пайдалануға болады. Бірақ жұмыстың кӛп бӛлігі қолмен жасалады. 

Bezier (Кривая безье) құрал-сайманын алып, суретте кӛрсетілгендей қисық 

сызыңыз (200-сурет). 

                    

 

 

 

 

 

 

                                                       200-сурет 

 

Салынған мұқабаны бояңыз. Мысалы, қоңыр түске. 

 Енді бейнеге кӛлем беру керек. Ол үшін Interactive Extrude (Интерактивный 

объем) құрал-сайманын таңдап алып, фронтальды және артқы бӛлігі сәйкес 

келетіндей етіп параметрлерін беру қажет (201-сурет). 

 

 

                                                       

 

 

 

 

 

 

                                                    201-сурет 

 

 Бұл мысалды орындау кезінде объектіге жарық кӛзін берсек артық емес, 

параметрі 202-суретте кӛрсетілген.  

Жұмыс аяқталды, нәтиже тӛменде 203-суретте кӛрсетілген. 
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              202-сурет                                             203-сурет (нәтиже) 

 

Практикалық тапсырма №11. Windows жұмыс үстеліне батырма (значок) 

жасау 

Батырма жасау мысалы ретінде қыздың суретін алдық (204-сурет). 

Осы күйінде қажет форматқа экспорттауға болар еді, бірақ батырманың пішіні 

қыздың контурын қайталасын, ал фон мӛлдір болсын. Сол үшін Eraser (Ластик) 

құрал-сайманын пайдаланып, артық жерлерді ӛшіріп тастаңыз (205-сурет) 

 

 

 

 

 

 

 

 

 

 

 

                      204-сурет                                               205-сурет 

 

Алдын-ала Eraser (Ластик) құрал-сайманының параметрлерін беріңіз (206-

сурет). 

 

 

                                   

                                                        206-сурет 

 

Келесі қадам жұмыстың негізі болып табылады. Ол үшін File → Export (Файл 

→ Экспорт) командасын орындап, экспорттау үшін *.ico форматын алыңыз. 

Бірінші ашылған сұхбат терезеде ешқандай ӛзгеріс енгізбей, параметрлерін сол 
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қалпында қалдырамыз. Ал келесі терезеде суретте кӛрсетілгендей 

параметрлерін береміз (207-сурет) 

Ондағы Palette (Палитра) тізіміне Adaptive (Адаптивная) вариантын таңдап 

алған дұрыс. Dithering (Настройка растра) параматрін ӛзгертпеген жӛн. Ӛйткені 

біздің жағдайда ол нәтижеге ешқандай ӛзгеріс келтірмейді. Colors (Количество 

цветов) бетінде ең үлкен мән (максималды) 256-ны беруге болады. Бұл мәнді 

батырманың файл мӛлшеріне шектеу қойылса ғана, азайтуға болады. Осымен 

мысал дайын болып жұмыс үстеліне шығарылды (208-сурет). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                        

                          207-сурет                                           208-сурет (нәтиже) 

 

Практикалық тапсырма №12. Жердің көлемді суретін салу 

Ellipse (Эллипс) құрал-сайманын таңдап алып, екі бірдей дӛңгелек салыңыз 

(209-сурет). 

 

                          

 

 

                                                 209-сурет 

 

Дӛңгелектің бірін белгілеп, Texture Fill (Текстурная заливка) құрал-сайманын 

таңдап алсаңыз, келесі сұхбат терезе ашылады (210-сурет). 
 

 

 

 

 

 

 



96 

                              

 

 

 

 

 

 

 

 

 

 

                                                             210-сурет 

 

 Ашылған сұхбат терезеде Texture Library (Библеотека текстур) 

кітапханасынан Styles кітапханасын, ал Texture List (Список текстур) 

кітапханасынан Satellite Photography (Спутниковая фотография) кітапханасын 

таңдап, параметрлерін беріңіз. Сонда келесідей Жер пайда болады (211-сурет). 

 

 

                                                  

 

 

 

 

 

 

 
                                                  

                                                      211-сурет 

 

 Енді планетамызға кӛлем беру жұмысына кірісейік. Ол үшін екінші 

дӛңгелекті белгілеп, Fountain Fill Dialog (Диалоговое окно градиентной 

заливки) құрал-сайманын таңдап алып, келесі параметрлерді беріңіз, яғни типін 

радиалды, қарадан-аққа, ортасы сол жақ жоғарғы бұрышқа ығысу деп береміз 

(212-сурет). 

 

 

                         

 

 

 

 

 

 

                                                       212-сурет 
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 Екінші дӛңгелекті бірінші дӛңгелектің үстіңгі жағына орналастырамыз. 

Градиентті боялған дӛңгелекті белгілеп, оған Interactive Transperency 

(Интерактивная прозрачность) құрал-сайманын пайдаланып мӛлдірлеу 

эффектісін қолданамыз. Параметрі тӛменде кӛрсетілген (213-сурет). 

 

 
                                                     

                                               213-сурет 

 

Нәтижесінде жер екінші дӛңгелектің бетінен кӛрінеді (214-сурет). 

Енді бұл дайын болған кӛлемді объектіге қара фон, яғни түнгі аспан мен 

жұлдыздар жетіспейді. Оны ӛздеріңіз салыңыздар. Нәтижесі тӛменде 

кӛрсетілген (215-сурет). 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

                    214-сурет                                       215-сурет (нәтиже) 

 

Практикалық тапсырма №13. «Қанды бояу» эффектісін жасау 

 Text (Текст) құрал-сайманын таңдап алып, стандартты қаріптердің типінен 

Arial Black түрін таңдап алыңыз, мӛлшерін де үлкендеу етіп алыңыз (216-

сурет). 

               

 

 

                                                      216-сурет 

 Shape (Форма) құрал-сайманының кӛмегімен қанның бейнесін жасау қажет. 

Бірақ бұл әрекетті жасамастан бұрын мәтінді «қисық» түріне келтіріп алыңыз. 

Ол үшін Pick (Выбор) құрал-сайманын таңдап алып, мәтінге тышқанның оң жақ 

батырмасын басып, Convert To Curves (Перевести в кривые) командасын таңдап 

алыңыз (217-сурет). 

 



98 

 

 

 

 

                                   

 

 

 

 

 

 

                                                              217-сурет 

 

Shape (Форма) құрал-сайманын таңдап алып, ағылған әріп эффектісін келтіріңіз 

(218-сурет). 

 

 

                               

 

 

 

 

                                                           218-сурет 

 

Енді мәтінді бояуға кірісейік. Параметрін тӛменде кӛрсетілген бойынша 

береміз (219-сурет). 

 

 

                                

 

 

 

 

 

 

 

 
 

                                                         219-сурет 

 

 Interactive Extrude (Интерактивный псевдообъем) құрал-сайманын таңдап 

алып, Lighting (Освещение) батырмасын басып, бірінші шамның суретін 

белгілеңіз. Параметрі тӛменде кӛрсетілген (220-сурет). 
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                                                         220-сурет  

 

Келесі Bevels (Скосы) батырмасын басып, Use Bevel (Использовать скос) 

батырмасына жалауша қойыңыз да, тӛмендегі параметрлерді енгізіңіз (221-

сурет). 

 

  

                                         

 

 

 

 

 

 

 

 

                                                         221-сурет 

 

Жұмыстың соңғы кезеңі кӛлеңке жасау болып табылады. Ол үшін объектілерді 

топтаңыз да, Interactive DropShadow (Интерактивная тень) құрал-сайманын 

келесі параметрлерімен беріңіз (222-сурет). 

 

 

                       

 

 

 

 

 

 

                                                      222-сурет 
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Жұмыс аяқталды, нәтижесі тӛменде 223-суретте кӛрсетілген. 

 

 

                                                        

 

 

 

 

 

 

 

 

   

                                                 223-сурет (нәтиже) 

 

Практикалық тапсырма №14. Мәтінмен жұмыс жасау 
 

Text (Текст) құрал-сайманын таңдап алып - a_Concepto TitulBroken қаріп түрін 

және мӛлшерін 72 пункт етіп алыңыз (224-сурет). 
 

                        
                                                        224-сурет 
 

Shape(Форма) құрал-сайманын таңдап алып, мәтіннің ұштарын ұзартамыз. Ол 

үшін ең алдымен мәтінді Pick (Выбор) құрал-сайманымен белгілеп, мәтінге 

тышқанның оң жақ батырмасын басып, Convert To Curves (Перевести в кривые) 

командасын таңдап алыңыз. 

Енді Shape(Форма) құрал-сайманымен жұмыс істей беруге болады. Нәтижесі  

тӛменде кӛрсетілген (225-сурет). 

                   
                                                                225-сурет 

 

Енді бояуға кӛшейік. Бояудың ашық кӛк түсін таңдап алу керек. 

Texture Fill Dialog (Диалоговое окно текстурной заливки) құрал-сайманын 

алып, ашылған сұхбат терезеде текстура кітапханасынан – Samples 6, 
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текстураның ішінен -  Oatmeal түрін таңдап алыңыз (226-сурет). Нәтижесі 227-

суретте кӛрсетілген. 

 

 

 

 

                                                              

 

 

 

 

 

                                                         

 

                      226-сурет                                                          227-сурет 

 

Жазуға кӛлеңке қосу арқылы, мәтіннің тереңдігін береміз. Ол үшін Interactive 

DropShadow (Интерактивная тень) құрал-сайманын алып, кӛлеңке жүргізіңіз 

және  кӛлеңкенің түсін кӛгілдір түске ӛзгертіңіз (228-сурет). 

             

                                                                   

 

 

 

 

 

 

                                                             228-сурет 

 

Эффект жасаудың негізгі кезеңі орындалды. Мәтіннің тереңдігі мен жазудың 

жылтырлығын беру қажет. 

Ендігі жұмыс осы мәтінді мұзға айналдыру болып табылады. Ол үшін 

Interactive Distortion (Интерактивная деформация) құрал-сайманын таңдап 

алып, мәтінді белгілеп, біраз жоғарыға тартыңыз (229-сурет). 

 

                       
                                                                 

                                                         229-сурет 

 

  Енді күнге шағылысқанда мұзда пайда болатын сәуле эффектісін келтіру 

керек. Ол үшін Polygon (Многоугольник) құрал-сайманын алып, жұлдызша 
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салыңыз да ұштарын Pick (Выбор) құрал-сайманының кӛмегімен ұзартыңыз 

(230-сурет). 

 Дайын болған объектіні белгілеп, Arrange → Shaping → Weld (Расположение 

→ Изменение формы → Объеденить) командасын орындап объектілерді  

біріктіріңіз (231-сурет). 

 Объектіні ашық кӛк түске бояп, сыртқы контурын Outline (Обводка) құрал-

сайманының ішінен No Outline(Удалить обводку) құрал-сайманының кӛмегімен 

алып тастаңыз. 

 Сәулеге тереңдік беру үшін Interactive DropShadow (Интерактивная тень) 

және Interactive Transparency (Интерактивная прозрачность) құрал –

саймандарын қолданыңыз (232-сурет). 

 

 

 

 

 

 

 

 

 

                                                                      

                       230-сурет.                                           231-сурет            232-сурет 

                   

 Дайын болған сәуленің бірнеше кӛшірмесін алып мәтіннің әрбір жеріне 

орналастырыңыз (233-сурет). 

 

                                                          

 

 

 

 

 

 

 

 

 

                                             

                                               233-сурет (нәтиже). 
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4. MACROMEDІA FLASH ПРОГРАММАСЫНДА ОРЫНДАЛАТЫН 

ПРАКТИКАЛЫҚ ТАПСЫРМАЛАР 

Практикалық тапсырма №1. Мәтінмен жұмыс істеу 

 Macromedіa Flash программасы фильмге мәтіндік элементті қойып, 

қасиеттерін беруге және жӛндеуге мүмкіндік береді. Баспа жүйелеріне және 

иллюстрациялар құруға арналған басқа да программалар тәрізді Flash 

ортасында сол бетте орналасқан мәтінге қатысты  мәтінді беттің кез келген 

жеріне орналастыруға болады. Ол үшін кестелер немесе ұяшықтар құрудың 

қажеті жоқ. Сондай-ақ, мәтіннің ӛлшемін ӛзгерту, бұру және бұрмалау 

мүмкіндіктері қарастырылған. Енгізілген мәтіннің түсін, стилін ӛзгертіп, оны 

туралауға да болады. Графикалық объект сияқты мәтін әр түрлі формада болуы 

мүмкін. 

 Мәтінді графикалық объектіге түрлендіріп, оған векторлық графиканың 

барлық мүмкіндіктерін қолдануға болады. Сонымен қатар, мәтін анимациялық 

объект те бола алады. Flash ортасында мәтіннің үш түрі құрылады: статикалық 

мәтін; динамикалық мәтін; енгізу ӛрісі. 

Мәтіннің типі объектілер инспекторы терезесінің кӛмегімен беріледі. Оны 

экранға шақыру үшін Window-Properties командасын орындау қажет. 

Нәтижесінде «қасиеттер» терезесі (234-сурет) ашылады.  

 

 
      

234-сурет. Қасиеттер терезесі 

 

 Text type ашылатын тізімінің опциялары  мәтіннің типін анықтауға мүмкіндік 

береді. Ал, Properties панелі мәтіннің әрбір түріне қажетті параметрлер 

жиынтығын береді.  

 

Мәтін енгізу 

Алдымен Macromedia Flash бағдарламасын іске қосамыз: 

Пуск → Программы → Мacromedia → Macromedia  Flash 8.  

Пайда болған терезедегі Create New (Құру) топтамасына кіретін тізімдерден 

Flash Document (Flash құжат) тізіміне меңзерді (тышқан кӛрсеткішін) апарып, 

тышқанның сол жақ батырмасын басыңыз.   

Нәтижесінде экранда жаңа фильм терезесі ашылады (235-сурет). 
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235-сурет. Macromedia Flash программасының жұмыс алаңы 

 Flash фильмінің кадрына мәтін енгізу барысында мәтіндік блок құрылады. 

Статикалық мәтін екі түрлі жолмен енгізіледі: кӛп жолдық блок және ені 

шектеулі блок. Мәтінді енгізу үшін: 

Text (Мәтін, Текст)   құралы қолданылады.  

 

Көп жолдық блокқа  мәтін енгізу 

 

1.  - құралын таңдаңыз. Курсордың түрі 
+
А түріне айналады.  

2. Курсорды кадр алаңына орналастырып, мәтіндік блок басталатын орынды 

курсормен белгілеңіз. Нәтижесінде кӛп жолдық мәтіндік блок құрылады. 

3. Мәтін енгізіңіз. Жаңа символдардың қосылуына қарай мәтіндік блок кеңейе 

береді. Enter клавишын басқаннан кейін ғана курсор жаңа жолға кӛшеді. 

 

Ені шектеулі блокқа мәтін енгізу 

1.  - құралын таңдаңыз.  

2. Курсорды кадр алаңына әкеліп, мәтіндік блоктың енін беріңіз. Ол 

тышқанның сол жақ батырмасын басып тұрып, курсорды кӛлденең бағытта 

жылжытыңыз. Нәтижесінде ені шектеулі мәтіндік блок құрылады.  

3. Мәтін енгізіңіз. Енгізілген мәтін оң жақ шекараға жеткенде курсор автоматты 

түрде жаңа жолға кӛшеді. Бұдан блоктың ені ӛзгермейді.  

4. Қажетіне қарай мәтіндік блоктың енін ӛзгертуге болады. Ол үшін маркерді 

кӛлденеңінен оңға немесе солға қарай жылжытыңыз. Нәтижесінде блок 

ішіндегі мәтіннің орналасуы ӛзгереді.  
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Мәтінді форматтау 

 Мәтінді форматтау үшін объектілер инспекторы терезесінің командалары 

пайдаланылады. 

 Мәтінді енгізу үшін тышқанның сол жақ батырмасын басып,  пайда болған 

мәтіндік блоктың ішіне мәтін енгіземіз.  

Aroow Tool (Курсор) –  құралының кӛмегімен мәтінді ерекшелейміз. Мәтінді 

баптаудың негізгі құралы - баптау құралы болып табылады.  

Font (Өлшем, Шрифт)  тізімінде мәтін шрифті енгізіледі.  

 Мәтін блогының ӛлшемін ӛзгерту үшін, келесі командаларын орындау керек:  

Modіfy (Өзгерту, Изменить)  

Трансформация (Трансформация, Transform)   

Вращение и скос (Айналу және қисаю, Rotate and Skew) 

Блоктың қисаюын жасау үшін курсорды қоршаудың шетіне жақындатып, 

қалауымызша ӛзгертеміз. Сол кезде блоктың пропорциясы ӛзгереді. 

 

Мәтін блогын таңдау 

1.  - құралын таңдаңыз. 

2. Мәтіннің кез келген әрібін тышқанмен белгілеңіз. Мәтін сол мәтіндік 

блоктың қоршауымен бірдей қоршаумен қоршалады (236-сурет).  

 

 
 

236-сурет. Мәтін блогын таңдау 

 

Символдарды форматтау 

 Символдарды форматтаудың негізгі құралы объектілер инспекторы терезесі 

болып табылады.  
 

 

 

 
 

 

237-сурет. Қасиеттер терезесі 

 

Шрифт гарнитурасы Шрифт өлшемі 

Трекинг Жоғарғы-төменгі индекстер Гиперсілтеме адресі Кернинг 
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 - шрифтер тізімі. Бұл тізім шрифтер гарнитурасын таңдауға арналған. 

Батырманы басқанда компьютерде орнатылған шрифтер тізімін ашады. 

Курсорды шрифт атын келтіргенде шрифтің қандай екенін кӛруге болады. 

Шрифт тышқанның батырмасын басу арқылы таңдалады.  

 - шрифт ӛлшемі (кегль). Бұл параметрдің кӛмегімен шрифт ӛлшемі 

пунктпен беріледі (1 пункт =1/72 дюйм).   

 - стандартты түс таңдауға арналған батырма.  Бұл батырманың кӛмегімен 

шрифт түсі таңдалады.  

 - бұл батырма таңдалғанда, шрифтің ені қалыңдай түседі. 

 - курсивпен жазу батырмасы. Бұл батырма таңдалғанда шрифт символдары 

қиғашталып жазылады. 

 - трекинг. Бұл параметр әріптердің арақашықтығын анықтайды. Оң мән 

әріптердің арақашықтығын үлкейтіп, теріс мән кішірейтеді.                     

 - бұл тізім мәтін символдарын арнайы индекспен жазуға мүмкіндік 

береді.  

 - URL ӛрісі. Егер ӛріске WEB-бетінің адресі немесе файл енгізілсе, 

онда бұл мәтін гиперсілтемеге айналады.  Іnternet-ке Flash-фильмін 

жариялағаннан кейін осы мәтін арқылы пайдаланушының сайтын белгілегенде 

WEB-беті немесе файл шақырылады.  

Мәтіндік объектіге растрлы немесе градиенттті бояу үшін оны графикалық 

элементке ӛзгерту керек:  

Изменить (Өзгерту, Modіfy) а Разбить (Бөлу, Break Apart)      Кез келген әріпті 

ерекшелейік. Ол үшін  

Микшер цвета (Түс микшері, Color Mіxer) секциясында орналасқан палитрадан 

дайын градиентті құюды таңдаймыз. 

 

Мәтінді импорттау және онымен жұмыс істеу 

 Flash-фильмінің кадрларына орналастыратын үлкен кӛлемді мәтінді осы 

программада теру міндет емес. Flash программасында орфографияны тексеру 

мүмкіндігі қарастырылмаған. Мұндай жағдайда мәтінді MS Word редакторында 

теріп, алмасу буфері арқылы оны кӛшіріп қоюға болады.  

  

Мәтінді көшіру 

1. MS Word редакторында теріп немесе осы программада терілген мәтінді 

ашыңыз. 

2. Flash-фильміне қойылатын мәтінді ерекшелеп, оны алмасу буферіне 

кӛшіріңіз (Edit – Copy (Түзету-кӛшіру, Правка -копировать)). 

3. Flash программасына ӛтіп,  - құралын таңдаңыз.  

4. Мәтіндік блок құрып, Edit-Paste (Түзету-қою, правка-вставить) командаларын 

орындаңыз. Нәтижесінде мәтіндік блокқа алмасу буферіндегі мәтін қойылады.  

Мәтінді енгізу үшін Edit-Paste Spatial (Түзету- арнайы қою, правка-специальная 

вставка) командаларының мүмкіндіктерін пайдалануға болады. Бұл команданы 
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орындағаннан кейін экранда Арнайы қою сұхбат терезесі (238-сурет) пайда 

болады. MS Word құжаты опциясын таңдағанда мәтін MS Word редакторында 

жасалған форматын сақтай отырып, кадрға қойылуға ыңғайланып, осы 

программамен байланыс орнатылады.  

Мәтіндік блок құрылып, одан кейін толықтырылғаннан кейін ол мәтінмен 

әдеттегі Flash ортасындағы графикалық объект ретінде жұмыс істеуге болады.  

 

 

 

 

 

 

 

 

 

 

                                 238-сурет. Арнайы қою терезесі 

 

Мәтінді графикалық объектіге түрлендіру 

 Мәтінге Flash технологиясындағы векторлық графиканың  мүмкіндіктерін 

қолдану үшін оны әдеттегі графикалық объектіге түрлендіру қажет. 

1. құралымен мәтінді ерекшелеңіз. 

2. Modіfy- Break Apart (Түрлендіру – Бӛлу, Модификация – Разбить) 

командасын орындаңыз. Мәтіннің әрбір символы графикалық объектіге 

түрленіп, бәрі де ерекшеленеді (239-сурет).  

 

 
239-сурет. Графикалық объектіге түрленген мәтін 

 

Мұндай Flash объектілеріне бояу ретінде растрлық бейнелерді пайдалануға 

болады. 

 

Мәтін символдарына растрлық бейнелерді пайдалану 

1. Мәтін енгізіп, оны графикалық объектіге түрлендіреміз.  

2. Flash фильміне растрлық бейнені файл-импорт командасының кӛмегімен 

импорттамыз.  

3. Color Mixer панелінен Bitmap опциясын таңдаймыз. 

4. Мәтіннің әрбір әрібін растрлық бейненің бояуымен бояймыз. Ол үшін -

құралын таңдап, барлық әріп үшін ретімен басып отырамыз. 

 

Мәтін символдарына көлеңке түсіру 

1. Мәтін енгіземіз. Оның жанына кӛлеңкесі түсетіндей болуы тиіс (240-сурет).  
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2. Осы мәтіннің кӛшірмесін аламыз. Кӛшірменің түсін сұр түске алмастырамыз 

(241-сурет). 

3. Мәтіннің кӛшірмесі оның ӛзінен кейін құрылғандықтан ол оның үстінде 

тұрады. Оны артқы жоспарға орналастыру қажет. Ол үшін  -құралымен 

мәтінді ерекшелеп, Modify- arrange-Send to Back (Ӛзгерту- реті- артқы жоспарға 

жіберу, Изменить-Порядок-отправить на задний план) командалар тізбегін 

орындау қажет. Оның нәтижесі 242-суретте келтірілген. 

4. «Алматы» сӛзінің кӛшірмесін графикалық объектіге айналдырамыз.  

             
               240-сурет                                         241-сурет 

 

 
                                                       242-сурет 

Мәтінді қозғалысқа келтіру 

 Flash технологиясында мәтінді қозғалысқа келтіруге болады. Flash – те 

блоктарды қозғалысқа келтіруге болмайды, сондықтан оны графикалық 

объектілерге түрлендіру керек. 

Алдымен жаңа мәтін енгізіп, оның ӛлшемін барынша кішірейтіңіз. Мәтінді 

ортасына қарай туралаңыз: 

Окно (Терезе, Wіndow) аВыравнивание (Түзету, Alіgn)  

Мәтінді графикалық объектілерге түрлендіріңіз: 

Изменить (Өзгерту, Modіfy) а Разбить (Бөлу, Break Apart) 

Изменить (Өзгерту, Modіfy) а Группировать (Топтау, Group)  

Енді осы мәтінді қозғалысқа келтірейік. 

1. Тышқанның оң жақ батырмасымен уақыт шкаласының “40-кадрын” 

белгілеңіз. 

2. Пайда болған контекстік менюдің Іnsert Keyframe (Кілттік кадрды қою, 

Вставить ключевой кадр)  командасын таңдаңыз. 

3. Modіfy – Transform - Scale (Ӛзгерту – Трансформация - Масштаб) 

командаларын орындаңыз.   

Маркерлердің кӛмегімен мәтін кӛлемін үш есе үлкейтіңіз. 

4. Alіgn (Түзету, Выравнивание)  командасы арқылы ортасына қарай туралаңыз. 

5. Rewіnd (Басына ауысу, На начало)  батырмасын басып, кадрдың басына 

ауысыңыз. Мәтінді ерекшелеңіз. 

6. Modіfy- Great Motіon Tween (Ӛзгерту- Қозғалыс құру, Изменить-а Создать 

двойное движение) командаларын орындаңыз. 

7. Жасалған анимацияны кӛру үшін “Play” батырмасын басыңыз. 
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Практикалық тапсырма №2. Графикалық объектілердің анимациясы 

 Анимация бұл статикалық суреттердің тізбектеліп бірінен соң бірінің 

шығарылуы. Flash фильмі кадрларының шығарылу ретін кӛрсету үшін уақыт 

шкаласы пайдаланылады. Жаңа фильм құрғанда уақыт шкаласының барлық оң 

жақ бӛлігі бос тіктӛртбұрыштардан тұрады, ал курсор бірінші кадрда 

орналасады.  Мұндағы бос тіктӛрбұрыштар құрылатын фильмнің кадрларын 

бейнелейді. Бос Flash фильмінде ағымдағы кадрдың кӛрсеткіші тек бірінші 

кадрда ғана орналасады. Flash ортасында кадрлар уақытты сипаттау үшін 

пайдаланылады (243-сурет). 

 
 

243-сурет. Монтаждау үстелі терезесі 

  Фильмге кез келген мӛлшердегі кадрларды қосуға болады. Кадрлардың 

жиілігі ескертусіз секундына 12 кадр, қарапайым Web жұмыстары үшін 

секундына 8 кадрды қолдануға болады. Кадрлар жиілігін кӛбейту фильм 

қозғалысын жылдамдатып, анимацияны шынайылыққа жақындатады. Ал 

жиілікті кеміту фильмді баяулатады, анимацияның күрделілігіне қарай діріл 

пайда болуы мүмкін.  

 Flash фильмнің ӛлшемін азайту үшін мүмкіндігінше кадрлар жиілігін 

тӛмендету қажет. Кадрда объект пайда болғаннан кейін бірінші кадрдың бос 

тіктӛртбұрышы  нүктесі бар тіктӛртбұрышқа ауысады (244-сурет). 

Мұндай кадр кілттік кадр деп аталады.   

Кілттік кадр  барлық уақытта қандай да бір объектілерден немесе алдыңғы 

кадрларға қатысты осы объектілердің ӛзгерісінен тұрады. Кілттік кадрлардың 

тізбегін құра отырып, кез келген қиындықтағы анимациялық тізбек құруға 

болады. Кілттік кадрлар тізбегінен тұратын анимация кадрлық анимация деп 

аталады. 

 

         
 

244-сурет. Уақыт шкаласы 
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 Әрбір кілттік кадр нүкте бойынша салынған күрделі объектілердің 

түрлендірулерінен тұратын болса, онда бұл кадрлық анимация анимацияның 

әмбебап түрі болып табылады. Оның жалғыз кемшілігі әрбір кадрды қолмен 

салуға тура келеді.  

 

Кадрлық анимация 

  Келесі мысалда қарапайым анимациялық фильм құрайық. Бірінші кадрда 

бір түсті боялған доп пайда болады. Одан кейін жұлдызша түріндегі суреттер 

пайда болады. Доп жұлдызшалармен бірге үдемелі жылдамдықпен айнала 

бастайды да, жұлдызшалар жан-жаққа ұшып кететіндей әсер беруі тиіс. Осы 

мысалды кадрлық анимация түрінде құрайық. 

1. Жаңа Flash фильмін ашамыз.  

2. Бірінші кадрға дӛңгелек және оның кӛлеңкесін бейнелейтін эллипс саламыз. 

Дӛңгелекті градиентті толтырумен бояймыз, ал, эллипсті сұр түспен бояймыз. 

Әрбір объект жеке-жеке топтастырылады (245-сурет). 

 
245-сурет. Топтастырылған графикалық объект. 

 

3.  Анимацияның екінші кілттік кадрын құрайық. Ол үшін курсорды бірінші 

кадрға келтіріп, тышқанның оң жақ батырмасын басамыз. Ашылған контекстік 

менюден Insert Keyframe (Кілттік кадр қою, Вставить ключевой кадр) 

командасын таңдаймыз (246-сурет). Уақыт шкаласында нүктесі бар екінші 

тіктӛртбұрыш пайда болады. Ағымдағы кадрдың кӛрсеткіші екінші кадрға 

ауысады. Енді экранда екінші кадрдың мазмұны бейнеленеді. Бірінші кадрдың 

барлық объектілері автоматты түрде екінші кадрға кӛшіріледі. Бірінші 

жұлдызшаны салып, оны топтастырып, доп бейнесіне орналастырамыз (247-

сурет). 

4. Екінші кадр тәрізді үшінші кілттік кадр құрамыз. Доп бейнесіне тағы да бір 

жұлдызша салып орналастырамыз.  
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 246-сурет.  Контекстік меню                 247-сурет. Допқа жұлдызшаларды 

                                                                                    орналастыру 

 

5. Бірінен соң бірін әрбір жолы доп бейнесіне бір жұлдызшадан орналасатын 20 

кілттік кадр құрамыз (248-сурет). 

 

 
 

248-сурет. Уақыт шкаласындағы кілттік кадрлар бейнесі 

 

6. Енді допты айналдырамыз. Доптың айналуы барысында жарықтың шағылуы 

орнында қалуы үшін, барлық жұлдызшаларды топтастырамыз (Ол үшін Shift 

клавишін басып тұрып әрбір объектіні таңдап, Modify – Group командасын 

орындаймыз). Айналу құбылысын құру үшін допта орналасқан объектілерге 

айналу қасиетін беру қажет, ал доп қозғалмай орнында қалады. Айналу 

бірқалыпты болмау үшін бірінші кадрдан бастап ол шағын бұрышқа бұрылуы 

тиіс, мысалы, 10
о
, келесі кадрда ол 30

о
, одан кейін 50

о
, тағы сол сияқты 190

о
-қа 

жетуі тиіс.  

7. Анимацияның 21-ші кадрын құрайық. Scale and Rotate (Масштабтау және 

айналу, Масштабирование и вращение) командасын пайдаланамыз. Scale and 

Rotate сұхбат терезесінде Scale параметрін ӛзгеріссіз қалдырып, Rotate 
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параметрінің ӛрісіне 10 мәнін енгіземіз. Жұлдызшалардың бейнесі сағат тілінің 

бағыты бойынша 10
о
-қа бұрылады.  

8. 21-ші кадрда сұхбат терезесін шақырып, тағы да 30 мәнін Rotate ӛрісіне 

енгіземіз. Доп бейнесінде орналасқан объектілер тағы да 30
о
-қа бұрылады (249-

сурет). Әрбір келесі кадрда бұрылу бұрышын 20
о
-қа арттырамыз. 

 

 

 

 

 

 

 

 

249-сурет. Масштаб және бұру терезесі 

 

9. Осылайша біз тағы да 10 кадр қостық. Бір кадр үшін айналу бұрышының 

жылдамдығы 190
о
. Бұл жылдам айналу құбылысын құру үшін жеткілікті (250-

сурет).  

 

 
 

250-сурет 

 

 Енді фильмнің үшінші кезеңіне кӛшпес бұрын, жұлдызшалардың қозғалысы 

жан жаққа тарап жатқандай әсер қалдыруы тиіс. Енді фильмді демонстрациялап 

кӛрейік. Мұны да орындауға болады. Анимацияның бірінші кадрына кӛшеміз. 

Ол үшін уақыт шкаласындағы бірінші кадрды белгілеу қажет. Control – Play 

(Басқару- орындау, Управление - Пуск) командаларын орындаймыз. Ағымдағы 

кадрдың кӛрсеткіші кадрлар бойынша жүгіріп ӛтеді. Ал жұмыс үстеліндегі  

программа кадрлары бір-бірін алмастыра бастайды. Ағымдағы кадрдың 

кӛрсеткіші соңғы кадрға жеткенде анимацияны демонстрациялау аяқталады.  

10.  Допта бейнеленген жұлдызшалар жан-жаққа ұшып бара жатқан әсер беру 

үшін доптың шетіндегі орналасқан  объектілер жан-жаққа қозғалуы тиіс, ал 

доптың дәл ортасында орналасқан жұлдызшалар кӛрерменнің ӛзіне бағыттала 

қозғалуы тиіс. Бұл кезде доптан ұшқан объектілер қозғалысын тоқтатуы керек, 
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ал кӛрерменге тура қозғалыстағы объектілер ӛзінің айналуын сақтауы қажет. 

Ол үшін доптың шетінде орналасқан объектілерді топтан ажыратуымыз керек. 

Modify – Ungroop (Ӛзгерту –топтан шығару, Изменить - Разгруппировать) 

командасын пайдаланып, оны топтан шығарып, қалғандарын қайтадан орталық 

объектілерді топтастырамыз.  

11.  31-ші кілттік кадрды құрамыз. Доптың бейнесінен шеткі объектілерді 

қашықтатып оорналастырамыз. Орталық объектілер тобына қатысты 

трансформацияны қолданып, ӛлшемін ұлғайтып, оның айналуын сақтаймыз. 

Тағы да Scale and Rotate командасын пайдаланамыз. Scale параметрінің ӛрісіне 

150%, Rotate ӛрісіне 190 мәнін енгіземіз. Орталықтағы жұлдызшалар тобының 

ӛлшемі ұлғаяды да, кӛрерменге жақындап келе жатқандай әсер береді (251-

сурет). 

 
 

251-сурет. 

 

12.  Доптағы объектілерді ӛшіру анимациясы үшін 5 кадрды пайдаланамыз. 

Олардың әрқайсысында біз объектілерді қозғалтамыз, Scale and Rotate 

командаларын пайдаланып басқа топтарды айналдырып, ӛлшемін ұлғайтамыз. 

35-ші кадрда шеткі объектілер кеңістікті жоғалтып үлгереді. Орталық 

объектілердің бейнесін ӛшіру қалады. Бұл кӛрермендердің жанынан ұшып ӛтіп 

кеткендей әсер береді (252-сурет). 

13.  36-шы кілттік кадрды құрамыз. Барлық жұлдызшаларды ӛшіреміз. Кадрда 

тек доп пен оның кӛлеңкесі қалады (253-сурет). 

Кадрлық анимацияның жетістігі фильм құру барысында бейнені толық 

бақылауға мүмкіндік бар. Ал, айтарлықтай кемшілігі мұндай анимацияның 

әрбір кадрын қолмен құруға тура келеді.  
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                               252-сурет                                     253-сурет 

 

Автоматты түрде құрылатын анимация 

 Біз келесі мысалда шағын анимациялық фильм құрамыз. Біздің кӛз 

алдымызда солдан оңға қарай құс ұшып ӛтеді. Фильмнің ұзақтығы 10 секунд. 

Ол үшін бізге 120 кадр қажет. Егер біз кадрлық анимация құратын болсақ, онда 

120 кілттік кадрды қолдан құруға тура келеді. Сондай-ақ бірқалыпты 

қозғалысты шығару үшін, әрбір кадрдағы объектінің дәл ығысуын жасауға тура 

келеді. Біірақ бұл мүмкін емес. Ал автоматты түрдегі анимацияны пайдалана 

отырып, біз объектіні бастапқы және соңғы жағдайын кӛрсетсек, ал барлық 

аралық кадрларды программа ӛзі құрады.  

 

Қозғалыстың автоматты түрдегі анимациясы 

1. Құстың суретін қолдан саламыз немесе импорттаймыз. Бастапқы жағдайда 

құс кадрдан тыс орналасады. Қозғалыс барысында ол кадрмен ұшып, тұрақты 

жылдамдықпен қозғала отырып, біздің кӛз алдымыздан ұшып ӛтіп кадрдан 

шығып кетеді (254-сурет).  

 

\ 

 

 

 

 

 

 

 

 

 

 

 

254-сурет 

2. Фильмде барлығы 120 кадр болады. Сондықтан 120-шы кадрды тышқанның 

оң жақ батырмасымен белгілеп контекстік менюден Insert Keyframe (Кілттік 

кадрды қою; Вставить ключевой кадр) командасын таңдаймыз. Уақыт 
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шкаласында кілттік кадрдың белгісі пайда болады, 1- кадрмен 120-кадрдың 

аралығы ашық сұр түспен толтырылып, 119-шы кадрдың белгісі  түріне 

ауысады. Бұл 1 кадрмен 120-шы кадрлар аралығы бірінші кадрдың 

кӛшірмесімен толтырылғанын кӛрсетеді.  

3. Ерекшелеу сайманының кӛмегімен құстың суретін қозғалыстың соңғы орны 

120-шы кадрға орналастырамыз (255-сурет). 

4. Уақыт шкаласындағы 1-ші кадрдың белгісін  тышқанның оң жақ 

батырмасымен белгілеп, ашылған контекстік менюден Сreat Motion Tween 

(Қозғалыстың аралық кадрлдарын құру; Создать промежуточные кадры 

движения) командасын таңдаймыз. Сондай-ақ бұл команданы Insert - Great 

Motion Tween (Қозғалыстың аралық кадрлдарын құру; Создать промежуточные 

кадры движения) командасымен де орындауға болады. Уақыт шкаласындағы 1-

ші кадрмен 120-шы кадрлардың аралығы ашық жұпаргүл түске боялып, осы 

кадрларды біріктіретін бағыттауыш пайда болады (256-сурет).  

 

 
 

255-сурет. 

 

 
 

256-сурет. 

 

 Great Motion Tween командасы объектінің бастапқы жағдайын кӛрсететін 

кадр мен оның соңғы жағдайын кӛрсететін кадрлар арасындағы барлық аралық 

кадрларды құрады. Егер ағымдағы кадрдың кӛрсеткішін қандай да бір аралық 

кадрға әкелсек, онда осы кадрға сәйкес қозғалыстың бастапқы және соңғы 

нүктелерінің арасындағы объектінің жағдайын кӛруге болады. Great Motion 

Tween командасының орнына объектілер инспектірінің опцияларын 

пайдалануға болады (257-сурет). 
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257-сурет. 

 Frame (Кадр) ӛрісіне кадр атауы жазылады. Бұл басқа фильм кадрларынан 

осы кадрға шартты және шартсыз кӛшуді ұйымдастыру үшін қажет. Tween 

(Аралық кадрлар; Промежуточные кадры) тізімінің кӛмегімен Flash-те мүмкін 

болатын анимацияның үш типінің бірін таңдауға болады. Қозғалыстың 

автоматты түрдегі анимациясын құру үшін, қозғалымтың бастапқы нүктесіне 

сәйкес кадрда осы тізімнен Motion (Қозғалыс; Движение) командасын таңдау 

қажет.  

 Қарастырылған мысалда объект кӛрерменнің жанынан солдан оңға қарай 

бірдей қашықтықта қозғалды. Егер қорзғалыс процесінде объекті мен 

кӛрерменнің арасындағы арақашықтық ӛзгеретін болса, мысалы, жақындаса, 

онда орын ауыстырумен қатар объектінің ӛлшемі ұлғаюы тиіс. Flash 

технологиясы объектінің орын ауыстыруын, оның ӛлшемінің ӛзгерісін және 

айналуын бірге орынлауға мүмкіндік береді. Келесі мысалда объект бірінші 

кадрдағымен салыстырғанда біртіндеп ӛлшемі ұлғайып, оңнан солға, 

жоғарыдан тӛмен қозғалады. Мұның бәрі кӛрерменге объектінің жақындап келе 

жатқан құбылысын сипаттап кӛрсетеді.  

 

Көрерменге объектінің жақындауы 

1. Объектіні бірінші кадрға орналастырып (258-сурет), оның ӛлшемін 

кішірейтіңіз (259-сурет).  

 

                                                     
 

258-сурет.                                                   259-сурет. 

 

2. 60-шы кадрды кілттік кадр құрамыз. Объектіні соңғы нүктеге орналастырып, 

оның ӛлшемін ұлғайтамыз (260-сурет). 
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260-сурет. 

 

3. Бірінші кадрға қайтадан келіп, Insert - Great  Motion командаларын 

орындаймыз.  

4. Enter клавишін басып Flash фильмінің орындалу нәтижесін кӛреміз.  

Бұл қарастырылған мысалда объект бірқалыпты қозғалады. Мұндай қозғалыс 

объектінің кӛрерменге жақындау процесін табиғи түрде кӛрсете алмайды. 

Фильмде вертолет жақындаған сайын оның жылдамдығы азаятындай әсер 

береді. Бірқалыпты қозғалыстың әсерін жасау үшін кадрдан кадрға кӛшкенде 

объектінің орын ауыстыру жылдамдығы ұлғаяды. Ол үшін Properties 

(Қасиеттер; Свойства) терезесінде Ease (Баяулату; Заедление) параметрі 

пайдаланылады. Бұл параметрдің оң мәні объектінің қозғалысын соңғы кадрға 

дейін баяулатады. Ал теріс мәні оны жылдамдатады. Біздің жағдайда -80 мәнін 

енгізуге болады.  

Сонымен біз осы уақытқа дейін объектінің түзу сызықты қозғалысын 

қарастырдық. Flash MX ортасында берілген траектория бойынша қозғалыс 

анимациясын құруға мүмкіндік бар.  

 

 Берілген траектория бойынша қозғалыс анимациясы 

 Flash програмасында объектілердің траектория бойынша қозғалысын жасауға 

болады. Қозғалысты жүзеге асыру үшін келесі командалар жиынтығын 

орындау қажет: 

1. Жаңа фильм құрамыз. 

2. Анимацияның объектісі ретінде кез келген суретті немесе графикалық  

элементті қолданайық және оны ерекшелейік. 

3. Объектіні топтастырамыз: Изменить (Ӛзгерту, Modіfy) - Группировать 

(Топтау, Group)  командаларын орындаймыз. Уақыт шкаласында орналасқан 

қозғалыс бағыттаушысын қосатын пернені басыңыз  (Добавить 

направляющюю движения). Уақыт шкаласында орналасқан ерекшелеген жаңа 

қабат пайда болады. 

4. Қарындаш сайманын таңдаңыз   және кадрдан ӛтетін объектінің 

қозғалысын бейнелейтін сызық сызамыз. 
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261-сурет. 

 

5.  - кӛрсеткішті қолданып,   объектінің центрі сызықтың басымен 

теңесетіндей етіп орналастырамыз. Іnsert (Қосу, Вставить) - Сreat Motіon Tween 

(Қозғалыс құру, Создать двойное движение) командаларын орындау арқылы 

анимация жасалады. 

    Келесі фильмнің барлық кадрларын жасаймыз. Тышқанмен бағыттаушы 

жолындағы 30 кӛрсеткішін басып тұрып, 1-ші қабатқа қарай орнатамыз.  

6. Іnsert (Қосу, Вставить) - Keyframe (Кілттік кадрды қосу, Ключевой кадр) 

командасын орындағаннан кейін соңғы кадр пайда болады. Сонымен қатар 

программа автоматты түрде аралық кадрларды қояды. 

7. Объектілерден ерекшелеуді алып тастау үшін тышқанмен кадрдың бос орнын 

белгілеңіз. 

8. Объектінің центрі сызықтың соңына орналасатындай етіп орналастырамыз. 

9. Фильмді ойнатып кӛрейік. 

 

 
 

262-сурет. 
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Бірнеше объектілердің анимациясы 

Flash – фильмінде бір уақытта бірнеше объект орналасуы мүмкін. Осы 

объектілердің қозғалысының анимациясын жасаған кезде әрбіреуін жеке 

қабатта орналастыру керек. Мысал ретінде кадрға кез келген сурет қояйық.  

1. Суретті кадрдың оң жақ жоғарғы бӛлігіне орналастырамыз.  

2. Бейнені алмастыру буферіне кӛшіреміз.  

3. Жаңа қабат қосамыз. Осы қабатқа алмастыру буферінде орналасқан бейнені 

кӛшіреміз. Кӛшірілген бейнені кадрдың сол жақ тӛменгі бӛлігіне 

орналастырамыз.  

Енді анимация құрамыз: 

1. Ол үшін ерекшелеудің кӛмегімен екі бейнені де ерекшелеп аламыз. 

2. Іnsert (Қосу, Вставить) - Сreat Motіon Tween (Қозғалыс құру, Создать двойное 

движение).  Бос орынды белгілеңіз. 

3. Екі қабаттағы кадрларды ерекшелеу үшін 50 кӛрсеткішін басып тұрып 

тӛменге қарай орнатамыз: Keyframe (Кілттік кадрды қосу, Ключевой кадр). 

4. Бірінші қабаттың 20-шы кӛрсеткішінде тышқанның оң жақ батырмасын 

басамыз. Пайда болған контекстік менюден Keyframe (Кілттік кадрды қосу, 

Ключевой кадр) командасын таңдаймыз. Ерекшеленген бейнені қарама-қарсы 

бұрышқа орнатамыз. Сол операцияны екінші қабаттағы кадрдың  20-шы 

кӛрсеткішіне де орындаймыз. 

5. Фильмді ойнатамыз. 

 

Практикалық тапсырма №3. Батырма құру және оны бағдарламалау 

    Бағдарлама іске қосылғаннан кейін қабаттың (Layer1) үстіне меңзерді 

апарып, тышқан батырмасының оң жағын басамыз. Ашылған контекстік 

мәзірден Properties (Қасиеттер) командасын таңдаймыз. Ашылған сұхбат 

терезеден қабаттың атын «Фон» деп ӛзгертеміз. Фон бетіне File → Import → 

Import to Stage (Файл → Импорттау → Сахнаны импорттау) командаларының 

кӛмегімен векторлық, растрлық бейнелерді, суреттерді импорттауға және 

орналастыруға болады. 

 Уақыт шкаласындағы Insert Layer   (Қабат құру) батырмасы кӛмегімен 

екінші қабат құрып, жоғарыдағы тәсіл арқылы оның атын «Батырма» деп 

ӛзгертеміз.  

«Батырма» қабатына Саймандар тақтасындағы Tools (Құралдар) тобынан  

Rectangle Tool (Tӛртбұрыш) құралын және Сollors (Түстер) саймандар тобынан 

Fill Color (Толтыру түсі) палитрасынан боялатын түсті таңдап, Options 

(Параметрлер) тобынан  Бұрыш радиусын орнату құралын таңдаймыз. Сол 

кезде тӛмендегідей сұхбат терезе шығады: 
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Радиус бұрышының ӛрісіне 45 санын пернетақтадан енгізіп, экран бетіне 

батырма құрамыз.  

Саймандар тақтасындағы   Text Tool (Мәтін)  құралы арқылы, батырма 

бетіне Теория  сӛзін жазамыз. 

Мәтіннің типі объектілер инспекторы терезесінің кӛмегімен беріледі. Оны 

экранға шақыру үшін Window → Properties (Терезе → Қасиеттер) командасын 

орындау қажет. Нәтижесінде «Қасиеттер» терезесі ашылады. Text type 

ашылатын тізімінің опциялары  мәтіннің типін анықтауға мүмкіндік береді. Ал, 

Properties панелі мәтіннің әрбір түріне қажетті параметрлер жиынтығын береді.  

 

 

 

 
 

 
Мәтінмен жұмысты қамтамасыз ететін қасиеттер терезесі 

 

Arrow Tool (Кӛрсеткіш)  құралын таңдап, құрған батырмамыздың үстінен 

екі рет үздіксіз шерту арқылы ерекшелеп белгілейміз, Modify → Convert to 

Symbol (Ӛзгерту → Символға түрлендіру) командасы немесе пернетақтадан F8 

функционалдық батырмасы арқылы таңдалған графикалық объектіні символға 

түрлендіреміз. Сонда символдың аты мен типін кӛрсетуге болатын сұхбат 

терезе шығады. Аты деген ӛріске «Батырма», ал типін Button (Батырма) етіп, 

OK батырмасын басамыз. Осы кезде біздің батырмамыз автоматты түрде 

Кітапханаға келеді.   

 

 

 

 

 

 

 

 

Шрифт гарнитурасы Шрифт өлшемі 

Трекинг Жоғарғы-төменгі индекстер Гиперсілтеме адресі Кернинг 
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  Батырманың үстінен тышқанның сол жақ батырмасын екі рет үздіксіз 

басамыз, сол кезде уақыт шкаласының түрі суреттегідей болады, яғни тӛрт кадр 

пайда болады: Up (Вверх), Over (Над), Down (Вниз), Hit (Нажатие).   

 

 

 

 

 

 

 

 

 

Батырма құрудағы монтаждау үстелі 

 

 Hit кадрына барып тышқанның оң жақ батырмасын басамыз, ашылған 

контекстік мәзірден Insert Keyframe (Кілттік кадр қою) командасын таңдаймыз 

немесе пернетақтадан F6 функционалдық батырмасын басамыз.  

Уақыт шкаласының жоғары жағындағы Scene1–ді (Сцена1) таңдап, Windows 

(Терезе) мәзірінен Behaviors (Компонент инспекторы) командасын таңдаймыз 

немесе пернетақтадан Shift+F3 батырмаларын қатарынан басамыз. Ашылған 

сұхбат терезеден  Add Behavior батырмасын басып, Web → Go To Web Page 

(Web → Web-бетіне ӛту) командасын орындаймыз.  

 

 

 

 

 

 

 

 

 

 

 

 

 Осы кезде ашылған Go to URL (URL-адреске кӛшу)  сұхбат терезесіндегі 

URL ӛрісіне URL-адресті, яғни, Word бағдарламасы арқылы дайындаған 

құжатымыздың типін htm етіп сақтап, оның адресін осы жолға жазамыз. Ал, 

ашылатын құжат жаңа терезеде ашылуы үшін тӛменгі Open in ашылмалы 

тізімдерінен «Blank» командасын таңдаймыз, сосын Ок батырмасын басамыз. 

Егер ӛріске WEB-бетінің адресі немесе файл енгізілсе, онда бұл мәтін 

гиперсілтемеге айналады.    

 Осы әрекеттерді орындағаннан кейін, Control → Test Scene командасын 

орындаймыз. Бұл командалар тізбегі екпінді сахнаны SWF форматындағы 
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фильм ретінде сақтап, программаны фильмді жүргізу режиміне кӛшіріп, 

фильмді ойнатуға жібереді. Осы кезде тӛмендегі терезе ашылады.  

 

 

 

 

 

 

 

 

 

 

 

 

 

 Ашылған терезедегі батырманы басқанда, біздің манағы Word 

бағдарламасындағы дайындаған құжатымыз, Internet Explorer бағдарламасы 

арқылы ашылады.  
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